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Guide to Lisa Manuals 

Set up your Lisa following the setup procedures in the 
Lisa accessories box or in Appendix 1, Setup 
Procedures, in the Lisa Owner's Guide. 

Go through Section A, LisaGuide, in the Lisa Owner's 
Guide, for an introduction to the Lisa. 

If your dealer or service representative did not set your 
system Preferences so that the Lisa knows what external 
devices are attached, follow the instructions in Section 
D, Desktop Manager Reference Guide, under Set, in the 
Lisa Owner's Guide. 

~ Go to Section A, Getting Started, in the manual for each 
office tool that you want to learn, for the essentials of 
using that tool. 

Go to Section B, Lisa Fundamentals, in the Lisa Owner's 
Guide, for the background information you need before 
beginning long-term work on the Lisa. 

You are now ready to start doing your own work on the 
Lisa: 
.If you want self-paced instructions for using a tool, go 

to Section B, Tutorial, in that tool manual. 
• If you want instructions for performing specific tasks 

with a tool, go to Section C, Reference Guide, in that 
tool manual. 

For specific instructions on filing and desktop 
management, go to Section D, Desktop Manager 
Reference Guide, in the Lisa Owner's Guide. 

For more information on the Lisa hardware, tips on 
caring for the Lisa, and suggestions for troubleshooting 
when the system isn't working properly, go to the other 
sections of the Lisa Owner's Guide. 
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Customer Satisfaction 

If you discover physical defects in the 
manuals distributed with a Lisa product 
or in the media on which a software 
product is distributed, Apple will 
replace the documentation or media at 
no charge to you during the 90-day 
period after you purchased the product. 

In addition, if Apple releases a 
corrective update to a software product 
during the gO-day period after you 
purchased the software, Apple will 
replace the applicable diskettes and 
documentation with the revised version 
at no charge to you during the six 
months after the date of purchase. 

In some countries the replacement 
period may be different; check with 
your authorized Lisa dealer. Return any 
item to be replaced with proof of 
purchase to Apple or to an authorized 
Lisa dealer. 

Limitation on Warranties and Liability 

All implied warranties concerning this 
manual and media, including implied 
warranties of merchantability and 
fitness for a particular purpose, are 
limited in duration to ninety (90) days 
from the date of original retail 
purchase of this product. 

Even though Apple has tested the 
software described in this manual and 
reviewed its contents, neither Apple 
nor its software suppliers make any 
warranty or representation, either 
express or implied, with respect to the 
software described in this manual, its 

© 1983 by Apple Computer, Inc. 
20525 Mariani Avenue 
Cupertino, California 95014 
(408) 996-1010 

quality, performance, merchantability, 
or fitness for any particular purpose. 
As a result, this software is sold "as 
is," and you the purchase are 
assuming the entire risk as to its 
quality and performance. 

In no event will Apple or its software 
suppliers be liable for direct, indirect, 
special, incidental, or consequential 
damages resulting from any defect in 
the software or manual, even if they 
have been advised of the possibility of 
such damages. In particular, they shall 
have no liability for any programs or 
data stored in or used with Apple 
products, including the costs of 
recovering or reproducing these 
programs or data. 

The warranty and remedies set forth 
above are exclusive and in lieu of all 
others, oral or written, express or 
implied. No Apple dealer, agent, or 
employee is authorized to make any 
modification, extension, or addition to 
this warranty. 

Some states do not allow the exclusion 
or limitation of implied warranties or 
liability for incidental or consequential 
damages; so the above limitation or 
exclusion may not apply to you. This 
warranty gives you specific legal rights, 
and you may also have other rights that 
vary from state to state. 

License and Copyright 

This manual and the software 
(computer programs) described in it are 
copyrighted by Apple or by Apple's 
software suppliers, with all rights 
reserved, and they are covered by the 

Lisa Software License Agreement 
signed by each Lisa owner. Under the 
copyright laws and the License 
Agreement, this manual or the 
programs may not be copied, in whole 
or in part, without the written consent of 
Apple, except in the normal use of the 
software or to make a backup copy. 
This exception does not allow copies to 
be made for others, whether or not 
sold, but all of the material purchased 
(with all backup copies) may be sold, 
given, or loaned to other persons if they 
agree to be bound by the provisions of 
the License Agreement. Copying 
includes translating into another 
language or format. 

You may use the software on any 
computer owned by you, but extra 
copies cannot be made for this 
purpose. For some products, a multi
use license may be purchased to allow 
the software to be used on more than 
one computer owned by the purchaser, 
including a shared-disk system. 
(Contact your authorized Lisa dealer for 
information on multiuse licenses.) 

Product Revisions 

Unless you have purchased the product 
update service available through your 
authorized Lisa dealer, Apple cannot 
guarantee that you will receive notice of 
a revision to the software described in 
this manual, even if you have returned a 
registration card received with the 
product. You should check periodically 
with your authorized Lisa dealer. 

Apple, Lisa, and the Apple logo are trademarks of Apple Computer, Inc. 
Simultaneously published in the USA and Canada. 
Reorder Apple Product #A6LO 141 
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Preface 

LisaCalc is an electronic spreadsheet and financial 
modeling tool that helps you perform simple arithmetic 
problems or complex data analyses. Using LisaCalc you 
can test variables in the spreadsheet to help you make 
decisions. You can print your spreadsheets, and you can 
move them into LisaGraph to create a graph of the data. 

This manual contains three kinds of documentation of 
LisaCalc: 

• Section A, Getting Started with LisaCalc, is a quick 
introduction to the tool. It is designed to give you the 
basic skills for using LisaCalc. 

• Section B, LisaCalc Tutorial, is a step-by-step guide to 
the major features of LisaCalc. It includes suggestions 
on how to use LisaCalc efficiently and effectively. 

• Section C, LisaCalc Reference Guide, is a complete 
reference section. It contains instructions for 
performing specific tasks, including the details of how 
each feature works. 

The material in this manual assumes that you have used 
LisaGuide, which teaches you the fundamentals of using 
the Lisa. The LisaGuide diskette came in the front pocket 
of the Lisa Owner's Guide, and instructions for using it 
appear in Section A of that manual. 

Section B, Lisa Fundamentals, of the Lisa Owner's 
Guide, contains important background information 
about setting up and using the Lisa for long-term work. 
Make sure you understand the concepts in that section 
before going on to either the Tutorial or the Reference 
Guide. Refer to Section D, Desktop Manager Reference 
Guide, of the Lisa Owner's Guide, when you need to 
know how to do filing or how to perform any of the other 
tasks outlined in Section B, Lisa Fundamentals. 

· . ·1·· • •• VII · .. 



... viii I : : : 

The material in this manual can be used in either short or 
long blocks of time. You can complete Getting Started in 
about 30 minutes. Then you can either go through the 
Tutorial one chapter at a time or start creating your own 
documents, looking up procedures in the Reference 
Guide as you need them. 
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Getting Started 
with LisaCa/c 

With LisaCalc you can produce income and expense 
statements, budgets, and do complex forecasting - all 
automatically. 

LisaCalc can assist you in quickly making key decisions 
by allowing you to evaluate various alternative situations 
that you otherwise wouldn't have time to consider. 

Getting Started with LisaCalc is a hands-on exercise. By 
going step by step through an easy example, you will 
quickly become familiar with the basic skills for using 
LisaCalc, and afterward be able to create, edit, file, and 
print your own LisaCalc documents. 

Getting Started ::: I A 1 
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Here's what you need 

What You Need 
to Get Started 

• A Lisa set up and plugged in, with the keyboard and mouse attached. 
• A ProFile set up and plugged in, with the Office System and LisaCalc tool on it. 
• A Printer set up and plugged in if you want to print. Make sure your printer is hooked 

up to your Lisa and turned on. Printing is optional. 
• About 30 minutes. 

Note: If your system is not already set up and configured, refer to the Lisa Owner's 
Guide, Appendix 1, Setup Procedures. 

ProFile 

sa 

Keyboard 

Mouse 

A21 : : : Section A ... 



If you haven't yet gone through LisaGuide, in which Lisa introduces Lisa, now is a good 
time to do so - it will make Getting Started even easier. For instructions on starting 
LisaGuide, refer to the Lisa Owner's Guide, Section A, LisaGuide. 

If you've already gone through a Getting Started for another Lisa tool, you'll see many 
similarities in using LisaCalc - the basic concepts for using each Lisa tool are the 
same. 

Getting Started ::: I A3 
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Starting Up 

What You're About To Do 

Follow the numbered steps below and on the next page to: 

• Turn on and start up your ProFile and Lisa . 
• Learn how to brighten the screen if it has dimmed automatically. 

Note: If your ProFile and Lisa are already on, skip to step 3. The red ProFile light is lit 
when the ProFile is on, and the Lisa on-off button is lit when the Lisa is on. 

Do This 

1 Turn on your ProFile by 
pressing the on-off switch 
on the back, left-hand 
side of the ProFile, as 
shown. 

2 Turn on your Lisa by 
pressing the on-off 
button, at the lower, right
hand side of the Lisa, as 
shown. 

... A41 : : : Section A 



Do This 

3 After several minutes, 
when the red ProFile light 
stops flashing, your 
screen should look 
something like the one to 
the right. (See something 
different? Refer to the 
Lisa Owner's Guide, 
Section G, 
Troubleshooting.) 

4 If your Lisa has been on ~ 
for a period of time with 
no activity, the screen 
may have automatically 
dimmed. If your screen is 
dim, just move the mouse 
to brighten it. 

Getting Started ::: I AS 
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The Desktop and the Mouse 

What You're About To Do 

The gray area of your screen is called the desktop. Like the desktop of an office desk, 
it's where you do your work. 

The mouse is what you use to communicate with your Lisa - you use it to point out 
what it is you want done. 

To get familiar with your Lisa's desktop and how to use the mouse, follow the steps 
below. 

Do This 

1 Hold the mouse as 
shown. (Don't press the 
mouse button yet.) 

A6 ::: Section A 



Do This 

2 Slide the mouse on your 
desk to move the pOinter 
around the Lisa desktop 
- the gray part of your 
screen. 

Notice the menu bar across the 
top of your screen - it contains 
menus of different actions you 
can take. Along the bottom of 
your screen are various icons -
graphic symbols that stand for 
different things. 

3 To get oriented, move the 
pointer to the d ifferent rl";:-;";":'"7~::--;:~~::-:--~---------------11-. 

spots shown to the right. 
(Trouble making the 
pointer go where you 
want it to go? Lift up and 
reposition the mouse.) 

Getting Started A 7 
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Seeing What's on a Disk 

What You're About To Do 

To get at the document you'll work with, you first need to open the ProFile disk icon as 
described in the steps below. 

The way you'll open the disk will illustrate your Lisa's most general principle: 

• First you select something . 
• Then you do something to what you've selected. 

Do This 

1 Select (highlight) the 
ProFile disk icon by 
placing the tip of the 
pointer on it and clicking 
the mouse button, as 
shown. (Icon not 
highlighted? Try again.) 

A8 ::: Section A 



Do This 

2 Open the selected disk 
icon by choosing Open 
"ProFile" from the File/ 
Print menu. 

Here's how 
• Press and hold with the 
pointer's tip on File/Print 
in the menu bar . 
• Move the pointer down 
and release when Open 
"ProFile" is highlighted. 
(Is the Open menu item 
dim? You probably 
cl icked somewhere else 
on the gray part of the 
screen and deselected 
the ProFile icon. Go back 
to step 1 and make sure 
the ProFile icon is 
selected.) 

3 Notice the window to the 
ProFile that zooms open 
on your Lisa's desktop. 
Your ProFile is like a very 
large file drawer - it's 
where you'll keep most of 
your work. 

~ 
LlsaGraph Paper 

LJ 
LlsaGraph Examples 

LJ 
Tools 

~ 
LlsaWnte Paper LlSaProJect Paper LlsaLlst paper 

LJ LJ LJ 
LlsaWnte Examples LlsaPro Ject Examples LlsaL1S t Examples 
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Pulling a Document 

What You're About To Do 

Inside the ProFile window you should see several stationery pads and folders. The 
LisaCalc Examples folder contains the example you'll be working on here. In the steps 
below, you will: 

• Open the LisaCalc Examples folder. 
• Tear off a sheet from the Getting Started stationery pad that's inside the folder. 
• Move the new sheet, or document, to a clear spot in the folder. 
• Give the new document the name Sales Forecast. 
• Open the document. 

Do This 

• To open the LisaCalc 
Examples folder: 

1 Select the LisaCalc 
Examples folder by 
clicking on it. 

2 Choose Open "LisaCalc 
Examples" from the File/ 
Print menu. 

Notice the window to the 
LisaCalc Examples folder that 
zooms open, and its contents, as 
shown. The "spreadsheet" 
patterns on the icons in the 
folder show they are LisaCalc 
icons. 

A10 ::: Section A 
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LlsaGraph Examples LlsaWnte Examples LlsaPro Ject Examples 

LJ 
1lllllso(alc Examples 11111 
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Do This 

• Copies of the Getting 
Started example are on 
the Getting Started 
stationery pad. To tear off 
a sheet from the pad: 

1 Select the Getting 
Started pad icon. 

2 Choose Tear Off 
Stationery from the File/ 
Print menu and wait a 
moment until the new 
document appears, as 
shown. 

• To move the new icon out 
of the way, to a clear spot 
in the folder: 

1 Place the pointer on the 
icon. 

2 Press and hold down the 
mouse button and move 
the icon as shown; then 
release the mouse 
button. 

• To rename the new 
document: 

1 Make sure the untitled 
document icon is still 
selected (highlighted). If 
you've deselected the 
icon by clicking 
elsewhere on the screen, 
select it again by clicking 
on it. 

2 Type the name Sales 
Forecast. (Typing 
mistake? Use the 
( Backspace) key to correct 
it.) 

1IIIIlIsnCaic Exmnple> IIIII 

Chapter 2 Chapter 3 

1I,IIlisaCaic Examples IIIIII 

Chapter 2 Chapter 3 

Type Sales Forecast 

Chapter 4 

Chapter 4 

Getting Started ::: A 11 
with LisaCalc ••• 



Do This 

• To open the Sales 
Forecast document: 

1 Make sure the document 
icon is selected 
(highlighted). 

2 Choose Open "Sales 
Forecast" from the File/ 
Print menu. 

Notice how the icon zooms open 
into a window. Wait a minute -
the hourglass, ~, means wait -
until the LisaCalc tool displays 
the Sales Forecast document, as 
shown. 

A12 ::: Section A 



The LisaCa/c Document 

The Sales Forecast document is now open on your Lisa's desktop. 

Across the menu bar at the top of the screen are the LisaCalc menu names. Each 
menu contains a list of actions you can take with a LisaCalc document. 

The LisaCalc spreadsheet is composed of lettered columns and numbered rows 
which intersect to form the cells into which you enter information. For example, cell 
C11 is in column C, row 11. 

The status panel, above the spreadsheet, contains areas labeled Cells, Value, and 
Formula, which display a selected cell's coordinates (column and row location), value, 
and formula . 

. Without pressing the mouse button, move the pointer around the screen and notice 
how the shape of the pointer changes to an arrow painter, " when it's over the menu 
bar, to a text pointer, I, when it's over the Cells section of the status panel, and to a 
cross-hair pointer, +, when it's over the spreadsheet. 

LisaCalc menu names 

Status panel 

Spreadsheet 
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What You Are Going to Do 

Imagine you work for a fictional company called Switch
On Communications, Inc. One of your competitors has 
recently introduced a business phone similar to one you 
produce, but for sale at a lower price than yours. In order 
to remain competitive, you are planning to lower the 
price of your phone. You are now preparing next 
quarter's sales forecast, and you want to see how many 
lower-priced phones you will have to sell in order to meet 
your profit objectives. 

In the next several pages you will learn to: 

1. Enter values into cells. 

2. Format cell entries so the numbers appear as dollar 
amounts. 

3. Enter formulas so calculations are performed 
automatically. 

4. Ask "What If?" by changing values and evaluating 
changed results. 

5. Change the width of a column so your new column 
heading will fit. 



Enter values 

Format cell entries 

Enter formulas 

When you are finished, your spreadsheet will look like the 
one below. Compare it with the spreadsheet now on your 
screen. 

Change column width 

Getting Started A 15 
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Entering Values 

What You're About To Do 

Following the steps below, you will enter the values for next quarter's forecast into 
column C. You'll begin with the assumption that next quarter you'll sell the same 
number of units at the same price as last quarter. You predict, however, that your 
operating expenses for next quarter will increase. 

Do This 

1 Enter the word Next, for File/Print Edit Type Style Page layout Format Protect Co 
Next Quarter, into cell C 1. lj 

~=-------------~-
111111 Sales For~(ast IIIIII 

Here's how 
• Select cell C 1 by 
placing the pointer in the 
cell and clicking the 
mouse button once. 
(Select the wrong cell? 
Move the pointer to the 
cell you want and click.) 
• Type N ext and press 
~. (Make a mistake? 
(Backspace) or choose 
Clear Entries from the 
Edit menu.) 

... A161:: : Section A 

"G Cells: C1 Value (Text): Next 

"M Formula: 
A E 

·· .. ,,,·,, .... ,,,, .... · .... ·t··,,··· ."j ... " ...... " ........................... + ...... "" .......... . 

" .... , ..... """ .......................... , ......... , .................... ",, .......... """.~"""''''.'''. " ... "" .. , ... :" .. " ... " ...... ""."" .. "" .. """~ ....... " ...................... " ....... : ... ", ........... ,. 
........... ,." ........... " .................... . ... . ........ ~ ....................... " ....... "................ . ....... "" ............. + ........ . 

.... ,." ........ , ............ ", .. "? ..... " .. ,,' 
......... L ................................ 1. ..... . 



Do This 

Follow the same procedure 
to enter the number values 
into their appropriate cells. 

2 Enter 700 into cell C3. 

3 Enter 200 into cell C4. 
(Don't worry about dollar 
signs yet.) 

4 Enter 100 into cell C5. 

5 Enter 34000 into cell C9. 
(Don't forget to press 
(Enter).) 

File/Print Edit Type Style Page Layout Format Protect (0 

lj 
• G Cells: C9 Value (Number): 34000 
• M Formula: 

A E 
1 ............ , ............................. , ........ . 
2 ; ....... ""'''''''''''''''::'''''''''' 3 .............................................. :t' ........ ;c; .. ·ld················, .................... ···· ........ ·.·.f9.9.,i·· ......... · ... :: ... ::.: .. ·.·f9.9L .. 

~ ~~~lr~~~~:frQ~~~]J~§; :::::3~L · .. " .. ·t· .. · .. 

6 
7 s8:fe·s""p·e;.,·en·IJ·e··"· ................................... $ ...... : .. :: ................ .I4.Q.,: ..... g.Q.g ..... .l' .... . 
8 fO'sf"'(j'{""G'O'O'ds""'S'(ji'd'" "'$ 70 000 ~ 
9 .Op::::RP,·:o~.rF· .. : .. aI,~· .. TfI'6·g .. :··.~i:·:p..~Ei:~.i.: ............ : .................... $,$.: ..... : ..... :: .... : ... : .. :.:::.~.Q:::Q9..9. .... :. 

......... + ........ 

''''" ... " ........... ''?'', ....... . 

pt ................... : .. : ......... ' ....... : ........... . 
10 ........... A.9.<...9.9.9. .... ; ....... . 
11 ""'''''!'''' ......................................... ! ... . 
12 .............................. ! .. . 

.... · .. · .. "" .. ",· .. · .. ···t,,·· .... · 

......................... ? ....... 
13 ................. ;. ........................ .; ........... . 
14 ............. , 
15 ..................................... .. .............. ! .......................................... : ..................................... , .. 
16 .... ,. . .. j ........................... .! ... . 

.. ··,·· .. ······ .. t'· .. ,,· 
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Formatting Cell Entries 

What You're About To Do 

All the figures you are dealing with are dollar amounts except for the number of units 
sold. Follow the steps below to change the format of the cells C4 through C10 so that 
their entries will be displayed as dollar amounts. 

Do This 

1 Select the cell range from 
C4 to C10, as shown. 

Here's how 
• Place the pointer in cell 
C4 . 
• Press and hold down 
the mouse button as you 
move the pointer down to 
cell C10; then release. 
(Select the wrong range? 
Move the pointer to cell 
C4 and begin again.) 

... A181: : : Section A 

Release here 



Do This 

2 Choose $1,235 from the 
Format menu. (Choose 

Page layout Format Protect (0 

IIIIII Sales Forecast IIIIII 
the wrong menu item? Go a...:::...:::...:=..~..::::.::..:.::::.::~_..J.:....::":"=':::'="------------
back and choose the one 
you want.) 

Notice how the values you've 
already entered now appear as 
dollar amounts. Entries into the 
remaining formatted cells will 
also appear as dollar amounts. 
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Entering Formulas 

What You're About To Do 

Sales Revenue = Number of Units Sold X Avg Sale Price per Unit 
The formula for that is: C3 * C4 

You want the calculated result of formula C3*C4 to appear in cell C7, Sales Revenue. 
Then, you want to calculate the Cost of Goods Sold, and the Profit. 

To enter a formula, you follow a different procedure than you do to enter a value. First, 
you select the cell which is to contain the formula's calculated result. Then, you enter 
the formula into the status panel, as described below. 

Do This 

1 Select cell C7. 

2 Important: You always 
enter a formula via the 
status panel. Select an 
insertion point in the 
formula area of the status 
panel by clicking once 
after the word 
"Formula:", as shown. 

A20 ::: Section A 

First select cell e71 
~Ie/print Edit Type st~ormot Prote,t (0 

"G Cells; C7 .... IValue; 

A B o E 

Avg S,a,l e, ,pr ,c~" p,e~ Unit ;, ' ',',', ~~~,',~' , .. ,' I~,~, .. ' 
AVCl ,Cqst ,~,e , ,Un~ t .. , '" .. ', .. , .. , , 

Iperat i ng E: penses 

Then click in formula area 



Do This 

3 Is there a blinking 
insertion point after the 
word "Formula:"? If not, 
repeat step 2. If so, type 
C3*C4 and press (Enter). 
(Make a mistake? 
( Backspace) or choose 
Clear Entries from the 
Edit menu.) 

Notice the calculated result for 
Sales Revenue that appears in 
cell C7. 

Follow the procedure in 
steps 1 - 3 to enter the 
following formulas: 

4 Enter the formula for 
Cost of Goods Sold, 
C3*C5, so the calculated 
result appears in cell ca. 
(Make a mistake? 
(Backspace) or choose 
Clear Entries from the 
Edit menu, and be sure to 
enter the formula via the 
status panel.) 

5 Enter the formula for 
Profit, C7 -CB-C9, so the 
calculated result appears 
in cell C10. 

Type this and press (Enter) 

File/Print Edit Type Style Page Layout Format Protect ((I 

~ ~-------
• G (ells: C10 Value (Number): 36000 
• M Formula: C7-C8-C9 

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 

A 
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.Q:p..~.Jj}.f6.'g:.::,g.i:·:p..·~.'6i~.i..... $ 30, 000 $ 34 000 i 
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· ...... · ....................... 6 ...... . 

Getting Started A21 
with LisaCalc 



"What If?": Changing 
Values and Evaluating 
Changed Results 

What You're About To Do 

Your competition is now selling a phone similar to your Switch-On Exec phone for 
$180. Although your phone has a couple of features that the competition's doesn't, 
you are considering lowering the selling price of the Switch-On Exec from $200 to $185 
in order to remain competitive. 

You have set a $45,000 profit goal for next quarter and want to know how many 
phones you would have to sell in order to reach that goal. Follow the steps below to 
evaluate some of the sales options available to you. 

Do This 

1 Enter 185 into cell C4. 
(Select the cell, type, and 

File/Print Edit Type Style Page layout Format Protect (a 
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(Enter).) " G (ells: C4 Value (Number): 185 
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Revenue and Profit figures A E 
automatically recalculate - and 
show you far below your profit 
goal of $45,000. 
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Do This 

2 Enter 800 into cell C3. 

3 As you produce more 
phones, the Avg Cost per 
Unit will decrease. So, 
enter 92 into cell CS. 

Notice that if you sell 800 
phones for $185 each, you still 
won't reach your profit goal of 
$45,000. 

4 Now enter 850 into cell 
C3. 

Notice that you will reach your 
profit goal of $45,000 if you sell 
850 phones at $185 each. 
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Changing the Width 
ola Column 

What You're About To Do 

You now want to prepare your Sales Forecast spreadsheet for distribution. Follow the 
steps below to widen column C and then add to the column heading so that it reads 
"Next Quarter". 

Do This 

1 The C/O column handle is 
the line between the 
letters C and 0 at the top 
of the spreadsheet. Move 
the cross-hair pointer to 
the C/O column handle. 

2 Press and hold down the 
mouse button as you 
move the pOinter to the 
right, just before the 
letter 0; then release. 

Notice that column C is now 
widened. 

... A241 : : : Section A 

Press and move with 
pointer on column handle 



Do This 

3 Insert the word Quarter 
in the column heading 
(cell C1) so that the 
heading reads "Next 
Quarter" . 

Here's how 
• CI ick once to select cell 
C1. 
• Click again after the 
word "Next" to select an 
insertion point. 

r=---;-----., 

• Pressthe(Spaceba~ 
and type Quarter. 
• Press (Enter). 

Your spreadsheet is now 
complete. To see it without 
any cell selected, click in 
the deselect box, as shown. 

New heading 
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Printing Your Document 
(Optional) 

What You're About To Do 

If you don't want to print your document now, or don't have a printer available, you can 
skip this section and go on to Putting Your Document Away. 

To print a copy of your finished document, follow the steps below. 

Do This 

1 To ensure that your work 
is saved on the ProFile 
before you print, choose 
Save & Continue from the 
File/Print menu. 

2 Make sure your printer is 
hooked up and turned on. 
(Refer to the manual that 
came with your printer for 
information on 
connecting the printer 
and loading paper and 
print ribbons.) 

... A261 : : : Section A 



Do This 

3 Choose Print from the 
File/Print menu to bring 
up the Print dialog box 
shown to the right. (See a 
different message on the 
screen? Go to the next 
page and read the 
"Trouble with printing?" 
section.) 

4 The current settings in 
the Print dialog box are 
fine, so use the mouse to 
check "OK", as shown. 
(Trouble? See "Trouble 
with printing?" on the 
next page.) 

Notice that the hourglass 
appears for a few moments -
the hourglass means wait - as 
your Lisa records the 
information necessary to print 
the document. 

5 When your document 
begins printing and you 
see the Monitor the 
Printer dialog box, check 
"Proceed", as shown. 
(Trouble? See "Trouble 
with printing?" on the 
next page.) 

Notice that once the hourglass 
disappears and printing begins, 
you can use your Lisa to do other 
work. 
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Page being printed: 0 Of 1 

If you want to do other work while the document is being pnnted, 
click Proceed. Otherwise, just wait. 

If you do decide to Proceed, you can get back here by choosing 
Monitor the Printer from the FilelPrint menu. You should do that if 
you hear a whistle or if you want to terminate printing. 

7 
8 [ 

• I --I 

Click Proceed 
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Trouble with printing? 

• If you see the alert 
message to the right, 
refer to the Lisa Owner's 
Guide, Section D, 
Desktop Manager 
Reference Guide, under 
Set Printer Configuration. 

• If you see any other alert 
message, follow its 
instructions. If needed, 
refer to the Lisa Owner's 
Guide, Section G, 
Troubleshooting, under 
Printers, or see the 
manual that came with 
your printer. 

• To learn more about 
printing, refer to Section 
C, LisaCalc Reference 
Guide, Chapter 2, under 
Print. 
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Putting Your 
Document Away 

What You're About To Do 

Now that you've finished working on your document, follow the steps below to put it 
away. Even if you chose to print your document and it's still printing, you can continue 
to use your Lisa to do other work. 

Do This 

1 Choose Save & Put Away 
from the File/Print menu. 
(Is the Save & Put Away 
menu item dim? Then you 
need to click in the 
document to make the 
window active.) 

Notice how the window zooms 
down to a document icon back 
in its filing home in the LisaCalc 
Examples folder. 
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Starting from Scratch 

What You're About To Do 

In order to start a new spreadsheet, you need to get a piece of LisaCalc stationery, as 
described below. Blank LisaCalc stationery is in a pad called LisaCalc Paper, in the 
ProFile window. 

Do This 

1 Tear off a sheet from the 
LisaCalc Paper pad at the 
top of the ProFile window. 
(Select the pad icon; 
choose Tear Off 
Stationery from the File/ 
Print menu.) 

2 Don't worry right now 
about moving the untitled 
document out of the way. 
Change the name of the 
untitled document to 
Budget. (Make sure the 
icon is selected; then 
type.) 
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Do This 

3 Open the piece of 
LisaCalc paper you 
named Budget as you 
would any document. 
(Choose Open "Budget" 
from the File/Print menu.) 

4 If you want to make your 
own spreadsheet, do so. 
Experiment - try 
different things. Press 
and move across the 
menu bar and look at 
what's in all your menus. 
If you want specific 
information on 
something, look in the 
LisaCalc Reference 
Guide, Section C, or 
check the index. 
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Finishing Up 

What You're About To Do 

It is a good idea to save all your documents and clear off your Lisa's desktop at least 
once a day. The steps below illustrate one of the many ways you can manage things on 
the Lisa desktop. 

Note: When you are connecting, disconnecting, moving, or servicing equipment, you 
must turn off the power. But normally, you should turn off your Lisa only at the end of 
each week, and always leave your ProFile turned on. 

Do This 

1 Choose Set Aside 
"Budget" from the File/ 
Print menu and notice 
how Budget is set aside 
as an icon on the 
desktop. 

Note: When you're working with 
several documents at the same 
time, it's often convenient to 
keep some of them set aside on 
the desktop, where it's easy to 
get at them. 
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Do This 

2 If you want to file the 
Budget document in a 
new place, move it to a 
clear area in the LisaCalc 
Examples folder, as 
shown. (Press with the 
pointer on the icon, move 
it, and release when the 
icon is where you want it.) 

III llsa[alc Examples 11111 
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3 If you want to throw away u===------~~~==.::...------_____r_ 
the Budget document, 
move it to the 
Wastebasket icon. When 
the document icon is on 
the Wastebasket and the 
Wastebasket icon 
highlights, release the 
mouse button and wait 
for the document to be 
deposited. 

Note: You can always get back 
the last thing you've thrown 
away by opening the 
Wastebasket icon and moving 
the deposited document back 
out. 

Gettlng Started Chapter z Chapter 3 Chapter 4 
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Do This 

4 Now set aside both the 
LisaCalc Examples folder 
and ProFile by choosing 
Set Aside Everything 
from the File/Print menu. 

Notice that both the Folder and 
ProFile icons are now set aside 
on the desktop. 

5 You can put away the 
LisaCalc Examples folder 
back in its filing home in 
the ProFile even when the 
ProFile window is closed. 
To do so, select the 
LisaCalc Examples folder 
and choose Save & Put 
Away" LisaCalc 
Examples" from the File/ 
Print menu. 

Note: If you want to deselect a 
selected icon, click once when 
the pOinter is not over the icon. 
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Do This 

6 When you are ready to 
work on something else, 
just open the ProFile 
again. When you want to 
turn off Lisa's power -
for example, over the 
weekend - press the lit 
on-off button, as shown. 
When you turn on the Lisa 
again, everything will 
reappear as you left it 
when you turned the Lisa 
off, including documents 
you may have left open on 
the desktop. Normally, 
you should leave the 
ProFile turned on. 
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A36 ::: Section A 

Using LisaCa/c 

You now have the basic skills necessary for using 
LisaCalc to produce your own LisaCalc documents. 
Because the concepts for using each Lisa tool are the 
same, you also have some of the basic skills for using 
other Lisa tools: LisaDraw, LisaGraph, LisaList, 
LisaProject, and LisaWrite. 

There is much more you can do with LisaCalc. You can 
learn about other LisaCalc features by: 

• Going through other exercises in the LisaCalc Tutorial, 
Section B. 

• Using the LisaCalc Reference Guide, Section C, as you 
do your work. 

• Just experimenting as you use LisaCalc. Remember -
when experimenting, you usually have to select 
something before taking action with it. It's safe to 
experiment because most of the things you do can be 
undone by choosing Undo Last Change from the Edit 
menu. And if you're experimenting with a document 
you've torn off of a stationery pad, you can try almost 
anything and always start fresh by either choosing 
Revert to Previous Version from the File/Print menu, or 
by throwing the document away into the Wastebasket, 
and tearing off a fresh copy from the same stationery 
pad. 



Other LisaCa/c Features 

• Built-in functions, including sum, average, if-then, net 
present value, compound interest factor, annuity 
factor, and more. To see what is available, choose 
Function Hints from the Calculate menu. 

• Being able to Copy a formula and then use Paste 
Adjusting to replicate it into other LisaCalc cells - no 
need to retype a formula over and over. 

• USing split screens to evaluate different parts of your 
spreadsheet at once. 

• Left and right justification, and centering. 

• Inserting new rows and columns. 

• Cutting and pasting between LisaCalc documents, and 
to LisaWrite and LisaGraph. 
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Guide to Lisa Manuals 

Set up your Lisa following the setup procedures in the 
Lisa accessories box or in Appendix 1, Setup 
Procedures, in the Lisa Owner's Guide. 

Go through Section A, LisaGuide, in the Lisa Owner's 
Guide, for an introduction to the Lisa. 

If your dealer or service representative did not set your 
system Preferences so that the Lisa knows what external 
devices are attached, follow the instructions in Section 
D, Desktop Manager Reference Guide, under Set, in the 
Lisa Owner's Guide. 

Go to Section A, Getting Started, in the manual f(u each 
office tool that you want to learn, for the essentials of 
using that tool. 

~ Go to Section B, Lisa Fundamentals, in the Lisa Owner's 
Guide, for the background information you need before 
beginning long-term work on the Lisa. 

You are now ready to start doing your own work on the 
Lisa: 

• If you want self-paced instructions for using a tool, go 
to Section B, Tutorial, in that tool manual. 

• If you want instructions for performing specific tasks 
with a tool, go to Section C, Reference Guide, in that 
tool manual. 

For specific instructions on filing and desktop 
management, go to Section D, Desktop Manager 
Reference Guide, in the Lisa Owner's Guide. 

For more information on the Lisa hardware, tips on 
caring for the Lisa, and suggestions for troubleshooting 
when the system isn't working properly, go to the other 
sections of the Lisa Owner's Guide. 
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What's in the 
LisaCalc Tutorial? 

This tutorial teaches you about LisaCalc as it guides you 
step by step through several real-life examples. To get 
the maximum value from this tutorial, you should tryout 
the examples on your Lisa as you go through it. 

All major LisaCalc features are covered in the tutorial, 
but not always in fine detail. A complete description of 
each LisaCalc feature can be found in Chapter 2 of 
Section C, the LisaCalc Reference Guide, in this manual. 

Before you start this tutorial, be sure you have completed 
LisaGuide, in which Lisa introduces Lisa; you can find the 
LisaGuide diskette in the front pocket of the Lisa 
Owner's Guide. Also, you should have completed Section 
A, Getting Started with LisaCalc, in this manual. If you 
haven't completed one or both already, now is a good 
time to do so. 

To complete the activities in this tutorial, you need 

• The blank LisaCalc stationery pad that is on your 
ProFile . 

• The sample documents for this tutorial that are in the 
LisaCalc Examples Folder on your ProFile. 

The arrow symbol ( ~ ) appears before each activity in 
the tutorial, and it means "Do something." For example, 

~ Turn the page to begin the tutorial. 
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A Travel Expense Report 

This chapter covers the most basic information about 
LisaCalc - how to get started, how to create a simple 
spreadsheet, how to print it, and how to save it. In 
particular, you will learn how to 

• Get a blank spreadsheet. 
• Move around within the spreadsheet. 
• Enter and edit values. 
• Enter and edit formulas. 
• Change display format. 
• Change column widths. 
• Print the spreadsheet. 
• Save or discard the spreadsheet. 
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Getting a Blank 
Spreadsheet 

• • • LisaCalc Tutorial 
841 : : : Section 8 

To see what LisaCalc can do, you're going to set up and 
fill in a typical business travel expense report. When you 
finish, you can print it to see the results. Figure 1 shows 
you what this report looks like when it's typed on a piece 
of paper. 

Travel Expense Report 
Name: Marco Polo 
Dest: Cathay 
Date: May 1, 1244 

Item 

Hotel 
Lunch 
Dinner 
Breakfast 
Car: No. Miles 130 

Rate .20 
Total 

Total 

Figure 1. Travel Expense Report 

55.00 
5.00 

13.80 
3.75 

26.00 

103.55 

To follow the example in this chapter, you need to create 
a new LisaCalc spreadsheet, 

~ Open the ProFile 
window by clicking twice 
on the ProFile icon. 

~ Tear off a spreadsheet 
by clicking twice on the 
LisaCalc stationery pad 
icon. 

~ Name the new document 
by typing your initials 
followed by Ch 1. This 
allows other people to 
use the same ProFile 
and not get their 
documents confused. 

a -



~ Open the document by 
clicking twice on its icon. I~ 

What you now see on your screen - a LisaCalc window 
containing a blank spreadsheet - should match Figure 2. 

Figure 2. Blank LisaCalc Spreadsheet 

The LisaCalc window has two parts. The bottom part is a 
view of the spreadsheet and the top part is the status 
panel, which contains information about the 
spreadsheet. 

The spreadsheet consists of cells, arranged in rows and 
columns. The rows run left and right and the columns run 
up and down. On your screen, the numbers 1 to 17 at the 
left of the spreadsheet identify the rows. The letters A to 
J at the top of the spreadsheet identify the columns. 

Each cell is identified by a column letter and a row 
number. For example, cell A 1 is the cell in column A and 
row 1. 

The status panel consists of the Cells area, the Value 
area, and the Formula area; these display the 
coordinates, value, and formula of the current cell, which 
is the cell you're currently working with. Since you 
haven't done anything yet, there is no current cell, and 
nothing is shown in these areas. 
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Entering Text 
and Numbers 

• • • LisaCalc Tutorial 
B61 : : : Section B 

Before you can enter anything in a cell, you have to select 
it. To select A 1, 

~ Using the mouse, move 
the pointer to any point 
within the cell. 

~ Click the mouse button. 

When you select A 1, it 
changes to inverse video 
(black instead of white), 
indicating that it is now the 
current cell. The pointer 
changes to an I-beam. If 
you move the pointer 
around, you will discover 
that it is an I-beam only 
when it is over the cell. 
Everywhere else in the 
spreadsheet, it is still a 
cross. 

In the status panel, A 1 now 
appears in the Cells area, 
indicating that A 1 is the 
current cell. In addition, in 
the Value area, the word 
Blank appears in 
parentheses after the word 
Value. This is the part of the 
status panel that tells you 
what type of value is in the 
cell; right now, the cell is 
blank. 

B ............. i ........... ~ 

" G (ells: Al 

1 Value (Blank): 

LisaCalc cells contain values; a value is either a number 
or a label. To create the travel expense report, start by 
typing a label in A 1: 

~ Type 

Travel Expense Report 

If you make a mistake, press the (Backspace) key to 
correct it. 



Changing 
Column Widths 

As you type, watch the screen. As soon as you start 
typing, the pointer disappears and a blinking vertical line 
appears. This line is called the insertion point; it shows 
you where the next letter you type will be displayed. If you 
move the mouse, the pointer reappears, but the insertion 
point stays where it is. Moving the mouse around does 
not change the current selection until you press the 
mouse button. 

The letters you type appear simultaneously in two places: 
in the cell, and in the Value area of the status panel. Also, 
the word Blank in the Value area has gone away; this is 
because the cell is no longer blank. 

What happens when you get to the right boundary of A 1, 
that is, when you have typed Travel E? From here on, the 
letters don't appear in A 1, but they do appear in the 
Value area. Why is this? 

The reason is that every column in a LisaCalc 
spreadsheet has a set width. If a value is too long to be 
shown in the spreadsheet, only the leftmost part of the 
value is shown. The whole value, however, always 
appears in the Value area. 

Before LisaCalc can do anything with the value in a cell, 
you must enter the value. To enter the value in A 1: 

~ Press the (Enter) key on 
the numeric keypad. 

There are a number of different ways to enter a value, 
which you'll see as you read on. The (Enter) key enters the 
value while keeping the same cell as the current cell. 

Another change when you 
press (Enter) is that the 
Value area now shows the 
word Text. This means that 
the value you have just 
entered is text, rather than 
a number. 

I Value (Text): 

Now you can change the width of column A to hold the 
whole label you entered. To do this, you have to select the 
grid handle between column A and column B. The grid 
handle is the double line between the letters A and B at 
the top of the column. 
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Mistakes 
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~ Move the pointer to the 
grid handle. 

A :IE B 

~ Press and hold down the mouse button. 

~ Move the pointer to the 
right. Notice that a 
flickering line appears 
where the pointer is. 

~ When you think the 
column is wide enough 
to show the whole label, 
release the mouse 
button. 

BT..!..~V.:'1 .... t.E ...... ~ ............. \' 
A 

You can move the column boundary to the right or left, as 
necessary. If it is still not right, repeat the same 
procedure until all the letters you typed are showing in 
A1. 

Now that you have more room in column A, you can enter 
some more labels. Start with A2: 

~ Select A2. Type 

Name: Marco Polo 

~ To get to cell A3, press 
the <l!P key once. 

When you select A3, the value in A2 is entered. Whenever 
you select a different cell, LisaCalc enters the value in the 
current cell before selecting the new cell. 

In typing the next few labels, you're going to learn some 
ways to correct mistakes. So type these labels exactly as 
shown, including the mistakes: 

~ Type 

Dest: Catay <l!P 
Date: Maay 1, 1944 

<l!P<l!P 
Itemm 

You should now be in cell A6. 

A 

t8.·~~.;·.~.h·~·.~.~!.::·~.~.~ .. ~·.~·.~·.~~~.~·.··.··.·.· ............ . 
~ p.~.~.t.: ..... f..~~.~·i .................................................... 1. 
4 Date: Maa··,! L 1944 ~ 5· .. ···· .. · .. ··· .. ·· .. · .. ·· .... · .. · .. ) .. ·· .. ······ .. · .... · .... · ...... ··· ........................ j. 

6 Itemm I 



Backspacing 

~ While the insertion mark 
is still positioned after 
the double "m," press 
the (Backspace) key to 
erase the extra "m." 

Inserting 

To change Catay into Cathay: 

~ Select cell A3. 

~ Position the pointer just [Dest: ca'Nay 
after the "t" and click ......... --..r\~r---_---a 
the mouse button. An 
insertion point appears 
after the "1." 

~ Type the letter "h." [Dei[ catiy 
In order to insert text in a cell, you have to click the 
mouse button once to select the cell, and then again to 
put the insertion point where you want it to be. If you only 
click the button once, then when you start to type, you 
will replace the whole value of the cell, rather than 
inserting text in a particular place. 

Deleting 

To delete the extra "a" in Maay: 

~ Select A4. 

~ To select a single letter, 14 IDate: t'1!ay 1: 1944 
move the pointer to just 
before the first "a." 
While holding down the 
mouse button, move the 
pOinter to the right until 
the letter is shown in 
inverse video (white on 
black). Release the 
mouse button. 
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~ Choose the Cut item 
from the Edit menu. 

Replacing 

To change 1944 to 1244: 

~ Move the pointer to the 
Value area and select 
the "9," then type a "2." 

Undo Last Change 

Cut t'. etx; -
Dat e: ~18V 1,. 1144 

Det e: 1"1ev 1,. 1244 

This last example shows that text in a cell can be edited 
either in the spreadsheet view or in the status panel. At 
this point, your screen should look like Figure 3. 

'I 

"G Cells: A4 Value (Text): Date: May 1, 1;144 

B c D E 

Figure 3. After Correcting Mistakes 

Clear Entries 

Now, make another deliberate mistake: 

~ Select A3. 

~ Choose Clear Entries from the Edit menu. 



As you can see, Clear Entries wipes out the contents of a 
cell. It is especially useful when you want to quickly clear 
a lot of cells at once. It differs from Cut in that Cut puts 
the contents of the cell onto the Clipboard, and Clear 
Entries just wipes them out. However, you can still 
correct the situation. 

Undo Last Change 

~ Choose Undo Last Change from the Edit menu. 

Undo Last Change reverses the effect of the last 
operation you performed; it "turns back the clock." In 
this case, it undoes the Clear Entries. The cell is restored 
to the state it was in just before the Clear Entries. Not all 
operations can be undone by Undo Last Change; for 
example, you cannot undo entering a value in a cell. 

Restore Previous Entry 

Since Undo only undoes the last operation you did, 
sometimes you can't turn back the clock as far as you'd 
like. To see this, 

~ Select A2. 

~ Type 12 IThis is 8 mist8k~D 
This is a mistake. 

What you have typed replaces the previous contents of 
the cell. 

~ Select the word 
"mistake" by 
positioning the pointer 
over the word and 
clicking the mouse 
button quickly twice. 

~ Choose Cut from the Edit Menu. 

~ Choose Undo Last Change from the Edit menu. 

Undo Last Change undoes the cut of the word 
"mistake," which is the last operation, but it can't 
restore the original contents. However, there is a way out. 

~ Choose Restore Previous Entry from the Edit menu. 
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Restore Previous Entry returns the cell to the way it was 
the last time you selected it, no matter how many 
complicated operations have intervened. However, once 
you have selected another cell, or chosen Clear Entries, 
you cannot restore the contents of the original cell. 

Now you can enter some of the expense items. To match 
the travel expense report in Figure 1, the titles for the 
expenses are going to be in column A and the expenses 
are going to be in column C. 

~ Go to cell A8, either by 18 IHotell 
clicking in the cell or by L...;;;....~..;;..;..;~ _______ ......I 

pressing the ®) key 
repeatedly. Type 

Hotel 

To enter the hotel amount in C8 

~ Press the ~ key twice. 

~ Type 

55.00®) 

Notice that C8 shows the amount as 55, with no zeros. 
This is because all numbers are shown as simply as 
possible unless you specify a specific number style. Since 
almost all the numbers in this spreadsheet are money 
amounts, you would like to display them as dollars and 
cents: each number should have a decimal point followed 
by two digits. To do this, you can change the number 
style of all the cells to a monetary format. Here's a simple 
way to change the number style of the whole 
spreadsheet: 

~ Choose Select All of Document from the Edit menu. 

This menu option selects all the cells in the spreadsheet. 
Notice that all the cells on your screen are shown in 
inverse video. 



~ Choose 1234.56 from 
the Format menu. 

Each of the monetary number styles shows what the 
value 1234.56 looks like displayed in that number style. 
You can display the values with or without a dollar sign, 
with or without commas, and with or without the cents. If 
the cents are omitted, the value is rounded to the nearest 
dollar. 

Once you choose 1234.56 
as the number style, 
LisaCalc displays all the 
numbers in the spreadsheet 
as dollars and cents, with 
no dollar sign. In fact, if you 
look at ca, you'll see that its 
value is now shown as 
55.00. 

Continue entering expenses: 

~ Select A9 and type 

Lunch CW<rID 
5 (Enter) 

LDE!.'69b.· ................................................ .. 

You might notice that the 5 in A9 is shown as 5, not as 
5.00. Whenever a cell is selected, its value is shown 
unformatted, regardless of the number style in the cell. 
This is so that you can edit the value. When you leave the 
cell by selecting another cell, the value reverts to the 
number style you specified. 

~ To get to A 10, press 
(Return), which selects 
the first cell in the next 
row. 
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~ Type 

Dinner~~ 
13.8 (Return) 

Breakfast~~ 
3.75 (Return) 

Your screen should look like Figure 4. 

El 'I 

It G (ells: A12 Value (Blank): 

B c D E 

Figure 4. After Entering Hotel and Meal Expenses 

G 

Entering Formulas To include the car expense in your report, you need to 
multiply the number of miles traveled by the amount 
allotted per mile, which is $.20 in this example. First, 
enter the number of miles and the amount per mile in 
column B: 

• • • LisaCalc Tutorial 
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~ With cell A 12 selected, type 

Car: No. Miles ~ 
130 (Return) 

Mileage Rate ~ 
.20 (Return) 

CarTotal~~ 



To calculate the total car expense, you need to use a 
formula. A formula is a rule that computes a value, based 
on other values; it appears in the Formula area of the 
status panel. 

In this case, you want a formula that says: 

Car expense = Number of miles X Amount per mile. 

Substituting the corresponding cells, you get 

C14 = 812 * 813 

In LisaCalc the * is used as the multiplication operator. 
To enter the multiplication formula to compute car 
expense in C14, 

~ Select the Formula area 
by clicking anywhere 
within the area. An 
insertion point appears. 

~ Type the formula 

B12*B13 (Enter) 

I It M Formulo:l--

• M Formula: B12*B13 

You can type the 8's in lower case, if you want; LisaCalc 
automatically changes them to upper case when you 
enter the value. 

Your screen should look like Figure 5. 

". " G [ells: C14 Value (Number): 26 

" M Formula: B12*B13 
B c o E G 

Figure 5. After Entering Car Expenses 

C14 now shows the result of the calculation, 26. 
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Now you're ready to calculate the total for the whole 
spreadsheet. To do this, you want to add the values in 
C8, C9, C10, C11, and C14. The formula for this is: 

C8+C9+C10+C11 +C14 

~ Enter the label Total in [![]f.',9.f,~,~"",'"'''''',',',''''''''''''''''',''''',','.',',''',''',''''',' .. ,' ...... ,',' .. ,' .................. ,' .. ,',' ............. ' ...................... : A16. 

~ Select C16. 

~ Select the Formula area. 

~ Type I "M Formula: C8+C9+C10+C11+C14 

C8+ C9 +CIO+ CII + CI4(Enier) 

C16 shows the total, 103.55. This formula is somewhat 
cumbersome; you'll learn an easier way to add a column 
of figures in the next chapter. 

Your screen should look like Figure 6. 

'. "G (ells: C16 Value (Number): 103.:,5 

" M Formula: C8+C9+ClO+C11+C14 
ABC 0 E 

Figure 6. After Entering Total 

Whenever you change a value that is used in a formula, 
the value of the formula changes automatically. For 
example, suppose your company changes the mileage 
rate from 20 cents a mile to 22 cents a mile. If you change 
the cell containing this value, the cell containing the total 
car expense will change automatically. To replace the 
value in 813: 

~ Select 813. 



~ Type .22) 

.22 (Enter) 

What happens? As soon as you press (Enter), the value in 
B13 is updated, the value in C14 changes to 28.60, and 
the value in C16 changes to 106.15. If you look fast, you 
can see the cells that are changing turn gray before the 
new value is displayed. LisaCalc grays a cell before it 
recalculates its value to let you know which cells are 
being recalculated. 

Now you've filled out an entire expense report. It should 
look like the one in Figure 7. 

". " G Cells: 813 Value (Number): .22 

"M Formula: 

Figure 7. Completed Spreadsheet 

Before you go on to print the spreadsheet, this would be 
a good time to stop and save the work you have done so 
far. You should get in the habit of saving your work from 
time to time, so as to minimize the effect of power 
interruptions or other unforeseen problems. Don't wait 
until you have completed a spreadsheet to save it. 

To save your spreadsheet, 

~ Choose Save & Continue 
from the File/Print 
menu. 

Chapter 1 
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While your spreadsheet is being saved, you see a Wait 
alert message informing you that this is what's 
happening. 

To print a spreadsheet, you naturally have to have a 
printer connected to your Lisa. If you don't have a printer, 
or it is not set up, you may skip this section for now, and 
proceed to Filing a Spreadsheet, later in this chapter. 

To find out how to set up your printer and hook it up to 
the Lisa, refer to the manual that came with your printer. 

You also need to set up Preferences correctly for your 
printer. If you have not already done this, do it now. To set 
up Preferences for your printer, refer to Section D, 
Desktop Manager Reference Guide, in the Lisa Owner's 
Guide, under Set Printer Configuration. 

Once the printer and Preferences have been set up, 
printing your first spreadsheet is easy. 

~ Just choose Print from the File/Print menu. 

A Print dialog box appears on your screen, as in Figure 8. 

-----------------------~~.---. --

Print... • Finished Quality 0 Quick Draft (Text Only) ( [ancel 
o One Copy While You Wait • While You Work , ...... ,.""".""""."""'.""''''''.''' 

• All Pages 0 Only,. """ .. ,,,""",.,,.,,""""""""""""""""'; 

Number of Copies: B0ITJ[]ITJ0000§J 

Figure 8. Print Dialog Box 

All print settings are as you need them right now. You 
learn to use the different settings available in the Print 
dialog box and the Format for Printer dialog box in 
Section C, LisaCalc Reference Guide, Chapter 2, under 
Print. 

~ Click OK in the dialog 
box. 

( OK ~ ) 



Filing a 
Spreadsheet 

Your Lisa now displays a message saying that it is 
preparing to print your document and allow you to 
continue working, since the Print dialog box specified 
that you wanted to print your spreadsheet while you 
work. After that message, the Lisa displays an alert box 
asking you if you want to cancel the printing or proceed 
with it. To respond to the message, 

~ CI ick Proceed to ','.i'4, .• 
continue working while 
your document is being 
printed. 

If your Lisa cannot print the spreadsheet while you work, 
it will display a message to let you know that, and you will 
have to wait until the document is finished printing and 
the message disappears. 

At this point, you can put away the sample spreadsheet. 
To do this: 

~ Choose Save & Put Away from the File/Print menu. 

The document window closes automatically, and its 
document icon goes back beside the stationery pad in 
the disk window. 

Now you can move the document icon to an empty place 
in the disk window. 

~ Move the pOinter into 
the spreadsheet icon. 
Press and hold the 
mouse button while 
moving the icon to an 
empty place in the disk 
window. 

~ Release the mouse button. 

i.1 

This completes Chapter 1. Go on to the next chapter, if 
you like, or come back to it at a later time. 
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Chapter (Enter) • Enter the value; leave the 
Summary same cell selected. 

@) • Enter the value; select 
the cell above the current 
cell. 

®) • Enter the value; select 
the cell below the current 
cell. 

~ orCTab) • Enter the value; select 
the cell to right of the 
current cell. 

00) • Enter the value; select 
the cell to left of the 
current cell. 

(Return) • Enter the value; select 
the leftmost cell in the 
next row down. 

Get a new spreadsheet • Open the ProFile window. 

• Click twice on the 
LisaCalc stationery pad. 

• Type a title for the 
spreadsheet. 

• Click twice on the 
spreadsheet icon. 

Enter value • Select the cell. 

• Type the value, followed 
by 
(Enter) or by another 
selection. 

Edit value • Select the cell. 

• Select the part of the old 
value to be changed. 

• Type the replacement 
characters, followed by 
(Enter) or by another 
selection. 

• • • LisaCalc Tutorial 
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Move from cell to cell 

Enter formula 

Change column width 

Change number style 

• Press any arrow key to 
move in the same 
direction as the arrow. 

• Press (Return) to select 
the first cell in the next 
row. 

• Press (Tab) to select the 
next cell on the right. 

• Select the cell you want 
to enter the formula in. 

• Select the Formula area. 

• Type the formula, 
followed by (Enter) or by 
another selection. 

• Select the grid handle to 
the right of the column to 
be changed. 

• Holding the button down, 
move the pointer to the 
right or the left. 

• When the column is the 
right width, release the 
button. 

• Select the cell or cells to 
be changed. 

• Choose the new number 
style from the Format 
menu. 
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Print the spreadsheet 

Save the spreadsheet 
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• If you haven't set up your 
printer yet, see the 
manual that came with 
your printer. 

• If you haven't set printer 
Preferences yet, see 
Section D, Desktop 
Manager Reference 
Guide, in the Lisa 
Owner's Guide, under 
Set Printer 
Configuration. 

• If you need to change any 
of the options in the 
Format for Printer dialog 
box for your document, 
choose Format for 
Printer from the File/ 
Print menu and change 
the options. 

• Choose Print from the 
File/Print menu. 

• Respond to any dialog 
boxes that appear. 

• Choose Save & Put Away 
from the File/Print menu. 
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A Department Budget 

In this chapter, you will learn how to use a different kind 
of spreadsheet - a department budget. In the process, 
you will learn more about LisaCalc, including how to 

• Copy formulas from one cell to another. 
• Use constants. 
• Use the Sum function to add a column of numbers. 
• Change formulas. 
• Create reusable spreadsheets. 
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In the last chapter, you started with a blank spreadsheet 
and filled in all the information yourself. In this chapter, 
you're going to start with a spreadsheet that already has 
some information on it, and learn how to complete it. 
When you're done, you're going to make it into a 
template, which is a framework that can be reused to 
create similar spreadsheets with different values. 

First, you have to get the spreadsheet named Chapter 2. 

To begin, 

~ Open the ProFile 
window. 

~ Open the LisaCalc 
Examples folder. 

~ Tear off a spreadsheet 
from the stationery pad 
named Chapter 2. 

~ Type a name for the 
spreadsheet. 

~ Open the spreadsheet 
by clicking twice on its 
icon. 

I 
~ ~ 
~ 
W 

GCP-Chapter :2 

I~ 
Figure 9 duplicates what you see on your screen. 



Formulas 
and Values 

111111 G[P-[hapter 211111 

" G [ells: Value: 

c D E G 

Figure 9. Initial Department Budget Example 

In this department budget, each row is a different budget 
item; column A contains the labels for the items. 
Eventually, you will have one column for each month. 
Right now, only the column for January, column 8, is 
present. 

Some of the cells in column 8 contain formulas; these 
cells already show values computed from the formulas. 
They're all zero right now. You're going to fill in the rest of 
the cells yourself. 

First, enter a value for January salary. This will be the cell 
in the Salary row and the January column, 84. 

~ Select 84 and type 62. ::.cil 

62.50 (Enter) 

As soon as you enter a value in 84, all the cells that were 
zero show new values. This is because these cells contain 
formulas that depend on the value in 84. Every time 84 
changes, these other cells change. 

Take a minute to look at some of these other cells and 
see what their formulas are. 
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Function 
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~ Select 85. 

Look at the Formula area. The formula is 

.3*84 

That is, the fringe benefits for January are 30% of the 
salary for January. 

~ Select 87. 

The formula for Payroll Expense in 87 is 

84+85 

so Payroll Expense is Salary plus Fringe 8enefits. 

817, Other Expenses, is the total of all expenses except 
payroll expenses. To see the formula in this cell, 

~ Select 817. Ii G (ells: 817 Vol 

Ii M Formula: sum(89:815) 

The formula is 

Sum(89:815) 

This formula is an example of the Sum function. It stands 
for the sum of all the cells from 89 to 815. It is the same 
as the formula: 

89+810+811 +812+813+814+815 

The notation 89:815 stands for the range of cells 
beginning with 89 and going to 815. A range is any 
rectangular group of cells. It can be any number of cells 
vertically and horizontally. You will be using this notation 
frequently in LisaCalc; there are quite a few operations 
that can be done to a range of cells instead of just to a 
single cell. 

In function notation, the items between the parentheses 
are called the arguments of the function. In this case, 
there is just a Single argument, the range 89:815. The 
Sum function adds the values of all its arguments. If any 
cell is blank or contains a label, its value is O. 



Scrolling the 
Spreadsheet 

To complete January expenses, 

~ Fill in the remaining values as follows: 

Cell Value 

89 10.50 

810 2.30 

811 1.00 

813 46.90 

814 35.30 

815 4.86 

If you've entered all the values correctly, the value of 
Total Expenses should be 185.24. Your screen should 
look like Figure 10. 

El 

3 
4 
5 

• G (ells: 615 

10 
11 
12 
13 
14 
15 
16 
17 
18 
19 

IIIIII GCP-Choptet 2 IIIII 
Value (Number): 4.86 

c o 

Figure 10. January Expenses 

E G 

In this spreadsheet, there are cells that have been filled 
in but are not visible on the screen right now. To see 
them, you need to scroll the spreadsheet up. Here's one 
way to scroll: 

~ Move the pointer to the 
scroll bar at the right of 
the spreadsheet and 
position the pointer 
within the downward-
pOinting scroll arrow. 

Scroll arrow 
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~ Press and hold the 
mouse button. As the 
spreadsheet moves up, -....:;..~_ 

higher numbered rows 
come into view. Keep 
your finger on the mouse 
button until row 22 
comes into view, then 
release the mouse 
button. 

If you scroll too far, use the upward-pointing scroll arrow 
to scroll back the other way. When you're through, the 
screen should show rows 4 through 22, as shown in 
Figure 11. 

IIIII GCP-Chapter 2111111 

" G Cells: 815 Value (Number): 4.86 

c o E G 

Figure 11. After Scrolling 

Two new labels have come into view. The value of Sales 
Forecast (821) is blank, but the value of Expense % (822) 
is shown as Infinity. What does this mean? 

~ Select 822. 

The formula in 822 is 819/821 * 100. This formula 
computes what percentage Total Expenses are of Sales 
Forecast by dividing 819 by 821 and multiplying the 
result by 100. The division is performed before the 
multiplication, so the formula is the same as: 

(819/821)* 100 



Using Constants 

Editing the 
Cells Area 

B21 has not been given a value yet, so it is treated as 
zero for the time being. Since division by zero is not 
possible, LisaCalc gives B22 a special value, Infinity. This 
value is usually the result of division by zero, but it can 
also mean that a value is too large for LisaCalc to 
recognize. 

Now enter a value for January Sales Forecast: 

~ Select B21 and type 

390 (Enter) 

The value Infinity in B22 is replaced by 47.50. 

Constants can save you time when you update the 
spreadsheet. To see how, take another look at some of 
the formulas. Start with Fringe Benefits: 

~ Select B5 and look at the formula: 

.3*B4 

This formula says that Fringe Benefits are 30% of Salary. 
If Fringe Benefits increase and the percentage changes, 
you'll need to change this formula. If the Fringe Benefit 
percentage is used in several different formulas, you'll 
have to change it in each place. 

To avoid making the same change in several different 
places, you can put the percentage in a cell by itself, and 
rewrite the formulas so that they refer to the coordinates 
of this cell, not to the actual percentage. Then, when you 
need to change the percentage, you only need to change 
it in one place. A value used in this way is called a 
constant. 

You can also use a constant in the formula for Supplies. 
You can set up cells for the constants in any convenient 
location. In this case you will use cells B24 and B25. 
These cells are now below the bottom margin of the 
spreadsheet. 

To get to cells B24 and B25, you can use a different 
method for moving around the spreadsheet: replacing 
the coord inates in the status panel. 
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~ Move the pOinter to the 
Cells area and position it 
just before the letter 8 in 
85. 

~ Select the whole "word" 
85 by quickly pressing 
the mouse button twice. 

~ Type in the new 
coordinates, 825, 
followed by (Enter). 

I "G (ells:15 

I • (j (ells: II 

I "G (ells: 825 

When the coordinates are replaced, the spreadsheet 
scrolls automatically to show 824 and 825. 

8efore entering the constants, you need to enter some 
labels so you know which constant is which. The labels 
will be in column A, and the amounts in column 8. 

To enter the labels, 

~ In A24, type 

Fringe % (Return) 

Supp.% 

To enter the amounts, 

~ Select 824 and type 

.3 <b!» 

.05 (Enter) 

Now you can change the formulas that use the constants. 
First, you want to change the formula in 85. To get to 85, 
you can edit the Cells area, using a slightly different 
procedure, 

~ While holding down the 
@ key, press the G key. 

Notice that 825 in the Cells area is highlighted. 

~ Type 

B5 (Enter) 



Copying Cells 

The @ key feature is a convenience that allows you to 
perform many procedures directly from the keyboard, 
without the mouse. The @ key can be used to 
abbreviate other system commands as well. These will be 
mentioned as they come up; Appendix 2, Apple Keys, in 
this manual contains a complete list. 

~ Select the .3 in the 
Formula area and type 

B24(Enter) 

" G [ells: 85 
" M Formula: 824*84 

The formula now refers to the cell that contains the 
constant, not to the constant itself. The value in 85 does 
not change. 

Make the same kind of replacement in the formula in 
812: 

~ Change the formula in 
812 to 825*84, then 
press the (Enter) key. 

• G [ells: 812 
• M Formula: 825*84 

Now that you've finished column 8, you can expand the 
spreadsheet to show all 12 months. First, you want to 
scroll back to row 1. To do this, you can use the elevator, 
which is the quickest way to scroll. 

The elevator is the empty white box in the scroll bar; a 
LisaCalc window has a vertical elevator and a horizontal 
elevator. The position of the elevator within the scroll bar 
indicates the position of the spreadsheet view within the 
document. If the elevator is all the way to the top, the 
spreadsheet view shows the top part of the spreadsheet, 
including row 1. If the elevator is somewhere in between 
the top and the bottom, the spreadsheet view shows a 
part of the spreadsheet in the middle. 

To get back to the top of the spreadsheet, 

~ Move the pOinter to the 
vertical elevator. ~ 

~~ 
~ While holding down the mouse button, move the 

elevator as far up in the scroll bar as it will go, then 
release the mouse button. 
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~ Now type the names of the months in the indicated 
cells, using the (Tab) key to get from cell to cell: 

Month 
Cell Name 

C1 Feb 
D1 Mar 
E1 Apr 
F1 May 
G1 Jun 
H1 Jul 
11 Aug 
J1 Sep 
K1 Oct 
L1 Nov 
M1 Dec 

Your screen should look like Figure 12. 

11111 GCP-Chnpter 21'1111 

"G [ells: Ml Deq 

Figure 12. After Entering Month Names 

To return to column A, you're going to scroll the 
spreadsheet using the view button, which is the box in 
the scroll bar next to the scroll arrow. There are two view 
buttons in the vertical scroll bar and two in the horizontal 
scroll bar. Every time you click in one of the view buttons, 
you move the spreadsheet one "windowful" in the 
indicated direction. That is, the upper view button in the 
vertical scroll bar moves the spreadsheet up one 
windowful, and so forth. To return to column A, 

~ Move the pOinter to the 
left view button on the 
horizontal scroll bar. 

___ £5Lill~ 
View button ~!l 

~ Click the mouse button once. 

Now you can copy the values and formulas from column 
B into columns C through M. To learn about different 
ways to copy, you're going to copy column B one cell at a 
time. In Chapter 3, Revising a Spreadsheet, you'll learn a 
way to copy a whole column in one operation. 



Copying a Cell with Paste 

The simplest way to copy a cell is with the Paste item 
from the Edit menu. Paste makes an exact copy of the 
cell. For example, assume that the value for Occupancy is 
the same for all 12 months. You want to copy 89 into C9 
through M9. Here's how to do it, 

~ Select 89. 

~ Choose Copy from the Edit menu. 

~ Select the Cells area by moving the pointer to it and 
clicking the mouse button three times. 

~ Type I • G Cells: C9 :~19 
C9:M9 (Enter) 

The notation C9:M9 indicates the range of cells from C9 
to M9, inclusive. Whenever you edit the Cells area to 
select a range, and part of the range is not showing on 
the screen, LisaCalc scrolls the spreadsheet so that the 
range is in the upper left corner. 

~ Choose Paste from the Ed it menu. 

The value in 89 is duplicated in each of the cells from C9 
to M9. 

Similarly, assume you want the values for 
Communications and Personnel to be the same every 
month. You also want to copy the ($000) in row 2. To do 
this, 

~ Select 810 by editing the Cells area. 

~ Choose Copy from the Edit menu. 

~ Select C10:M10. 

~ Choose Paste from the Edit menu. 

~ Copy the value in 811 into cells C11:M11. 

~ Copy cell 82 into cells C2 through M2. 

~ Scroll the spreadsheet back so that A 1 is showing. 

When you are through, your screen should look like 
Figure 13. 
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111111 G[P-[hllpter 2111111 

" G [ells: [2:112 Value: 

"M Formula: 

Figure 13. After Pasting Cells 

Copying a Cell with Paste Adjusting 

What if you expect an expense to increase each month? 
For example, assume that the value for Salary, row 4, 
goes up by 1% each month. What's the easiest way to get 
the right formula into each cell in the row? 

The first thing to do is establish the value for February. 
Since the value each month is 1 % greater than the month 
before, the formula in C4, February, should be 1.01 * 84; 
that is, 101% of 84. 

~ Select C4, select the 
Formula area, and type 

1.01 *B4 (Enter) 

• G [ells: C4 

• M Forrnula: 1.01 *B4 

Now you want the formula in 04 to be 1.01 *C4, the 
formula in E4 to be 1.01*04, and so on up to M4. To copy 
the formula in C4 to the range 04 through M4, you can 
use Copy to copy C4 to the Clipboard, then paste the cell 
to 04:M4. However, in this case, you can't use the Paste 
menu item, because the formula in each cell then would 
be 1.01*84. Instead, you're going to use Paste 
Adjusting. 



Paste Adjusting pastes a copy of a cell to a range of cells, 
adjusting the coordinates appropriately for the new cells. 
In this case, what you need is a formula in each cell that 
says, "take the cell immediately to the left of this cell, 
and multiply it by 1.01." In 04, this would be the formula 
C4*1.01. To copy from C4 to the other cells in the row, 

~ Choose Copy from the Edit menu to copy C4. 

~ Select the range 04:M4 
by editing the Cells area. 

~ Choose Paste Adjusting 
from the Edit menu. 

I "G (ells: D4:~14 

Hesh:ne Previous f:nt:rq 

Now you see the dialog box shown in Figure 14. The 
dialog box for Paste Adjusting shows you what the 
formula would be for cell 04. You know that the formula 
is for 04 because you see 04 next to the word Cells in the 
upper left-hand corner of the dialog box. When the 
formula for 04 is exactly what you want, LisaCalc will 
copy a similar formula into all the cells in the range. 

Cell: D4 

Same 

o 
Formula: 1.01*C4 

I 
Relative 

Figure 14. Dialog Box for Paste Adjusting 

The dialog box shows you what formula will be in 04 
when you click OK. Right now, it shows the formula 

1.01 *C4 

which is exactly what you want for 04. If the formula were 
not correct, you could change it before clicking OK; you'll 
see an example of this later in this chapter. By telling 
LisaCalc what formula you want in 04, you are telling it 
you also want the same sort of formula in all the other 
selected cells. To finish pasting, 

~ Click OK. ( OK ~ ) 
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The salary values for the remaining months appear as 
63.76, 64.39, and so forth. 

Assume you want to do something similar for 
Advertising. Let's say Advertising increases by 3% each 
month. First establish the value for February. This time, in 
entering the formula, you will see how you can use the 
mouse instead of the keyboard to enter cell coordinates. 

~ Scroll the spreadsheet so that A 1 is showing. 

~ Select C13, then select the Formula area. 

~ Type It G Cells: C13 
1.03* It M Formula: 1.03*1 

~ Move the pointer to B 13. R8,§ .. : .. ~.9.J 
~ Holding down the (Option) 

key, click the mouse 
button. 

Notice that the coordinates of the cell you clicked in 
appear in the Formula area. Because you held down the 
(Option) key, you did not actually select B 13. 

~ Press the (Enter) key. 

Now copy the formula into the other months: 

~ Choose Copy from the Edit menu. 

~ Select the range 
D13:M13. 

/etG (ells: D13:M13 

~ Choose Paste Adjusting from the Edit menu. 

In the dialog box that comes up, you can see that the 
formula for D13 is the one you want, so no changes are 
needed. To finish the paste, 

~ Click OK. OK ~ J 

Now you want to do the same thing for Sales Promotion, 
Other, and Sales Forecast. Sales Promotion will increase 
by 3% each month, and Other and Sales Forecast will 
increase by 4%. 

~ Enter the following formulas in column C and use 
Paste Adjusting to copy them to columns 0 through 
M. 



Item 

Sales Promotion 

Other 

Sales Forecast 

Row 

14 

15 

21 

Formula 

1.03*814 

1.04*815 

1.04*821 

When you finish, your screen should look like Figure 15. 

I GCP-Chnpter- 2 ,II 

1-:::....::...~..::;~:r:.:..:I1:.:..:~-=U~..::;~~:.:..::M.;::2=-1 _..J.;...;VO:.;..:IU:.:;.I!:.....: ----------------1!I!il~ 

Figure 15. The Spreadsheet So Far 

Next, you want to extend the value for Payroll Expenses. 
To see the formula in this cell, 

~ Select 87. 

For each month 

Payroll Expenses = Salary Expense + Fringe Benefits 

In other words: 

87 = B4 + B5 

C7 = C4 + C5 

and so forth. In this case, you don't have to set up a 
formula in column C; you're just going to extend the 
formula in column 8 to columns C through M. To do this, 

~ Choose Copy from the Edit menu. 

~ Select the range C7:M7. .; G [ells: C7 :M7 
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~ Choose Paste Adjusting from the Edit menu. 

~ When the dialog box 
appears, verify that the 
sample formula is 
correct, then click OK. 

OK ~ J 

If the numbers in row 7 look wrong, it's because the 
Fringe Benefits row hasn't been filled in yet. This will be 
remedied shortly. 

~ Follow the procedure above to fill in the values for 
Other Expenses (row 17), Total Expenses (row 19), 
and Expense % (row 22). 

When you are finished, scroll your spreadsheet back to 
A 1; your screen should look like Figure 16 . 

• (j [ells: 
• M Formula: 

Figure 16. The Spreadsheet So Far 

So far, you have copied cells without making any 
changes, such as Occupancy, and you have copied cells 
in which all the coordinates were changed for each 
occurrence, such as Payroll Expenses. You can also copy 
cells while changing some coordinates but not others. 

For example, suppose you want to copy Fringe Benefits. 

~ Select B5. 



The formula in B5 is B24 * B4. In this formula, B24 is a 
constant, while B4 changes each month. You want to 
leave the constant the same, but change the salary for 
each month. That is, the formula for February (column C) 
should be B24 *C4, the formula for March (column D) 
should be B24 * D4, and so on. You have to tell LisaCalc 
that you want the first coordinate in each successive 
formula to remain unchanged, but you want the second 
coordinate to change according to the column the cell is 
in. To do this, 

~ Choose Copy from the Edit menu. 

~ Select the range C5:M5. I. G [ell s: C5 :M5 

~ Choose Paste Adjusting from the Edit menu. 

The dialog box that appears is shown in Figure 17. 

[ell: [5 

Same 

o 0 
Formula: [24*C4 

I I 
Relative 

Figure 17. Dialog Box for Paste Adjusting 

The dialog box shows the formula for cell C5; right now, 
the formula is 

C24*C4 

C4 is correct, but you want C24 to be B24. To fix this, 

~ Click the check box above C24. 

C24 changes to B24, and the dialog box looks like Figure 
18. 

[ell: CS 

Same 
~ I 0 

Formula: 824*C4 
o I 
Relative 

Figure 18. Dialog Box for Paste Adjusting 

[ Cancel 
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You have changed the formula to the one you wanted for 
cell C5, 824 *C4. 8y selecting Same for the first 
coordinate and Relative for the second coordinate, you 
are telling LisaCalc that you want the first coordinate to 
always be 824, and the second coordinate to change in 
each column. 

~ Click OK. OK ~ ) 

Now the dialog box goes away, and the columns change 
to show the correct values for row 5. 

To complete the spreadsheet, fill in the values for 
Supplies the same way. 

~ Select 812 by editing the Cells area. 

~ Choose Copy from the Edit menu. 

~ Select the range I It (j Cells: C12 :M12 
C12:M12. 

~ Choose Paste Adjusting from the Edit menu. 

~ In the dialog box, click in (ell: (12 
the box above C25 so -------------' 
that the formula for C 12 ~ Same 
is B25*C4. '\ I 0 

~ Click OK. 

Formula: 825*C4 
o I 
Relative 

OK ~ J 

When you're through, scroll the spreadsheet back to A 1; 
your screen should look like Figure 19. 



Displaying and 
Printing Formulas 

IIII GCP-Chapter 2 IIIIII 
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Figure 19. Completed Spreadsheet 

Now that you've completed the spreadsheet, it would be 
interesting to see the formulas as well as the values. To 
do this, 

~ Choose Show Formulas 
& Values from the 
Calculate menu. 

Calculate Automatically 
"'Calculate Manually 

Calculate Now 

Your screen should look like Figure 20. 
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II11I I GCP-[haptet 2 I !IIII 
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8 
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Figure 20. Formula Display 

In this display, there is room for only some of the rows, 
because formulas take more space than values. If you 
want to see more cells, you can scroll the spreadsheet. 
You can also widen the columns if you want to. 

You can print the formula display the same way you print 
the value display. It's a good idea to make a printed copy 
of the spreadsheet, especially if it's complicated. A 
pri nted copy has two advantages: 

• You can examine all the formulas at the same time, to 
see if you want to revise any of them . 

• You have a permanent record of the formulas in the 
spreadsheet. 

To print the spreadsheet, 

~ Choose Print from the File/Print menu. 

~ Click OK in the alert 
box. 

( 01( ~ ) 

Next, you will learn how to make your spreadsheet into a 
template. Before going on to this procedure, you should 
file the document that you have just been working with. 
To do this, 

~ Choose Save & Put Away from the File/Print menu. 



Making the 
Spreadsheet 
into a Template 

You could leave the document where it is in the disk 
window, but your disk window would soon become 
cluttered with a lot of document icons. You can create a 
folder to contain all the related documents. 

~ Move the pOinter into 
the empty folder pad 
icon in the ProFile 
window, and click the 
mouse button twice. 

~ Type 

Tutorial

followed by your initials. 

LJ 
.Yfolders 

MM' 

• T'Jtonal-GC~ 

To file the document in your new folder, 

~ Move the pOinter into the document icon. 

To do this, you may have to rearrange the folders on the 
desktop. 

~ Press and hold the 
mouse button while 
moving the document 
icon over the folder icon. 

~ Release the mouse 
button when the folder 
icon flashes. 

Tutona.l-GCP 

~ Move the folder icon to an empty place in the disk 
window. 

~ Move the document that you worked with in Chapter 1 
into your new folder to keep all your examples 
together. 

You can use the same spreadsheet you have just created 
for next year's budget. To do this, you want to keep 
everything that doesn't change from year to year, and 
remove everything else. In this case, you probably want 
to keep all the formulas, labels, and constants. What you 
have when you get done is called a template. 
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First, you have to reopen the spreadsheet. To do this, 

~ Click twice on the Tutorial folder to open it. 

~ Move the pointer to the 
icon that represents the 
Chapter 2 example you 
just saved. 

~ CI ick the mouse button twice. 

Protecting Cells 

I~ 

To create a template, you first protect the cells you want 
to keep, then you clear the other cells. 

When a cell is protected, the following rules apply: 

• If a protected cell has a formula, you can change the 
formula but you can't replace it with a value. The value 
of the cell changes if the cells it depends on change. 

• If a protected cell has a value but no formula, you can't 
change the value. 

• If you try to paste anything on top of a protected cell, 
you are prevented by an alert box that gives you the 
choice of clearing or not clearing. 

• If you try to clear a protected cell, you are prevented by 
the appearance of an alert box that gives you the 
choice of clearing or not clearing. 

• You can cut or copy a protected cell. 
• You can change the format of a protected cell. 

In this spreadsheet, you want to start by protecting every 
cell that has a formula. 

~ Choose Select All of Document from the Edit menu. 

~ Choose Protect 
Formulas Only from the 
Protect menu. 

Now you want to protect the labels and constants: 

~ Select the range A1:M2 I" G Cells: Al:M2 

~ Choose Protect Formulas & Values from the Protect 
menu. 

~ Protect the range A4:A25, using Protect Formulas & 
Values. 



You also need to protect cells 824 and 825. To do this, 

~ Scroll the spreadsheet so that both 824 and 825 are 
showing. 

~ Move the pointer to 824. 1''',f.'.'9.:',;',',~'9.',',','j 

~ Holding down the mouse 
button, move the pointer 
to 825. Notice that both 
cells are highlighted. 

~ Release the mouse button. 

~ Choose Protect Formulas & Values from the Protect 
menu. 

Clearing the Template 

To finish making the spreadsheet into a template, clear 
all the unprotected values: 

~ Choose Select All of Document from the Edit menu. 

~ Choose Clear Entries from the Edit menu. 

Now you see an alert box warning you that only 
unprotected cells will be cleared. Since this is what you 
expected, 

~ Click OK in the alert 
box. 

( 

~ Scroll the spreadsheet back to A 1. 

~ Click in the deselect box 
at the upper left corner 

OK ~ ) 

, G [ells: 

, M Fonnula: of the spreadsheet view, 
so that nothing is 
selected in the 
spreadsheet. 

Deselect bOX ..... -th]-----..... 
lLJ.§~!.~,~.".P.~.P~!..: 

Your screen should look like Figure 21. 
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1IIII1 GCP-Choptet 2 IIII1 

Ii G (ells: Value: Hi:?H 
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Ii M Formula: 

Figure 21. Template after Clear 

Now you can save the template. 

~ Choose Save & Put Away from the File/Print menu. 

~ Change the name of the 
spreadsheet to "Dept 
Budget Paper." I 

Dept Budget Paper 

~ Choose Make Stationery Pad from the File/Print 
menu. 

Now you have made this 
template into a pad of 
stationery. Next year, when 
it's time to prepare your 
department budget, all you 
will have to do is tear off a 
sheet from the pad and fill 
in the missing values. 

II 
Dept BUdget Paper 



Chapter 
Summary 

Scroll spreadsheet 

Use constant 

Copy a cell 
with no changes 

Copy a cell 
with changes 

• Move the pointer to the 
arrow in the scroll bar. 

• Press and hold the 
mouse button until the 
spreadsheet is 
positioned correctly. 

or 

• Ed it the Cells area to 
show the coordinates of 
the cell you want to 
select. 

• Enter the constant value 
in a separate cell. 

• Write formulas to refer to 
the cell instead of to the 
number. 

• Select the cell. 

• Choose Copy from the 
Edit menu. 

• Select the range you 
want to paste the cell to. 

• Choose Paste from the 
Edit menu. 

• Select the cell. 

• Choose Copy from the 
Edit menu. 

• Select the range you 
want to paste the cell to. 

• Choose Paste Adjusting 
from the Edit menu. 

• Change coordinates as 
necessary in the dialog 
box. 

• Click OK in the dialog 
box. 
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Display formulas 

Print formulas 

Protect formulas 

Protect values 

Clear unprotected cells 

Make a template 
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• Choose Show Formulas & 
Values from the Calculate 
menu. 

• Choose Show Formulas & 
Values from the Calculate 
menu. 

• Choose Print from the 
File/Print menu. 

• Select the range of cells 
whose formulas are to be 
protected. 

• Choose Protect Formulas 
Only from the Protect 
menu. 

• Select the range of cells 
whose formulas are to be 
protected. 

• Choose Protect Formulas 
and Values from the 
Protect menu. 

• Select the range of cells 
to be cleared. 

• Choose Clear Entries 
from the Edit menu. 

• Protect cells that are to 
be in the template. 

• Clear unprotected cells. 

• Save and put away the 
spreadsheet. 

• Choose Make Stationery 
Pad from the File/Print 
menu. 



Chapter 3 
Revising a Spreadsheet 



Revising a Spreadsheet 

In this chapter, you will learn some more advanced 
options for changing the appearance and contents of 
an existing spreadsheet. The features covered include 
how to 

• Select the right format for a cell. 
• Center or justify the contents of a cell. 
• Create repeating patterns. 
• Change the column widths of several columns at the 

same time. 
• See two different parts of the spreadsheet at the same 

time. 

• Move columns. 
• Copy a whole column using Paste Adjusting. 

Chapter 3 ::: 853 
Revising a Spreadsheet ••• 



A Forecast versus 
Actuals Example 

• • • LisaCalc Tutorial 
8541 : : : Section 8 

To get the example for this chapter, 

~ Open the ProFile 
window. 

~ Open the LisaCalc 
Examples folder. 

~ Tear off a spreadsheet 
from the Chapter 3 
stationery pad. 

~ Type 

Ch3: 

followed by your initials 
to name the 
spreadsheet. 

~ Open the spreadsheet. 

.. ~ 
I 
~ ...,. 

Chapter :3 

I 
Ch3:GC~ 

Your screen should look like Figure 22. 

Figure 22. Opening Screen for Chapter 3 



This example shows a comparison between revenue 
forecast and actual revenue for 1985 for a mythical 
company named Sue's Sporting Goods. Take a minute to 
look over the spreadsheet. 

The FORECAST section in rows 5 to 19 shows the 
forecasted revenue for 1985. The forecast is broken 
down by product and month. For each product, the 
forecast shows the number of units that Sue expects to 
sell, the price per unit, and the total revenue. In addition, 
subtotals are shown for each quarter, as in column F. The 
subtotal for the fourth quarter is missing; you will add it 
later in the chapter. 

The ACTUALS section in rows 21 to 29 shows the actual 
revenue for each month. To see this part of the 
spreadsheet, 

~ Scroll the spreadsheet so that rows 21 through 29 are 
showing. 

Rows 21 through 29 are shown in Figure 23. 

21 
22 
23 
24 
25 
26 
27 
28 
29 
30 

Figure 23. ACTUALS Section of Spreadsheet 

For each product, the ACTUALS section shows the 
monthly revenue and the variance. The variance is the 
percentage by which the forecast revenue deviates from 
the actual revenue; it is positive when the actual exceeds 
the forecast, and negative when the actual falls short of 
the forecast. 

~ Use the elevator to scroll 
the spreadsheet back so 
that A 1 is showing. 

There is nothing actually incorrect about this 
spreadsheet; all the formulas and values are as they 
should be. However, for a variety of reasons, it is very 
hard to read. Your main task in this chapter will be to fix 
the spreadsheet so that it is easier to use. 

Chapter 3 
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One of the reasons this spreadsheet is hard to read is 
that all the numbers look the same. Although the values 
include whole numbers like Units, money amounts like 
Revenue, and percentages like Variance, they are all in 
the same format. By using the various number styles 
available on the Format menu, you can give these values 
a more appropriate and attractive appearance. The 
Format menu is shown in Figure 24. 

Words left/Nos. Right 
Left Flush .L 
(enter .K 
Right Flush .R 
Fill Pattern 

Floating Decimal 
No Decimal 
Fixed Decimal ... 
Scientific ... 
$1~234. 56 
1,234.56 

$ 1234.56 
1234.56 

$1~235 
1~235 

$ 1235 
1235 

Figure 24. Format Menu 

All the cells in this spreadsheet have the same number 
style: floating decimal, which is the number style 
provided by LisaCalc when you have not specified one. In 
floating decimal, numbers are shown as compactly as 
possible. Digits that are not needed are omitted. For 
example, in cell C14, a value which is meant to be $3.80 
is shown as 3.8. The final zero is omitted because it is not 
needed. 

Also, in floating decimal, the decimal points in different 
cells do not necessarily line up; they can appear 
anywhere within the cell. For these reasons, it is not the 
most appropriate number style for money amounts; for 
these, you want a monetary number style. 



Monetary Number Styles 

Monetary number styles display money amounts either 
with or without the following elements: 

• Dollar sign ($) 

• Commas (,) 
• Cents (.29, .00, and so forth) 

As you can see from Figure 24, you decide on a monetary 
number style by looking in the Format menu for the item 
that looks the way you want your values to look. The 
monetary number styles on the menu show how the value 
$1,234.56 would look in various number styles. For 
example, if you wanted a dollar sign and commas, but no 
cents, you would choose $1,235. The number style is 
shown as $1,235 instead of $1,234 because, with this 
number style, the value $1,234.56 is shown rounded to 
$1,235. The actual value of the cell does not change, only 
the way the value is displayed. 

The rows in this spreadsheet that contain monetary 
values are the rows for Price, Revenue, and Totals. There 
are four Price rows, one for each product. Notice that in 
three of these rows, the value is a whole number of 
dollars. In row 14, however, the price is $3.80, which is 
shown as 3.8. Therefore, you need a number style that 
shows cents. An appropriate number style for these rows 
would be $ 1234.56. 

~ Select row 8 by clicking 
in the row header. 

~ Choose $ 1234.56 from the Format menu. 

~ Do the same for rows 11, 14, and 17. 

When you change a number style, only the appearance of 
the numbers changes; the labels (such as the word Price 
in 88) do not change. Labels are not affected by number 
styles. 

In monetary number styles, negative values are enclosed 
in parentheses. You can't see this on this spreadsheet, 
since all the values in the FORECAST section are 
positive. However, when a value is positive, one space is 
added to the right of the value so that it will line up 
properly with the negative values. 
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For the Revenue rows, the number style you used for the 
Price rows is not appropriate. To see why, 
~ Select row 9. . .................................... .. 

§.~.~.~.~.~;:.~ ....... . 

~ Choose $ 1234.56 from the Format menu. 

As you can see, the cells in row 9 now show asterisks (*). 
This is what LisaCalc displays whenever a value is too 
large to fit in the cell display. Because these cells contain 
large values, you want to leave out unnecessary features 
like the dollar sign and the cents. The best number style 
is 1235. 

~ Choose 1235 from the 
Format menu. 

Floating Decimal 
No Decimal 
Fixed Decimal ... 
Scientific ... 
$1,234. S6 
1,234.56 

$ 1234.S6 
1234.56 

$1,235 
1,235 

$ 1235 

1235 J, , 

~ Do the same for rows 12, 15, 18, and 19. 

F9 and F19 still show asterisks, indicating that the value 
is too large to display; you'll see how to fix this later in the 
chapter. 

The rows for Units can be left as they are, since they 
contain ordinary numbers, not money amounts. 

Now your screen should look like Figure 25. 



Figure 25. After Monetary Number Styles 

Fixed Decimal Number Style 

The only other rows that need a different number style 
are the rows for Variance. 

~ Scroll the spreadsheet so that rows 21 through 29 are 
showing. 

The Variance rows show the percentage by which the 
actual revenue differs from the forecasted revenue. The 
value can be either positive or negative. However, you 
really don't need as many decimal places as are shown 
now. In fact, the extra decimal places make the numbers 
hard to read. What you need is a number style that 
specifies a fixed number of decimal places. This is fixed 
decimal number style. 

To convert the rows to fixed decimal number style: 

~ Select row 23. 

~ Choose Fixed Decimal from the Format menu. 

When you choose this number style, a dialog box comes 
up, as shown in Figure 26. 
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[ Cancel 
Fixed Decimal Point--Number of Places: • 

OJ( 

Figure 26. Dialog Box for Fixed Decimal 

The dialog box asks you how many decimal places you 
want; the value 2 is already filled in. Since this sounds 
about right, 

~ Click OK. OK ~ ) 

~ Set the same number style for rows 25, 27, and 29. 

Your screen should look like Figure 27. 

Figure 27. Decimal Number Style 

In spite of the number style changes, this spreadsheet is 
still difficult to read. The main reason for this is that the 
numbers are crowded together. In addition, some of the 
values, such as the one in F19, are too large to be 
displayed. The answer to both these problems is to widen 
the columns. 



In Chapter 1, you learned a quick way to widen a single 
column. Now you are going to learn how to widen several 
columns at the same time. In this spreadsheet, you want 
to widen columns B through Q; column A is already the 
correct width. 

~ Select the "29" in the 
Cells area. 

~ Type 

B:Q (Enter) 

I • (j (ells: II 

I • (j (ells: B:O 

You have just selected columns B through Q. 

~ Choose Column Widths 
from the Page Layout 
menu. 

Now you see a dialog box, as shown in Figure 28. It tells 
you that the current column width of the first you 
selected is 8 characters. The 8 is already selected, so you 
can change it by just typing the new number. All the 
selected columns will have the same width. 

Column klidth--Number of Characters: II 

Figure 28. Dialog Box for Column Widths 

~ Type 

9 

~ Click OK. 

Characters: 91 

~ Click in the deselect box so that nothing in the 
spreadsheet is selected. 

Your screen should look like Figure 29. 
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The next step in making this spreadsheet more orderly is 
to change the way some of the values are lined up within 
the cells. 

--------------------------------------------------------------------~.~~~ Lining Up Values 
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Take another look at the Format menu in Figure 24. The 
first group of menu items all have to do with the way 
values are lined up within cells. These items are called 
alignment options. Values can be left flush, right flush, or 
centered. You can also choose to have a value repeat as 
a fill pattern. If you don't choose any of these options, 
then the way the values are lined up depends on what 
kind of values they are: numbers are right flush, and 
everything else is left flush. 

In this spreadsheet, the month names (row 5) would look 
better if they were centered. 

~ Scroll the spreadsheet so that A 1 is showing. 

~ Select row 5. 5 + : FI]~fC FIST 

~ Choose Center from the Format menu. 

Also, if the names of the products in column A were right 
flush, they would stand out more effectively. 



~ Select the range A7:A 16 
by moving the pointer to 
A7, holding down the 
mouse button, moving 
the pointer to A 16, and 
releasing the mouse 
button. 

• G Cells: A7:A16 

~ Choose Right Flush from the Format menu. 

~ Make cells A22:A28 
right flush also. 

I • G Cells: A22:A28 

~ Scroll the spreadsheet back so that A 1 is showing. 

The biggest help in improving the clarity of this 
spreadsheet would be to draw lines to separate various 
sections. For example, it would be nice to have a row of 
periods between rows 9 and 10 to separate the 
information about Jogging Togs from the information 
about Sneakers. 

To do this, you start by inserting a row between rows 9 
and 10: 

~ Select the grid handle 
between rows 9 and 10. ~i::::::::::::::::::::::::::::::::: 

~ Choose Insert Blank Row from the Edit menu. 

Now you want to fill the row with periods: 

~ Select B10. 

~ Type a period followed 
by CEnter). ~ 

~ Choose Fill Pattern from the Format menu. 

~ Choose Copy from the Edit menu. 

~ Select C10:Q10. I • G (ells: C10 :010 

~ Choose Paste from the Edit menu. 

To create a row of periods between Sneakers and Ace 
Bandages, 

~ Select row 10. 

~ Choose Copy from the Edit menu. 
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~ Select the row handle between rows 13 and 14. 

~ Choose Paste from the Edit menu. 

To create a row of periods between Ace Bandages and 
Crutches, 

~ Select the grid handle between rows 17 and 18. 

~ Choose Paste from the Edit menu. 

~ Scroll the spreadsheet so that A 1 is showing again. 

When you finish, your spreadsheet should look like 
Figure 30. 

" G [ells: 818 :(J18 

Figure 30. Fill Patterns 

You also might want to draw a line of equals signs just 
above the Totals line, to indicate that the line is a sum. 

~ Insert a blank row 
between rows 21 and 22. 

~ Type an equals sign in 
B22, followed by (Enter). 

~" .. """.""""."." .... ".""." .. 

22 Totals ... , ................ ,. ........... , ........ . 

~ 
~ Choose Fill Pattern from the Format menu. 

~ Copy B22 to C22:Q22. 

~ Scroll the spreadsheet back to A 1. 



Split Views In adding the extra rows to the spreadsheet, you have 
also made it somewhat larger. One of the results of this is 
that you cannot see the actuals for each month. You 
could scroll the spreadsheet so that they are showing, 
but then you would not be able to see the month names 
in row 5. What you would really like is to be able to see 
two different parts of the spreadsheet at the same time. 

Suppose you want to see the forecast and actuals for 
Jogging Togs at the same time. Here's how you do this: 

~ ~~~:~~;~~r~~J~:!;. 6J. ______ ~~ ____ "_"_L" 

~ To split the spreadsheet 
view, move the pOinter 
to the spl it control at the 
top of the vertical scroll 
bar. Hold down the 
mouse button while 
moving the spl it control 
down until it is between 
rows 18 and 19. Release 
the mouse button. 

Split control 

Now your screen should look like Figure 31. 
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" G Cells: e22 :022 Value: 

Figure 31. Split Views 

When you have split views, each view has its own scroll 
bar. In this case, each split view has a vertical scroll bar. 
These two scroll bars operate independently. Only one 
horizontal scroll bar is necessary, since neither view can 
be moved to the left or right without the other one 
moving in exactly the same way. 

Now what you need to do is scroll the bottom view to 
show the actuals for as many products as possible. 

~ Move the pointer to the rl~1i1 
downward-pointing··:·· H

•

H 

.... 

scroll arrow in the lower [j ~ 
view. Hold down the 
button until rows 26 
through 31 are showing, 
then release the button. 

Now you can see the forecast and the actuals for each 
month for the first three products. 



To unsplit the screen, 

~ Move the pOinter to the 
new split control in the 
middle of the 
spreadsheet. While 
holding down the mouse 
button, move the split 
control all the way to the 
bottom of the screen. 

Now the screen is restored to a single view. 

~ Using the elevator button, scroll the spreadsheet so 
that row 1 is showing again. 

Copying a Column As mentioned earlier, the quarterly totals for the fourth 
quarter of 1985 are missing from this spreadsheet. The 
easiest way to add them to the spreadsheet is to copy 
the formulas from another column of quarterly totals. 

In Chapter 2, you learned how to copy a column by 
copying one cell at a time. Now you will see how a whole 
column can be copied in one operation. What you want 
to do is copy column N, which shows the third quarter 
totals, to column R, using Paste Adjusting. 

~ First, use the view 
button to scroll the 
spreadsheet so that 
columns Nand Rare 
both showing. 

~ Select column N by 
clicking in the column 
header. 

View button 

~ Choose Copy from the Edit menu. 

~ Select column R. 

~ Choose Paste Adjusting from the Edit menu. 

As always, a dialog box appears to let you decide which 
coordinates are relative and which stay the same. It is 
shown in Figure 32. 
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Cell: R7 

Same 
o 

Formula: sum(07:Q7) 
I 

Relative 

Figure 32. Dialog Box for Paste Adjusting (Columns) 

Since each cell in column N needs to be examined and 
adjusted separately, LisaCalc goes down column None 
cell at a time. For each cell that contains a formula, 
LisaCalc lets you adjust the coordinates to be the way 
you want them. 

The first formula you see is the one that is going to be 
pasted to R7. Notice that R7 is shown next to the word 
Cell in the upper left-hand corner of the dialog box. 
When the formula is the way you want it, you click the 
Next button to go on to the next cell in the column. If you 
click OK, you are saying that all the formulas in the 
column are now correct. If you click Cancel, you are 
cancelling the whole paste operation. 

Since the formula for R7 is correct as shown, 

~ Click the Next button. -il'I 
Now you see the formula for R9. The new dialog box is 
shown in Figure 33. 

Cell: R9 

Same 
o 

Formula: sl.III(09:09) 
I 

Relative 

Figure 33. Dialog Box for R9 

Notice that something new has been added to the dialog 
box: a button labeled Previous. This button allows you to 
go back to the previous cell, in case you realize that the 
formula in that cell is not correct. As before, Next goes 
on to the next cell, and OK approves the whole column. 



To see how this works, 

~ Click the Previous 
button. 

Now you see cell R7 again. 

~ Click the Next button. 

Now you see R9 again. 

Cell: R7 

Same 
o 

Formula: sum(07 :(7) 

I 
Relative 

+,,'1 
Cell: R9 

Same 
o 

Formula: sum(09 :(9) 
I 

Relative 

You may have noticed that when you filled in the Paste 
Adjusting dialog box for R7, you left all the coordinates 
relative. This makes sense, since the position of the cells 
referred to in the formula is the same for this column as it 
was for column N. If you reflect for a minute on the 
position of column R as compared to column N, you will 
see that all the formulas in column R have the same 
property; that is, that all their coordinates are relative. 
Once you have determined that this is the case, you don't 
need to fill in a dialog box for each cell; you just click OK. 

~ Click OK. 

~ Change R4 to: 

4th Quarter 

OK ~ ) 

Illidd' 

Your screen should look like Figure 34. 
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El 
"G [ells: R4 Value (Text): 4th Qusrter 

"M formula: 
N 0 p o R s T u 

Figure 34. After Paste Adjusting 

Now that you have the values for each month and the 
quarterly totals, you might as well include a column of 
yearly totals. To do this, 

~ In 84, enter the label: [85 Tote.ll 

85 Total 

~ In 87, enter the formula I • M Formula: Sum(F7,. J7,. t~7,. R7)1 

Sum(F7,J7,N7,R7) (Enter) 

~ Choose Copy from the Edit menu. 

~ 8elect 88:833. I . ,..."'\ S-:Z; ... • G (ells: ~b: oJ) 

~ Choose Paste Adjusting from the Edit menu. 

~ In the dialog box, click OK ~ ) 
OK. 

~ Clear 88,812,816,820,824, and 825. 

~ Copy R10 to cells 810, [!QJSF. .. ; ...... ;.: .. ; ...... ; ..... : ..... ; ...... ; .. j 
814, and 818. 

~ Copy R22 to 822. 
r:v;--r::rc .......................... .. 
lR...nL.:.:.:.:.:.:.:l 



~ Widen column S to 9 characters. 

~ Scroll the spreadsheet so that L 1 is in the upper left 
corner. 

When you get through, your screen should look like 
Figure 35. 

Figure 35. After Creating New Column 

Now that you've created the column of totals, you might 
decide that it's not in a very good place. Right now, the 
column is all the way to the right of the spreadsheet. 
Suppose you wanted it to the left instead? For example, 
you might want to put it between columns Band C. 

You move a column the same way you move anything 
else in LisaCalc: by first cutting it from its old location, 
and then pasting it to its new location. To move column S 
so that it's between columns Band C, 

~ Select column S. 

~ Choose Cut from the Edit menu. 
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This would be an appropriate time to talk about cutting. 
It's usually a good idea to paste something as soon as 
possible after cutting it. After the cut, you can scroll the 
spreadsheet as necessary, and select the cells you need 
to select, but you shouldn't stop to do any editing 
operations, such as entering a value in a cell. The main 
reason for this is that each time you choose Cut or Copy 
from the Edit menu, the current contents of the 
Clipboard disappear. Although you can bring them back 
again with Undo Last Change, you shouldn't depend on 
this feature to rescue you. 

In the case of columns and rows, there are additional 
reasons for dOing the paste as soon as possible after the 
cut. When you cut a column, the columns to the right of 
the column you cut are renamed and moved over to close 
the gap. Any formulas that have references to these 
columns are adjusted appropriately. However, formulas 
that reference the deleted column cannot be adjusted 
since the column is on the Clipboard. As long as this is 
true, these cells have the value Error. When you paste the 
column back to the spreadsheet, the formulas are 
adjusted correctly. 

However, if you insert any blank columns or rows while 
the column is still on the Clipboard, the formulas might 
not be adjusted correctly when you paste the column 
again. The same problem exists when you edit formulas 
that reference the column you have cut. To avoid any 
complications, don't try to perform any editing 
operations between the cut and the paste. 

To finish moving the column, 

~ Scroll the spreadsheet so that column A is showing. 

~ Select the grid handle B :IE c 
between columns 8 
and C. 

~ Choose Paste from the Edit menu. 

Your screen should look like Figure 36. 



Figure 36. After Moving Column 

This concludes Chapter 3. You can now print the 
spreadsheet, if you want to, or just save it using the same 
procedure as in the other chapters. 

Chapter 3 
Revising a Spreadsheet · - -1

873 --. . --



Chapter 
Summary 

• • • LisaCalc Tutorial 
B741::: Section B 

Left justify values 

Right justify values 

Center values 

Repeat values in cell 

Split view horizontally 

Split view vertically 

Unsplit view 

Insert column or row 

Move column or row 

• Select the cells. 

• Choose Left Flush from 
the Format menu. 

• Select the cells. 

• Choose Right Flush from 
the Format menu. 

• Select the cells. 

• Choose Center from the 
Format menu. 

• Select the cells. 

• Choose Fill Pattern from 
the Format menu. 

• Move the horizontal split 
icon to a row grid handle 
and release. 

• Move the vertical split 
icon to a column grid 
hand Ie and release. 

• Move the new split 
control off the screen. 

• Select the grid handle 
where the column or row 
is to be inserted. 

• Choose Insert Blank Row 
or Insert Blank Column 
from the Edit menu. 

• Select the column or row. 

• Choose Cut from the Ed it 
menu. 

• Select the grid handle 
where you want the 
column or row to go. 

• Choose Paste from the 
Edit menu. 



Copy column or row 

Change column width 
of several columns 

• Select the column or row 
to be copied. 

• Choose Copy from the 
Edit menu. 

• Select the header or grid 
handle where the column 
or row is to be copied. 

• Choose Paste or Paste 
Adjusting from the Edit 
menu. 

• Select the columns. 

• Choose Column Widths 
from the Page Layout 
menu. 

• Type in the column width 
you want. 

• Click OK. 
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More about Formulas 

In previous chapters, you have used mostly very simple 
formulas. In this chapter, you have a chance to explore 
the different kinds of formulas that you can use with 
LisaCalc. The features covered in this chapter include 
how to 

• Put together the right mathematical formula. 
• Use the Npv function to compute net present value. 
• Use dates in formulas and values. 
• Use the Lookup function to read from tables. 
• Use the If function to choose between alternatives. 
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The sample spreadsheet for this chapter contains four 
different examples; each example shows different kinds 
of formulas. 

To get the spreadsheet, 

~ Open the ProFile 
window. 

~ Open the LisaCalc 
Examples folder. 

~ Tear off a spreadsheet 
from the stationery pad 
named Chapter 4. 

~ Type a name for the 
spreadsheet. 

I 
~ ...,. 

Ch.3pter 4 

I 
.3.C03.:ch4 

~ Open the spreadsheet. Your screen should look like 
Figure 37. 

j...::.:...!G::....:(:!:.el:.::ls!...: ___ .J.!.v.::.:.al::.::ue!...: ____________ --{\\j\\i\ 
• M Formula: i\ii\~! 

B c o 

,"0 

Figure 37. Formula Examples 



Using Financial 
Functions 

The example for financial functions is in the upper left 
corner of the spreadsheet; it covers the range A 1: E 11. 
This example shows the calculations you might do to 
evaluate the prospective purchase of two new pieces of 
equipment for your business. All the values have been 
filled in; you have to enter the formulas. The cells in the 
spreadsheet have already been formatted appropriately. 

Columns 8 through E of the spreadsheet represent the 
successive years during the lifetime of the equipment. 
T=O is the present, T= 1 is next year, and so forth. 

The purchase price of the first piece of equipment is 
$7,000 (cell 83); of the second, $3,000 (cell 84). Since 
these amounts are negative numbers, LisaCalc displays 
them surrounded by parentheses. When a cell has a 
monetary number style, negative numbers are shown 
surrounded by parentheses. 

Row 5 shows the investment tax credit. This is a one
time credit, taken this year. Therefore, you want this 
amount to be in 85. The investment tax credit is 10% of 
the total price of the equipment. 

~ Enter the following 
formula in 85: 

-.1 *(B3+ B4) 

The result in 85 is 1000. 

• G (ells: 85 
• M Formula: -.11j1(83+84) 

The .1 is the same as 10%. The minus sign is necessary 
because the values in 83 and 84 are negative, and you 
want the value in 85 to be positive. 

Why are the parentheses necessary in this formula? That 
is, why couldn't you just write -.1 * 83 + 84. 

To answer this question, we have to go a little more 
deeply into the way formulas are calculated. 

Order 01 Calculation in Formulas 

There are two kinds of components in a LisaCalc 
formula: operators and operands. Operators indicate the 
kind of operations to be performed, such as addition, 
multiplication, and so forth, and operands indicate the 
objects these operations are to be performed on, such 
as cell coordinates and numbers. In this formula, the 
operators are * and +, and the operands are -.1, 83, 
and 84. 
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If a formula contains more than one operator, LisaCalc 
has to decide which operation to perform first before it 
can calculate the value of the formula. If the formula is 

-.1*83+84 

then there are two choices: it could perform the 
multiplication first, or the addition first. The rule LisaCalc 
applies is the following: 

Rule 1: Exponentiation ( ~ ) is performed first; then 
multiplication (*) and diviSion (I); then addition (+) and 
subtraction (-). 

Applying Rule 1 in this case means that the multiplication 
is the first operation to be performed. However, this is 
not what you want. What would happen is that you would 
add 84 to -10% of 83. 8y using parentheses, you avoid 
this problem. This brings us to the next rule: 

Rule 2: Anything inside parentheses is calculated first. 

Therefore, if your formula is 

-.1 *(83+ 84) 

the addition is performed first, followed by the 
multiplication. This is just what you want. 

There is another rule you should be aware of, although it 
does not apply to this formula: 

Rule 3: If a formula contains more than one operator of 
the same type, the operations are performed from left to 
right. 

"Of the same type" is interpreted according to this list: 

Type 1: Exponentiation ( ~ ) 
Type 2: Multiplication (*) and division (I) 
Type 3: Addition (+) and subtraction (-) 

For example, in the following formula: 

026/A27*825 

the division is performed before the multiplication. This 
means that the formula is equivalent to 

(026/ A27)* 825 

and not 

026/(A27 * 825) 



If you're ever unsure how a formula will be evaluated, you 
can always use parentheses to control the order of 
evaluation. 

Net Present Value 

Now you can continue filling in the spreadsheet. Row 6 is 
the annual depreciation. Since you have decided that the 
equipment has a useful life of three years, you want it to 
depreciate one-third each year, assuming straight-line 
depreciation. Assuming your company is in the 50% tax 
bracket, you want to credit half the amount of the 
depreciation as a tax savings. Therefore in each of the 
cells C6, 06, and E6, you want the formula: 

-(1/3)* .5*(83+ 84) 

The minus sign is necessary so that the values in C6, 06, 
and E6 will be positive. To fill in this row, 

~ In C6, enter the formula " G [ells: C6 
~~~~~----~-----

- (1/3)*.5*(B3+ B4) 

~ Copy the formula into 
cells 06 and E6. 

" M Formula: -( 1/3) * . 5* (63+64) 

• G (ells: D6 :E6 

• M Formula: 

8ecause the formula is the same in each cell, you can use 
Paste instead of Paste Adjusting. 

The next row, Other Savings, shows the amounts you 
estimate the new equipment will save your business. 
These amounts are constants. 

The annual cash flow (row 9) in each column is the sum of 
the amounts in rows 3 through 7. You can use the Sum 
function to add these amounts. 

~ In 89, enter the formula 

Sum(B3:B7) 

" G [ells: B9 
"M Formula: sum(B3:B7) 

~ Copy this formula to C9 through E9 using Paste 
Adjusting. 

In the dialog box that appears, notice that the formula 
shown for C9 is correct. 

~ Click OK. 
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Now you are ready to enter the formula for net present 
value. The NPV function calculates the net value, at the 
present time, of a cash flow at a specified discount rate. 
The cash flow is a series of amounts, one for each time 
period, that is shown in the spreadsheet as a range of 
cells. In this example, the cash flows at the end of each 
year are in cells 89 through E9. The discount rate (11%) 
is in cell 812. To enter the formula, 

~ Select the Formula area 
of 811 and enter the 
formula 

Npv(B12,B9:E9) 

" G [ells: Bll 
" M Formula: Npv(B12, 89:E9)1 

The first argument to the function is the discount rate, 
and the second is the range of cells containing the cash 
flow. 

Now you see the net present value in 811, $1282. Your 
spreadsheet should look like Figure 38. You might try 
changing the discount rate in 812 to see how it changes 
the value in 811. 

~::"':~=-[::'::F:':':';~~:':"':u':::':~~:":"':-np-V(-Bl-2,....JB9.:...:~;:.:.:!~:..:...e..:..:(N.:.::u~mb::.::e;....,t.r):.:....: --=12.:..:81..:...:.6..::...;84..:...:73.=.::20...:.:45~24:.:..:66:..:...2 _____ -i!:III!.li 

A B H ,{r 

Figure 38. End of NPV Example 



Dates So far in this tutorial, you have used two kinds of values: 
numbers and labels. You can also use a third kind: dates. 
As with numbers and labels, you don't have to tell 
LisaCalc when you're using a date, you just enter it in the 
proper format and LisaCalc knows how to interpret it. 

For example, look at cell D 17. It shows the value 

1/19/84 

This is the date January 19, 1984. Similarly, D18 is 
February 12, 1984, and so on. 

In addition to dates, a value can also be a date part, 
which is a specified number of days, months, or years. 
For example, cell E 17 contains the value 

72 days 

The date example starts in cell A 14; it is shown in 
Figure 39 . 

• G (ells: Value: 

• M Formula: 

Figure 39. Date Example 
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Using Dates 

In this example, you are completing a chart that shows 
the status of several projects. When this chart was set 
up, the information included for each project was the 
starting date, in the Start column, and the estimated 
number of days to complete the project, in the Est Time 
column. This chart makes no distinction between 
Saturdays and Sundays and normal working days. As 
time went by, and it became possible to provide more 
accurate completion dates for the project, these were 
entered in the Real End column. Given this information, 
you have to fill in the formulas in the remaining columns. 

The first thing you need to calculate is the estimated 
completion date, in column F. This value is based on the 
starting date, in column D, and the estimated number of 
days to complete, column E. To calculate the estimated 
completion date, you add the estimated number of days 
to the starting date. To do this, 

~ Select F17. 

~ Enter the formula 
" G Cells: F17 

D17+E17 " M Formula: D17+E17 

This formula shows you that you can add a date part to a 
date; the result is a date. 

To copy this formula to F18:F21, 

~ Choose Copy from the Edit menu. 

~ Select F18:F21 by moving the pointer to F18, holding 
down the mouse button, moving the pOinter to F21 
and releasing the mouse button. 

~ Choose Paste Adjusting from the Edit menu. 

~ In the dialog box, verify that the sample formula is 
correct; then click OK. 

The column is shown in Figure 40. 



Figure 40. Est End Column 

The next thing you want to calculate is the slack 
remaining on the project. This is the number of days 
between the real completion date and the estimated 
completion date. Positive slack means the project is 
ahead of schedule; negative slack means the project is 
behind schedule. To calculate the slack, you subtract the 
real completion date from the estimated completion 
date: 

~ Select H17. 

~ Enter the formula " G (ells: H17 

F17-G17 " M Formula: F17-G17 

When you subtract one date from another, the result is a 
number of days. In this case, the number is positive, 
because the project is ahead of schedule. 

~ Copy this formula to cells H18 through H21, using 
Paste Adjusting. 

The column is shown in Figure 41. 

Figure 41. Slack Column 

Notice that the values in H18 and H19 are negative 
numbers. This is because in these rows, the real end date 
comes after the estimated end date. A project is 
considered critical if this is the case. Therefore you want 
the word Yes to appear in the Critical column (column B) 
for these projects. The way to do this is with the If 
function. 
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The II Function 

The If function lets you set a cell to a particular value if a 
specified condition is true, and to a different value if the 
condition is false. 

The If function has the following form: 

If (condition, value 1, value 2) 

The condition is actually a statement that can be true or 
false. When the If function is calculated, the condition is 
tested to see whether it is true or false. If the condition is 
true, then the value of the If function is value 1. If the 
condition is false, the value of the If function is value 2. 

In this case, you want to test whether the estimated 
ending date comes before the real ending date. If it does, 
you want to display Yes in the Critical column. If it 
doesn't, you don't want to display anything in this 
column. To do this, 

~ Select 817. 

~ Enter the following • G [ells: 817 
~--------------~------formula: • M Formula: if(F17 < G17, "Yes"," ") 

If(F17 < G17,"Yes"," ") 

This formula needs some explanation. The expression 
F17 < G17 means "F17 is less than G17"; < is the "less 
than" symbol. So the condition to be tested by this 
function is whether F17 is less than G17. If it is, then the 
value of the function is "Yes"; if it is not, then the value of 
the function is" ". Putting a blank space between two 
quotation marks is how you display a blank in a cell. 

To enter the rest of the formulas in this column, 

~ Copy the formula to cells 818 through 821, using 
Paste Adjusting. 

Your screen should look like Figure 42. Notice that 818 
and 819 show "Yes," indicating that these projects are 
behind schedule. 



Using Tables 

Figure 42. End of Date Example 

The next example on this spreadsheet starts with cell 11. 

~ Scroll the spreadsheet so that 11 is in the upper left
hand corner. 

The example is shown in Figure 43. 

EJ 
• G (ells: IValue: I • M Formula: 

? I J K L M N 0 P 0 
1 I LOOKUP f=-

2 TABLES .Q 
3 12ip Code [State Tax Pate Sales Sales TI Zip/State 
4 
5 ;5: ( oooe 0 
6 '9, 1 ~o( IY 
7 IS: 2' .04 >2( 
8 iOI 
9 2 JO ;O( 
10 6' I§ 'or 
11 

:1············································· 

IT ( ~ooo 
12 I 
13 "I. .v. 
14 10 ( 

15 2Q'i .0' 
16 .0: 1 .04~ 
17 !l .0: le 
18 Il( 8; 
19 O~ J' 
20 It] 

21 If) 
I<~ [] [iII I2llblP", 

Figure 43. Tables Example 
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In this example, you are head of sales for the western 
region. You have to calculate the total sales tax your 
company has collected this year for this region. You have 
been given a spreadsheet which lists the total sales for 
each zip code in your region. 

To help you calculate the total sales tax, the spreadsheet 
also contains two tables. The first, in columns Nand 0, 
shows the sales tax rate for each state. The states are 
listed by their two-letter postal abbreviations. 

The second table, in columns P and Q, shows what state 
each zip code is in. The values in column P are the lowest 
zip code for each state. For example, 80000 is lowest zip 
code for Colorado, and 82000 is the lowest zip code for 
Wyoming. This means the zip codes for Colorado run 
from 80000 to 81999. 

The value 100000 in P17 is included to mark the end of 
the table. If it were not there, any value greater than 
99500 but less than 100000 would not be found. 

To complete this example, you need to fill in formulas in 
columns J, K, and M. 

In column J, you want the names of the states 
corresponding to the zip codes in column I. For example, 
in J5 you want the name of the state containing the zip 
code in 15; this zip code is 85398. To find this state name, 
you run down column P until you find the last value 
before 85398. When you find the value 85000 in P9, you 
check the corresponding cell in column Q. The value in 
Q9 is AZ; this is the value you want in J5. 

If you wanted, you could fill in all the state names 
individually by looking them up in the table, but it's much 
easier to use the Lookup function. 

The Lookup function has the following form: 

Lookup (value, range 1, range 2) 

The value is the value you want to look up in the table. 
Range 1 is the range where you look up the value, and 
range 2 is the range that contains the answers you're 
looking for. 

To see how this works, 

~ Select J5. 



~ Enter the following 
formula: 

" G Cells: .JS 
" M Formula: lookup( Is1 Ps :Pl7., CIS :017) 

Lookup (I5,P5:P17,Q5:Q17) 

This formula says that you want to take the value in 15 
and look it up in the range P5 through P17. Then you 
want to find the corresponding value in the range Q5 
through Q17. This value is the value of the formula. In 
fact, you can see that J5 now shows AZ (Arizona), which 
is the state that zip code 85398 is in. 

Now you can copy the formula into the rest of the 
column. 

~ Choose Copy from the Edit menu. 

~ Select the range J6:J19. I" G [ells: J6:J19 

~ Choose Paste Adjusting from the Edit menu. The 
dialog box is shown in Figure 44. 

Cell: J6 

Same 
o 0 0 

Formula: lookup(I6, P6 :P1S, 06 :(18) 

I I I 
Relative 

Figure 44. Dialog Box for Paste Adjusting 

To adjust the formula, remember that the table in 
columns P and Q stays in the same place, no matter what 
value you're looking up. The coordinates for these two 
ranges should be identified as Same, not Relative. 

~ Check the boxes above P6:P18 and Q6:Q18. 

The dialog box now looks like Figure 45. 

Cell: J6 

Same 
o I I 

Formula: lookup(I6, P5 :P17, 05 :(17) 

I 0 0 
Relative 

Figure 45. Dialog Box for Paste Adjusting 
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~ Click OK. ( OK ~ ) 

The State column is shown in Figure 46. 

Figure 46. State Column 

In column K, you want the tax rates corresponding to the 
states in column J. For example, in K5 you want the tax 
rate for the state in J5, which is Arizona. These values 
come from the table in columns Nand O. You can use 
Lookup in just the same way. 

~ Select K5. 

~ Enter the formula 

Lookup(J5,N5:N18) M Formula: lookup( J5,. N5 :N18) 

~ Copy this formula to r. G [ells: K6 :1<.19 J 
cells K6:K19. Adjust the L . 
coordinates as in the 
previous formula. 

In this case, the third argument to the Lookup function 
has been omitted. Therefore, LisaCalc uses the column 
immediately to the right of the first range as the second 
range. The Tax Rate column is shown in Figure 47. 



Figure 47. Tax Rate Column 

To complete the example, you need to fill in the sales 
tax amount in column M. This amount is just the amount 
of sales (column L) multiplied by the sales tax rate 
(column K). 

~ Select M5. 

~ Enter the formula 

K5*L5 

~ Copy this formula to 
cells M6:M 19. Both 
coordinates are relative. 

,. G [e s: M5 

,. M Formula: K5*L5 

Ii G [ells: ~16:M19 

Finally, to add up the sales tax: 

~ In M21, enter the 
formula: 

It (j [ells: M21 

It M Formula: -sum(M5:M19) 
Sum(M5:M19) 

Your screen should look like Figure 48. 
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Figure 48. After Lookup Example 

You've already used the If function in the Dates example 
above. In this section, you will learn some of the more 
advanced uses to which this function can be put. This is a 
rather boring example; you should probably skip it unless 
you're really interested in tax forms or in more 
complicated formulas. To see the example for this 
section, 

~ Scroll the spreadsheet so that R1 is in the upper left
hand corner. 

Your screen should look like Figure 49. 



• G [ells: M21 Value (Number): 8834.64249999999993 
1-.~M"::'F::':'or;':'m:"";u';'=la':"': -su-m(-M5-:M-l.J.:.9)..::..:..:.:.:....:::..:..::.;.:.;;::.;:.:.."-'--~:"';'O':":';:O";';~.:..;..;;.;:...:..:....--------f,i!!i!!!i!!! 

STU 

Figure 49. Capital Gains and Losses 

This example shows how to calculate capital gains and 
losses for personal income tax. It corresponds to Part III 
of the IRS Schedule D (1981 version). This schedule is 
shown in Figure 50. 

~ Summary of Parts I and II 

19 Combine lines 7 and 18, and enter the net gain or (loss) here.. . . . . . • • 
NOTE: If line 19 is a gain complete lines 20 through 22. It line 19 is a loss complete lines 23 and 24. 

20 If line 19 shows a gain, ~nter the smaller of line 18 or line 19. Enter zero if there I I 
is a loss or no entry on line 18. . . . . . . • . . • . • . . • L-. ___ -'-_ 

21 Enter 60% of line 20. . • . . . • . • . . • • 1 ___ 1_ 
If line 21 ;5 more than zero, you may be liable for the alternative minimum tax. See Form 6251. 

22 Subtract line 21 from line 19. Enter here and on Form 1040, line 12 . 

23 If line 19 shows a loss, enter one of the following amounts: 
(i) If line 7 is zero or a net gain, enter 50% of line 19, 
(ii) If line 18 is zero or a net gain, enter line 19; or, 
(W) If line 7 and line 18 are net losses, enter amount on line 7 added to 50% of the amount on line 18 . 

24 Enter here and as a IOS5 on Form 1040, line 12, the smallest of: 
• on line 23; 

if married and filing a separate return); or, 

Figure 50. Schedule 0 

This example assumes that you have already completed 
Part I, short-term capital gains and losses, and Part II, 
long-term capital gains and losses. The result of Part I is 
in cell T9 and the result of Part II is in cell T10. Adjusted 
taxable income is in T8. 

You may have noticed that column R looks a little odd. 
This is because it is only one character wide. Column R 
contains comments for each line that paraphrase the 
instructions in Schedule D. The column can be widened, 
but you don't have to if you prefer not to see the 
comments. 
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~ Widen column R until it looks like Figure 51. It will be 
58 characters wide. 

El 
"G [ells: RiS Value: 
"M Formula: 

R 

4 
5 
6 I6:~Ii.:.~~.t::i.:9:6~;::::::.:::::.::::::::::::::::::.:::::::::.:::::::::::.:::::::::::::::::::::::.::::::::.::.:::::::::::::::.::::::::::::::::::::::::::::::::.::::::::::::j~.l(8r:: 
7 ----------------------------------------------------------
8 .:AiiIyif~~:::··t.·~~·~~~·~::::I.~.~.9.~·~::·.:::·:.·:·: ... :: ... :: .. :: .. :: .. :: ... ::.: ...... : .. ::.:::::: .. : ... : .. :::.................. 
9 N.~.~ ..... ~.b.9..r.:.t::.~.~.r.:'!1 ..... g .. !i,~n ..... 9.r.: ..... !.9.~.~.i. ...... ~y.rJ1 ..... 9.f: ..... !.!.Q~.~ ..... ? ..... I9.:Q.9 .... § ................ . 
10 N!l..~ ..... !.9.n.g:.t~!.I!l ..... g.~.~.Qi. ..... ~.lJ.I!I ... .9f.. .... ~.jQ.~.~ .. J§ .... ~n.9 ..... ~?. .................. . 
11 Sum of li nes 7 and 18 

12 }I:·.::u.:6~:::n::j.:~:·g:~i,·6;:::: .. :~·~~.i.J.:~~:::·9.:t.:·I?··pf..:.:I~:::··.·:.::::?~!;:9.::.J(:.6·~:::1i~I6::: 
13 60% of li ne 20 
14 Uri'e' 19 - line 21 

15 If.·.:E6:~·.:.·.I$:.:::~.6.9.0:~::.·.·.iJ.9:~:§~:.:::9..6:~.·:::9.I::.?.:~.::'I:rL.·.:: .. .IIII··:: .. 9..i .. :.:.tIfD.:.:::......... 
16 J.f..HD~ .. ] .... .t~.D.9t ... ~.J .. 9..~.~, .... ~~1 .... 9..f.J..i..n.~.J.~... ......... . 
17 ):.f. .... ~.tD.~ .... J.~ ..... !.~ .... D.9.t .. ~ .... !.9..~.~, ....... ~.I9.:rJ1.~ ..... 19.:~ ... J.!.r..~ ...... 1..~ .............................................................. .. 
18 .~L .. UD~~.Z ... ~n.9.J~ .... ~~).9..~.~.~.~, ... .,)J.n~ .. z. .. :+.: .... ?Q~ .. g .. f. .. ~ .. ~D.~.J?... 
19 §.~.l9.:g.~~.~ ..... 9..f. .. J.jn.~ ..... ?.?.t ...... $.?.QQQ, ...... 9.!. ..... ~.J.~.~.~.~.9 ... _t..~~.~~J.~ ..... !.Qg9.rJ1.~. 
20 .~Q~Q, .... .1. .. ~ .. Q~ ..... ~.? .................. . 
21 

Figure 51. After Widening Column R 

The comments in column R are worded similarly to the 
instructions in schedule D. Column S shows which line on 
schedule D matches each row in the spreadsheet; the 
values for each line are in column T. 

To show you how to fill in the formulas in column T, we'll 
start with the simpler formulas and move on to the more 
complicated formulas. This means that you won't be 
filling in the cells in order. For this reason, the values 
shown on your screen aren't necessarily correct until the 
whole column is filled in. 

T8, T9, and T10 are already filled in; they are constants 
as far as this example is concerned, although actually 
they have been computed from other parts of the 
schedule. For cell T 11, the description in R 11 says "sum 
of lines 7 and 18." This means you want T11 to be the 
sum of T9 and T10. 

~ Enter the following 
formula in T11: 

T9+TIO 

The value in T11 is 1050. 

.. G Cells: T11 

.. M Formula: T9+ T10 



For T13 (IRS line 21), R13 says "60% of line 20." Line 20 
is the amount in T12. 

~ Enter the following 
formula in T13: 

.6*T12 

The value in T13 is 0 right now. 

• G [ells: T13 
• M Formula: .6*T12 

T14 (line 22) is described as "Line 19 - line 21." That 
means you want the value to be T13 subtracted from 
T11. 

~ Enter the following 
formula in T14: 

TII-T13 

The value in T14 is 1050. 

• G [ells: T14 
• M Formula: T11-T13 

To fill in T15 and T19, you need two useful functions you 
haven't encountered yet: Max and Min. 

Finding Maximums and Minimums 

For T15, you need a form~la that matches the description 
in R 15. This description reads: 

If line 19 shows a loss, one of 23 (i), (ii), (iii). 

23 (i) is T16, 23 (ii) is T17, and 23 (iii) is T18. The way this 
example is set up, two of these cells will be zero, and the 
other will be greater than zero. You need to find the value 
that is greater than zero. This will, in fact, be the largest 
of the three values, or the maximum. To do this, you use 
the Max function. 

~ Enter the following 
formula in T15: 

Max(T16,T17,T18) 

The value in T15 is 0 right now. 

• G Cells: T1S 
• M Formula: max (T16 t T17t T1S) 

The description for T19 (line 24) says: 

Smallest of line 23, $3000, or adjusted taxable income. 

Line 23 is T15, and adjusted taxable income is T8. To find 
the smallest of the three values, or minimum, you use the 
Min function. 
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~ Enter the following 
formula in T19: 

Min(TI5,3000,T8) 

The value in T19 is O. 

• G Cells: T19 
• M Formula: min(Tl5, 3000, T8) 

Max and Min can also have any number of cells, cell 
ranges, or numbers for arguments. 

The remaining formulas all use the If function. 

The 'f Function Revisited 

In T16, you need a formula to match the description in 
R 16, which says: 

If line 7 is not a loss, 50% of line 19. 

Since you've already used the If function in the date 
example, you shouldn't have any trouble coming up with 
the appropriate formula. The condition to be tested is 
whether line 7 (T9) is greater than or equal to zero. If it is, 
then you want the value of the cell to be 50% of line 19 
(T11). If it's not, then you want the value of the cell to be 
zero. The only remaining fact you need is that the symbol 
for "greater than or equal to" is > =. 

~ Enter the following • G Cells: T16 
formula in T16: t-.-M-F-or-m-ul-a-: 1-·r-(T-9-)=-O ..... ,-.5-*T-l-l,-O) 

If(T9 > = O,.5*TII,O) 

The value in T16 is O. 

Similarly, in T17, you need a formula that matches the 
description in R 17: 

If line 18 is not a loss, same as line 19. 

Since line 18 is T10 and line 19 is T11, 

~ In T17, enter the • G Cells: Tl7 
formula: I-.-M-F-o-rm-u-I a-:-i-f (-T-l0-)-: ...... 0-, T-l-l,-O) 

If(TIO >= O,TII,O) 

The value in T17 is 1050. Notice that T15 and T19 also 
change to show 1050. 



In T18, you need a somewhat more complicated formula. 
Its description in R 18 reads: 

If lines 7 and 18 are losses, line 7 + 50% of line 18. 

In this case, two conditions are to be tested: "line 7 is a 
loss" and "line 18 is a loss." How can you test two 
conditions with the same If function? 

You can do this by using And. An If function with And in it 
looks like this: 

If (condition 1 And condition 2, value 1, value 2) 

And links two conditions to create a compound 
condition. If both condition 1 and condition 2 are true, 
then the compound condition is true, and the value of the 
cell is value 1. If either condition 1 or condition 2 or both 
is false, then the compound condition is false, and the 
value of the cell is value 2. 

In T18, condition 1 is "line 7 is a loss," or T9 < O. 
Condition 2 is "line 18 is a loss," or T10 < o. If the 
compound condition is true, then the value of the cell is 
"line 7 + 50% of line 18," or T9+ .5*T10. If the 
compound condition is false, the value of the cell is zero. 
To enter this formula, 

~ Enter the following formula in T18: 

If(T9 < ° And TIO < O,T9+.5*TIO,O) 

The spaces on each side of And are required. After 
entering the formula, the value in T18 is O. 

The next formula to fill in is in T12. The description in R12 
reads: 

If line 19 is gain, smaller of 18 or 19. Zero if no gain. 

This instruction says that if line 19 (T11) is greater than 0, 
the value of the cell is the minimum of line 19 and line 18 
(T10). If line 19 is less than or equal to zero, the value of 
the cell is zero. On the other hand, if line 18 is zero, then 
the value of the cell is zero, regardless of the value of line 
19. 

You can turn this statement into an If function if you turn 
it around. An equivalent way to phrase it is to say that the 
value of the cell is zero if either line 18 or line 19 is less 
than or equal to zero. Otherwise, the value of the cell is 
the minimum of line 18 and line 19. 
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To make this into an If function, you need to use Or. Or is 
similar to And in that it links two conditions into a 
compound condition. An If function using Or looks like 
this: 

If (condition 1 Or condition 2, value 1, value 2) 

If either condition 1 or condition 2, or both, is true, then 
the value of the cell is value 1. If both condition 1 and 
condition 2 are false, then the value of the cell is value 2. 

In this case, condition 1 is "line 18 is less than or equal to 
zero." Condition 2 is "line 19 is less than or equal to 
zero." If the compound condition is true, then the value 
of the cell is zero; otherwise it is the minimum of line 18 
and line 19. 

To enter this as a formula, 

~ Enter the following formula in T12: 

If (TIl <= ° Or TIO <=O,O,Min(TII,TIO» 

The value in T12 is 1050. Notice that the values in T13 
and T 14 also change. 

In the last formula you have used a function within a 
function: the Min function inside the If function. This is 
perfectly legitimate; in fact, if you wanted, you could use 
a function within a function within a function, and so 
forth. 

Finally, you need to fill in T20. This is the cell that you will 
copy to line 12 of form 1040. If you have a net gain in T 11, 
T20 is the same as the value in T14. If you have a net loss 
in T11, T20 is the same as the value in T19. To do this, 

~ Enter the following • G Cells: T20 
form u la in T20: r-.-M-F-or-m-u-I a-: -if-' (-Tl-l-)-'= '-O,'-T-14-·., T-1-9) 

If(TII > = O,TI4,TI9) 

The value in T20 is 420. 

Your screen should look like Figure 52. 



• G Cells: T20 Value (Number): 420 

• M Formula: i f(T11 )= 0, T14, T19) 
R 

Figure 52. After Capital Gains 

This concludes Chapter 4. You can put away the 
spreadsheet, if you like, using the same method as in 
previous chapters. 
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A complete summary of formulas and functions can be 
found in Appendix 4, Formulas, and Appendix 5, 
Functions, in this manual. 



Chapter 5 
Copying to Other Tools 



Copying to Other Tools 

In this chapter, you learn how to copy values from a 
LisaCalc spreadsheet to become part of documents in 
other tools. In particular, you learn how to 

• Copy from a spreadsheet into a LisaGraph document. 
• Copy from a spreadsheet into a LisaWrite document. 

You also can cut and paste data from a LisaCalc 
spreadsheet to a LisaTerminal document. For how to do 
this, see the LisaTerminal manual. 
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You can copy all or part of a LisaCalc spreadsheet into a 
LisaGraph table to be plotted. When you do this, only the 
values, not the formulas, are copied, since LisaGraph 
cells do not have formulas. 

The example shown here is the same example as in the 
Lisa Graph manual, Section B, LisaGraph Tutorial, 
Chapter 4, LisaGraph and Other Tools. If you don't 
understand any of the LisaGraph operations outlined 
here, you should refer to that tutorial. 

To begin, 

~ Open the ProFile disk window. 

~ Open the LisaCalc examples folder. 

~ Tear off a spreadsheet 
from the Forecast 
stationery pad. 

~ Type a name for the 
spreadsheet. 

~ Open the spreadsheet. 

I~ 
'AN" 

I 
~ ~ 

Forecast 

What you see on your screen should match Figure 53. 



Figure 53. Forecast Spreadsheet 

You may recognize this spreadsheet as another forecast 
from Sue's Sporting Goods, similar to the one in Chapter 
3. This spreadsheet shows monthly projections for 1983 
for three products: Sneakers, Jogging Togs, and 
Bandages. 

Unlike the example in Chapter 3, however, this one shows 
the months vertically, in column A, and the product 
names horizontally, in row 1. This is because this version 
of the spreadsheet has specifically been laid out to be 
convenient to paste into LisaGraph. The X-axis data is in 
column A, and the Y-axis data is in columns B through D. 

To paste the data into LisaGraph, you start by getting a 
blank LisaGraph document: 

~ Change the size and location of the spreadsheet, as 
necessary, until you can see the LisaGraph stationery 
pad. 

~ Tear a graph from the 
LisaGraph stationery 
pad. 
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~ Type the name I 
Sports For~;~il 

Sports Forecast 

LlsaGraph Paper 

~ Open the document. 

~ Change the size and location of the two documents as 
needed so that you can see at least part of both 
documents at the same time. 

When you're through rearranging the documents, your 
screen should look somewhat like Figure 54. 

Figure 54. Desktop with Two Documents 

Now you're ready to copy the data from LisaCalc into 
LisaGraph. The only part of the spreadsheet you want to 
copy is the values in rows 4 through 15. To do this, 

~ If necessary, activate the LisaCalc spreadsheet by 
clicking anywhere within the window. 

~ Select the Cells area. 

~ Type 
"G (ells: 4:15 

4:15 (Enter) 

~ Choose Copy from the Edit menu. 



~ Activate the LisaGraph document. 

~ Select rows 1 through 
12. ( Ii G [ells: 1:12 

~ Choose Paste from the Edit menu. 

Now the data you have copied is automatically graphed 
in LisaGraph. Your screen should look like Figure 55. 

Figure 55. LisaGraph Graph 

To make the graph more readable, you can change the 
graph in the following ways: 

~ Widen the graph so that it fills the whole screen. 

~ Choose Line from the 
Graph menu. 

~ Add titles and so forth. 

Instructions for all these steps can be found in the 
LisaGraph manual. When you get through, your graph 
might look like the one in Figure 56. 
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III'II Spor ts For eC(lSt IIIIII 
• G [ells: Value: 

o 
[] 

$ 

FORECAST 

SPORTING GOODS 

OOOO.---------------------------~ 

Jft-I FEB H~ fflR MAY III J.JL fUi SEPT OCT i'IJV IE 

Monthly Projections for 1983 

Figure 56. Completed Graph 

Sneakers 

Jogging Togs .. 
Bandages 

• 

o 
[] 

You can copy all or part of a LisaCalc spreadsheet into a 
LisaWrite document. Only the values of the cells, not 
their formulas, are copied. When you paste to LisaWrite, 
tab settings replace the LisaCalc column boundaries, so 
that the values still look like a spreadsheet. The tab 
settings are determined by LisaWrite; you might have to 
change them. Once the values have been copied to the 
LisaWrite document, they are treated as text; you can no 
longer perform calculations with them. 

The LisaWrite manual, Section B, LisaWrite Tutorial, 
Chapter 6, Working with Multiple Documents, shows an 
example of pasting a LisaCalc spreadsheet into a 
LisaWrite document. 

In this example, you paste the spreadsheet in Figure 57 
into the LisaWrite document shown in Figure 58. 



u 

,I "G [ells: IValue: 

"M Formula: 
A B C D II E f 

1 ')p",-,y; nt· .on I)uantity Cost/Uni t Mo Cost ti 2 
• 

',.-

3 :ouch 16548 1 75.00 75.00 , 

4 Desks 498766 ~ 55.50 166.50 
5 :r,a.irs 1954J 3 39.00 117.00 
6 .., 
7 Total $ 358.50 

~ ...... 
•• ~ 

Figure 57. LisaCalc Spreadsheet 

DFFICE SUPPU CDr1MERCIAL TERM LEASE AGREEr1ENT 

OFFICE SUPPLY CORPDF'ATION, SAN LEANDRO, CALIFORNIA 

CUSTm1ER mFDPI1ATIOI~ 

CUSTm1ER'S ~IR~1E: John Snnt;·, CU::;Tm1ER/1:OiITRACT 1,10. A101 
8ILLH'IG ACORESS: Alphabet Electronics, 1st ;!.: Frerr,,:d Mt. 'new 
I~ISTALLATIm'l ADDRESS: Same 
I 

TERM OF AGREEI'UIT: _24 ~HITH _36 MDf!TH _48 MONTH 

Dffice Supply Corpol'l'hon hereb'i leases to the Customer. '').nl] Cu"omer 
hereb)! leases from Offlce Supply Corporatlon, n·,e Equipment and Furniture 
descnbed below I here8Jter csHed "The EqLllpment") in a.ccorde.nce I'li t!l tile 
terms aml cClndi tions art::l prices set fortl", bel 01'1 and on the remaimng p.3.:Jes 
hereof. 

EOUIPME~IT 
ORDERED OUA~ITITY 

MONTHLY LEASE 
AMOUNT/1j~1 IT 

MONTHLY 
COST 

Figure 58. LisaWrite Document 

The results are shown in Figure 59. 
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CUSTOMER INFOR~1ATION 

CUSTOMER'S NAME: Jolin Smith CUSTOMER/CONTRACT NO. A101 
BILLING ADDRESS: Alphabet Electronics, 1st & Fremont, Mt. View 
INSTALLATION ADDRESS: Same 

TERM OF AGREEMENT: _24 MONTH _36 MONTH _48 MONTH 

Office Supply Corporation hereby les.ses to the Customer, end Customer 
I,ereby leases from Office Supply Corporation, the Equipment and Furniture 
described below (hereafter called "The Equipment") in accordance vlith the 
terms and conditions and prices set forth below and on the remaining pages 
hereof. 

EQUIPMENT 
ORDERED 
Description 

Coucrl 1654A 
Desk.s 49876B 
CI·lairs 1954J 

Total 

QUANTITY 
Quantity 

MONTHLY LEASE 
AMOUNT /UNIT 
Cost!1Jnit 

$ 75.00 
$ 55.50 
$ 39.00 

MONTHLY 
COST 
Mo. Cost 

$ 75.00 
$166.50 
$117 .00 

~358. 50 

Figure 59. LisaCalc Data Pasted into LisaWrite Document 



Chapter 
Summary 

To copy a LisaCalc 
spreadsheet into a 
LisaGraph document 

To copy a LisaCalc 
spreadsheet into a 
LisaWrite document 

• Get or activate the 
LisaCalc spreadsheet. 

• Select the cells that you 
want to copy. 

• Choose Copy from the 
Edit menu. 

• Get or activate the 
LisaGraph document. 

• Select the location in the 
LisaGraph table where 
the cells are to be pasted. 

• Choose Paste from the 
Edit menu. 

• Edit and format the 
graph and table. 

• Get or activate the 
LisaCalc spreadsheet. 

• Select the cells that you 
want to copy. 

• Choose Copy from the 
Edit menu. 

• Get or activate the 
LisaWrite document. 

• Place the insertion point 
where you want to place 
the LisaCalc data, or 
select the text in the 
LisaWrite document that 
you want to replace. 

• Choose Paste from the 
Edit menu. 

• Edit and format the 
document. 
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What's in the 
LisaCa/c Reference Guide? 

This LisaCalc Reference Guide contains complete 
information about LisaCalc and is divided into two parts. 
Chapter 1 briefly explains basic LisaCalc concepts. Read 
Chapter 1 for an overview of LisaCalc and how to use it. 
Chapter 2 is divided into categories. Within each 
category there are procedures for accomplishing specific 
tasks and some examples. Use Chapter 2 for step-by
step instructions on how to complete a particular task 
within LisaCalc. 

You can look for specific topics in the Index, in the table 
of contents of this Reference Guide, or at the beginning 
of each category of Chapter 2 of this Reference Guide. 

The information in the LisaCalc Reference Guide is 
based on the assumption that you have completed 
LisaGuide, for an introduction to your Lisa, and Section 
A, Getting Started with LisaCalc, for a brief introduction 
to the basic skills needed to use LisaCalc. For more self
paced instructions on LisaCalc, you can use the LisaCalc 
Tutorial, Section B. 

Cv 



Chapter 1 
Overview 



What's in 
Chapter 1? 

The LisaCa/c 
Screen 

Menu bar 

Status panel 

Deselect box 

Window 

Row 

Overview 

Chapter 1 covers the basic concepts and terminology for 
LisaCalc. It introduces you to the LisaCalc screen, 
elements of a LisaCalc spreadsheet, selecting, scrolling, 
menus, dialog boxes, alert boxes, and the LisaCalc work 
flow. 

A LisaCalc window is divided into two parts: the 
spreadsheet view and the status panel. When you work 
with a LisaCalc document, the screen typically looks 
like Figure 1. 

Value area 

Formula area Menu title 

Cells area 

Figure 1. Typical LisaCalc Screen 

Spreadsheet view 

Menu item 
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Icon 

Window 

Menu bar 

Menu title 

Menu item 

Spreadsheet view 

Status panel 

Cells area 

Value area 

Formula area 

Deselect box 

Cell 

Column 

Row 

Value 

Graphic symbol 
representing something on 
the Lisa desktop. 

Displays the contents of an 
open icon, such as the 
contents of a document or 
a disk. 

Displays the names of all 
available LisaCalc menus. 

Shows the names of a list of 
menu items. 

An option, command, or 
instruction that affects the 
current selection when you 
choose it. 

Displays the values of the 
cells currently visible. 

Shows information about 
the selected cell or cells. 

Shows which cell or cells 
are selected. 

Shows the contents of the 
selected cell and the kind 
of value it contains. 

Shows the formula of the 
selected cell. 

When selected, indicates 
that nothing in the 
spreadsheet is selected. 

A box at the intersection of 
a row and a column that 
contains a single value, 
such as a date. 

Cells arranged vertically. 

Cells arranged horizontally. 

The contents of a cell; a 
number, label, or date. If a 
cell has a formula, the value 
is the result of the formula. 



LisaCa/c 
Concepts 

A LisaCalc spreadsheet is an arrangement of cells in 
rows and columns. Each cell is identified by its 
coordinates, which are the column letter and the row 
number. For example, cell A 1 is in row 1 and column A. A 
cell can have a value, which is a number, label, or date. A 
cell can also have a formula, in which case its value is 
computed from the formula. A formula is a mathematical 
expression combining numbers, dates, functions, and 
coordinates of other cells. For more information about 
formulas, see Appendix 4, Formulas, in this manual. 

When you change the value of a cell, the values of cells 
that depend on it change automatically. You can edit the 
contents of cells using the same procedures that you use 
for all Lisa editing. You can also format individual cells, 
or groups of cells, or the whole spreadsheet. 

LisaCalc cells can be protected, which prevents their 
values from being accidentally cleared or replaced. 

Pointers 

As you move the mouse, the pointer moves around the 
screen and assumes different shapes as you move from 
one area to another. LisaCalc has the following pOinter 
shapes. 

I The text pOinter appears 
whenever you can select 
text. 

The hollow cross-hair 
pointer appears in the 
spreadsheet view to show 
when you can select cells. 

The arrow pointer appears 
outside the spreadsheet to 
show when you can select 
icons, view controls, and 
menu items. It always 
points up and to the left. 

The check pointer is used 
to make choices within 
some dialog boxes. 

The hourglass appears 
when you need to wait while 
the Lisa finishes what it is 
doing. 
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Selecting 

You select something by clicking the mouse button on 
the appropriate object. The current selection is shown in 
inverse video (white on black). 

Table 1. Selecting in LisaCalc 

To Select 

One cell 

One column 

One row 

Do the Following 

• Move the pOinter into the 
cell and click the mouse 
button once. 

or 

• Type the coordinates of 
the cell in the Cells area 
and press (Enter). 

Example: 

A 1 (Enter) 

• Move the pointer into the 
column header and click 
the mouse button once. 

or 

• Type the column letter or 
letters in the Cells area 
and press (Enter). 

Example: 

B (Enter) 

• Move the pOinter into the 
row header and click the 
mouse button once. 

or 

• Type the row number in 
the Cells area and press (Enter). 

Example: 

4 (Enter) 



Table 1. Selecting in LisaCalc, continued 

To Select 

Several cells, columns, 
or rows 

Between two columns 
or between two rows 

Do the Following 

• Move the pointer into the 
first cell, column header, 
or row header. 

• Press the mouse button 
and hold it down while 
moving the pointer into 
the last cell, column 
header, or row header; 
then release the mouse 
button. 

or 

• In the Cells area, type the 
coordinates of the first 
cell, column, or row. 

• Type a colon (:). 

• Type the coordinates of 
the last cell, column, or 
row, followed by (Enter). 

Examples: 

A 1 :B4 (Enter) 

A:C (Enter) 

3:4 (Enter) 

• Position the pointer on 
the grid handle between 
two columns or rows and 
click the mouse button 
once. 

or 

• In the Cells area, type the 
coordinate of the first 
row or column. 

• Type a vertical bar ( I ). 
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Table 1. Selecting in LisaCalc, continued 

To Select 

One or more characters 

One word 

Whole contents of cell 

Next cell left, right, up, or 
down 

Do the Following 

• Type the coordinate of 
the second row or 
column. 

Examples: 

.AJB 

314 

• If the characters are in a 
cell, select the cell first. 

• Move the text pointer to 
the left of the first 
character. 

• Press and hold down the 
mouse button. 

• Move the pointer directly 
through to the last 
character and release the 
mouse button. 

• If the word is in a cell, 
select the cell first. 

• Move the pointer into the 
word and cl ick the mouse 
button twice. 

• If the selection is already 
in the cell, click the 
mouse button three 
times or press the (Enter) 
key. 

• If the selection is not in 
the cell, move the pointer 
to the cell and click four 
times. 

• Press ~ key or (Shift) 
followed by (~). 

• Press® key or (Tab) key. 

• Press <® key_ 

• Press @) key_ 



Table 1. Selecting in LisaCalc, continued 

To Select 

First cell in next row 

Formula area 

Cells area 

Value area 

Whole spreadsheet 

Extend a selection 

Deselect; select nothing 
in the document 

Do the Following 

• Press the (Return) key. 

• Move the pointer to the 
Formula area and click 
the mouse button three 
times. 

or 

• Hold down the @ key 
and press the M key (for 
Mathematical formula). 

• Move the pointer to the 
Cells area and cl ick the 
mouse button three 
times. 

or 

• Hold down the@ key 
and press the G key (for 
Go to). 

• Move the pOinter to the 
Value area and click the 
mouse button three 
times. 

• Choose Select All of 
Document from Edit 
menu. 

• Move the pointer to the 
end of the new selection. 

• Press and hold down the 
(Shift) key and click the 
mouse button once. 

• Move the pointer to the 
deselect box in the 
upper-left corner of the 
spreadsheet view and 
cl ick the mouse button 
once. 
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When you select a cell or group of cells by editing the 
Cells area, and the cells are not showing on the screen, 
LisaCalc automatically scrolls the spreadsheet so that 
the cells are showing. 

Scrolling 

To see parts of the spreadsheet not showing on the 
screen, use the view controls to scroll hidden portions of 
the document into view. Figure 2 shows LisaCalc's view 
controls. 

Figure 2. Window with View Controls 

Scroll bars 

Scroll arrows 

Contain controls that scroll 
hidden portions of a 
spreadsheet into view. 

Bring hidden portions of a 
spreadsheet into view 
slowly, one row or column 
at a time. 



Elevators 

View buttons 

Split control 

Move within the scroll bar 
to indicate where the 
current view is in relation to 
the rest of the spreadsheet. 
Enable you to scroll quickly 
to any spot in the 
document. 

Scroll the next or previous 
view of the spreadsheet 
into sight. 

Divides the spreadsheet 
view into two or more views 
that can be scrolled 
independently. 

Table 2 explains the different ways to scroll in LisaCalc. 

Table 2. Scrolling in LisaCalc 

To Scroll 

Row by row or 
column by column 

Continuous rows or 
columns 

View-sized increments 

Continuous view-sized 
increments 

Large jumps 

Do the Following 

• Move the pointer into a 
scroll arrow and click the 
mouse button once for 
each row or column. 

• With the pointer in a 
scroll arrow, press the 
mouse button and hold it 
down until the desired 
view is shown. 

• Move the pOinter into a 
view button and click the 
mouse button. 

• With the pointer in a view 
button, press the mouse 
button and hold it down 
until the desired view is 
shown. 

• Move the pointer into an 
elevator and hold down 
the mouse button while 
moving the elevator up or 
down in a vertical scroll 
bar, or left or right in a 
horizontal scroll bar. 
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Table 2. Scrolling in LisaCalc, continued 

To Scroll 

Split a view vertically 

Split a view horizontally 

Close a split view 

About Menus 

Do the Following 

• Release the mouse 
button when the elevator 
is in the correct position 
relative to the beginning 
and end of the scroll 
bars. 

• With the pointer on the 
split control in the 
vertical scroll bar, press 
the mouse button and 
hold it down, moving the 
mouse toward you at the 
same time. 

• With the pointer on the 
split control in the 
horizontal scroll bar, 
press the mouse button 
and hold it down, moving 
the mouse to your right at 
the same time. 

• With the pointer in the 
split control of the view 
you want to close, press 
and hold the mouse 
button, pulling the edge 
of the spl it view to the 
original split control. 

LisaCalc's editing, formatting, printing, and filing 
operations are listed on menus. The menu bar at the top 
of the screen shows the names of the available menus. 
Figure 3 shows the menu bar with the names of LisaCalc 
menus. A description of all LisaCalc menu items can be 
found in Appendix 1, Menu Items, in this manual. 

,.. File/Print Edit Type Style Page layout Format Protect Calculate .., 

Ilj 1111UlI-Miliolll I 

Figure 3. LisaCalc Menu Bar 



To choose a menu item, 

~ Move the pointer to the protert 
menu bar and position it 
over the name of the 
menu you want to open. 

~ Press the mouse button 
and hold it down. Notice 
that the menu is now Protect Formulas fs Values 
showing. Protect Formulas Only 

~ Move the pointer into 
the menu item you want. 
Notice that the item is 
highlighted. 

~ Release the mouse button. 

Some menu items are accompanied by an Apple symbol 
and a letter of the alphabet. This means that you can hold 
down the @ key while typing the letter to choose that 
menu item rather than choosing the item with the mouse. 
Refer to Appendix 2, Apple Keys, in this manual, for a list 
of the menu items that you can choose using the @ key. 

Some menu items are followed by an ellipsis ( ... ). When 
you choose one of these menu items, a dialog box 
appears requesting additional information that is 
required to complete the operation. Dialog boxes are 
explained in the following section. 

When a menu item is shown in gray instead of black, it 
cannot be chosen at that time. This is usually because it 
does not apply to the current selection. 

Some menu items are grouped together and represent 
the available choices for a particular menu setting. The 
current setting has a check mark next to it, while the 
others don't. If you choose another setting in the group, 
the current one is automatically turned off. 

For example, the Format menu is divided into two 
sections: the first shows the alignment of the current 
selection, and the second shows the number style for the 
selection. For any selection, each section has exactly one 
check mark. If you choose a different option in the 
bottom section, the bottom check mark changes, but the 
top check mark stays as it is. 
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Dialog Boxes 

A dialog box appears beneath the menu bar after you 
choose a menu item followed by an ellipsis ( ... ). Figure 
4 shows a LisaCalc dialog box. The dialog box asks you 
to fill in information required to complete the operation. 
Usually, default information is already filled in, which you 
can accept by clicking OK. 

Fixed Decimal Point--Number of Places: • 
( [ancel J 

( OK J 

Figure 4. Fixed Decimal Format Dialog Box 

To fill in a dialog box, 

~ If a value is already selected, and you want to change 
the value, type in the new value. 

~ If the dialog box (ell: 09 
contains check boxes, 
move the pointer to the 
box you want to check 
and click the mouse 
button once. 

Same 

Formula: ~7*~ 
I I 
Relative 

~ When the dialog box shows the information you want, 
position the pointer in OK and click the mouse button 
once. 

To dismiss the dialog box without changing the 
document, whether you changed a value in the dialog 
box or not, 

~ CI ick Cancel. 

Alert Boxes 

An alert box is a box in which a message from the Lisa is 
displayed. The message can be Wait, Note, Caution, 
Stop, or ?, as described below. You can usually respond 
to these messages by clicking the OK or Cancel button. 
To do this, move the pointer to the OK or Cancel button 
and click the mouse button. 



Wait Message 

The Wait message tells you that the Lisa is carrying out 
an operation that may take some time. You don't need to 
respond to the message. However, some Wait messages 
give you the option of terminating the operation by 
holding down the@ key while typing a period. Figure 5 
is an example of a Wait message. 

LisaCalc is calculating. 

To terminate the operation, hold down the Apple key 
while you type a period. 

Figure 5. Wait Message 

Note Message 

The Note message tells you that something might need 
your attention. Most likely, everything is all right, but 
there is something you should know about just in case. 
To dismiss the alert box with a Note message, you just 
click OK. Figure 6 shows a LisaCalc Note message . 

• "85 Forecast" has not been changed since it 
was last put away. 

Figure 6. LisaCalc Note Message 

Caution Message 

OK 

The Caution message tells you that you are about to do 
something risky that cannot be undone or something 
that may take a long time. To allow the operation to 
continue, you click OK. To cancel the operation, you click 
Cancel. Figure 7 shows a Caution message. 
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Do you really want to choose an edit menu 
item. The Clipboard has cells on it which 
are being moved. The formulas that refer 
to those cells have been set to error. IF 
you choose an edit menu item you may 
inval idate the move. 

To leave the document as it is now, cl ick 
Callcel. 

Once you click OK, you wi II Ilot be able to 
change your mind, even by choosing Undo. 

Figure 7. Caution Message 

Stop Message 

Cancel 

OK 

The Stop message tells you that something you 
requested cannot be done and why. To dismiss the alert 
box with a Stop message, you click Cancel. Figure 8 is an 
example of a LisaCalc Stop message. 

The formula you entered is missing one of 
the operands For +. 

Figure 8. LisaCalc Stop Message 

?Message 

Cancel 

The? message tells you that you can choose one of a 
number of alternative actions. Most? messages have 
two or three choices. You dismiss the? alert box by 
clicking one of the choices. Figure 9 is an example of a ? 
message. 

The lower diskette appears to be new. 
Would you like Lisa to initialize it? 

Figure 9. ? Message 

Cancel 

Initialize 



L isa Calc 
Work Flow 

The following sections outline how to start a new 
LisaCalc document and how to work with an existing 
LisaCalc document. For specific information and step
by-step instructions refer to Chapter 2 of this Reference 
Guide and to Section D, Desktop Manager Reference 
Guide, in the Lisa Owner's Guide. 

Starting a New Document 

To start a new LisaCalc document, 

~ Open the ProFile 
window. 

~ Tear off a spreadsheet 
from the LisaCalc 
stationery pad. 

~ Type the new 
document's name. 

Ll 

I~T'"'' ::I .... a-ch1 :: :: :: 
.~ .... ,. 

LlsacalC paper 

~ Open the new 
document's window. • G (ells: IValue: 

• M Formula: 
A B C 

1 
2 
3 
4 

A 

0 

~ Enter data into the 
spreadsheet. 

ii!1Iii! 
~ Save all changes about every 15 minutes and 

continue working. 

~ Print the spreadsheet, if you like. 

~ Put away the completed document. 

I 

• 

: 
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To organize your documents into a folder and keep the 
disk window uncluttered, you might want to 

~ Move the saved 
document into a folder 
of related documents. 

or 

~ Tear a new folder from the folder pad, name the 
folder, and move the document into it. 

Working with an Existing Document 

To get a filed LisaCalc document to work with, 

~ Open the ProFile 
window. 

~ If the document is in a 
folder, open the folder 
that contains the 
document that you want 
to work with. 

~ Open the document. 

~ Edit and format the 
document, saving it 
every 15 minutes. 

U 
Andy's Documents 

~~ tmrl 
a.ca-ch 

Set Aside Everything 
Set Aside "aca-chl" 

Save & Put Away 
Save & Continue 

Revert to Previous Version 

Format for Printer ... 
Print ... 
Monitor the Printer ... 

~ Print the spreadsheet, if you like. 

~ Put away the document in its original location. 



Chapter 2 
Procedures 



What's in 
Chapter2? 

Procedures 

Chapter 2 contains the procedures for doing everything 
that can be done in LisaCalc. To make the procedures 
easier to find; they have been divided into categories 
according to function. These categories are: 

Calculate 

Look here for operations that involve calculations. 

C24 Circle Missing Values 
C27 Dates 
C29 Formulas 
C31 Functions 
C33 Recalculation 

Edit 

Look here for operations that change the contents of 
your document. 

C38 Clear Entries 
C40 Copy Cells with Paste 
C45 Copy Cells with Paste Adjusting 
C52 Copy Text 
C54 Cut Cells 
C55 Cut Rows or Columns 
C57 Cut Text 
C58 Enter Value 
C60 Insert Rows or Columns 
C62 Insert Text 
C63 Move Cells 
C67 Move Rows or Columns 
C69 Move Text 
C71 Replace Text 
C72 Restore Previous Entry 
C73 Revert to Previous Version 
C74 Undo Last Change 

Chapter 2 ::: C21 
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Format 

Look here for operations that change the appearance of 
the spreadsheet. 

C76 Alignment 
C78 Column Widths 
C80 N umber Style 
C84 Printing Type Style 
C86 Screen Type Size 
C87 Show Formulas and Show Values 

Print 

Look here for print operations. 

C90 Format for Specific Printers 
C95 Insert Page Marks 
C96 Print a Document 
C 100 Remove Page Marks 

Protect 

Look here for operations that protect values from 
accidental destruction. 

C102 Protect Formulas and Values 
C 103 Protect Formulas Only 
C104 Unprotect 

Other Tools 

Look here for operations that copy values from LisaCalc 
to other tools. 

C106 LisaGraph 
C107 LisaWrite 



C24 Circle Missing Values 
C27 Dates 
C29 Formulas 
C31 Functions 
C33 Recalculation 

Calculate 
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To circle all cells with missing values 

~ Choose Circle Missing 
Values from the 
Calculate menu. 

To find the next missing value 

Function Hints ... 

~ Choose Find Next Missing Value from the Calculate 
menu. 

To display the spreadsheet without circles around values 

~ Choose Don't Circle Values from the Calculate menu. 



The purpose of these menu items is to help you find cells 
whose values may have been omitted or mistyped. 

If you choose Circle Missing Values, then all cells in the 
spreadsheet whose values are missing are circled. This 
includes the following categories of cells: 

1. A blank cell that is referenced by a formula in another 
cell. 

2. A cell whose value is a label, and that is referenced by 
a formula in another cell, in which the cell occurs as 
part of a range that is an argument to a function. 

3. A cell whose formula references a cell in one of the 
first two categories or references a cell whose value 
has been cut. 

When you choose Circle Missing Values, the first circled 
cell below the current selection is selected. You can then 
enter a value if you decide that the cell is incorrect. When 
you do this, the circles disappear from any cell that 
depends on the cell you changed. If Calculate Manually is 
in effect, the circles don't disappear until you choose 
Calculate Now. 

When you choose Find Next Missing Value, the next cell 
whose value is still missing is selected. If necessary, 
LisaCalc automatically scrolls the spreadsheet. Cells 
described in 3 above are not selected. 

When there are no more cells with missing values below 
the current selection, an alert message is displayed 
telling you there are no more cells below the current 
selection. 

Calculate 

Circle 
Missing Values 

(continued) 
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Calculate 

Circle 
Missing Values 
(continued) 
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Find Next Missing Value can also be used to facilitate 
filling in a template. To do this, you set up the 
spreadsheet so that it contains all the formulas, but not 
the values. To begin, select A 1. When you choose Find 
Next Missing Value, LisaCalc selects the first cell that 
needs to be filled in. After you enter a value in this cell, 
you choose Find Next Missing Value again, and LisaCalc 
selects the next cell that needs to be filled in. When the 
last missing value has been filled in, LisaCalc displays an 
alert message telling you that there are no more cells 
with missing values. 

In the following example, the formula in A2 is A 1 + 1, and 
the formula in 85 is Sum(81 :83). Notice which cells are 
circled. 



To enter a date value 

~ Enter a value of the form: 

month/day/year 

To enter a date part 

~ Enter a value of the form: 

x days 
x weeks 
x months 
x years 

To enter a date formula 

~ Enter a formula in one of the following forms: 

- Date 
- Date part 
Date + date part 
Date - date part 
Date part + date part 
Date part - date part 
Date - date 

Calculate 

Dates 
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Possible uses for dates include the following: 

• Determining whether one date is earlier or later than 
another. 

• Calculating the number of days, months, or years 
between two dates. 

• Converting a number of days to a number of months or 
years, or the other way around. 

Dates are fully explained in Appendix 4, Formulas, in this 
manual. 

Examples 

Date 

1/4/83 
01104/83 
7/4/1776 
9/9/9 

(= 9/9/1909) 

Date Part 

5 days 
2 weeks 
1 month 
8 years 

Date Formula 

1/4/83 + 5 days 
9/6/79 - 2 weeks 
3 months + 4 days 
6 months - 20 months 
7/4/1976 - 7/4/1776 



To enter a formula in a cell 

~ Select the cell. 

~ Select the Formula area by clicking in it or by pressing 
@ and typing M for Mathematical formula. 

~ Type the formula. 

~ Enter the formula by pressing (Enter) or selecting 
another cell. 

To quickly enter coordinates of a single cell in a formula 

~ Move the pOinter to the cell whose coordinates should 
appear in the formula. 

~ While holding down the 
(Option) key, click the 
mouse once in the cell. 

Calculate 

Formulas 
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Formulas 
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To quickly enter coordinates of a range of cells in a 
formula 

~ Move the pointer to the first cell in the range. 

~ Press and hold down the (Option) key. 

~ Press and hold down the mouse button; move the 
pointer to the last cell in the range. 

~ Release the (Option) key and the mouse button. 

Formulas are fully explained in Appendix 4, Formulas, in 
this manual. The topics covered include: 

• What sequence the elements of a formula should be in. 
• How to construct formulas whose value is a number. 
• How to use logical formulas to make choices between 

alternative values. 
• How to use dates in formulas. 

Examples 

A1*82 
100*(819-821)/821 
Sum(A 1:A 10) 
A3 + Max(A4:A 7 ,84,C5:C8) 
2*Pi* A3 A 2 
83 > "3/14/82" 



To use a function in a formula 

~ Enter the function in the following form 

name (argument 1, argument 2, ... ) 

To see a summary of functions and their arguments 

~ Choose Function Hints from the Calculate menu. 

Functions are fully explained in Appendix 5, Functions, in 
this manual. 

A complete list of functions follows. 

Name 

Financial functions 

Annuity 
Compound 
Npv 

General purpose functions 

If 
Lookup 
Search 

Purpose 

Annuity factor 
Compound interest factor 
Net present value 

Set conditional value 
Find specified value 
Find number of occurrences 
of a specified value 

Calculate 

Functions 
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Name Purpose 

Trigonometric and algebraic functions 

Cos Cosine 
Sin Sine 
Tan Tangent 
Acos Arccosine 
Asin Arcsine 
Atan Arctangent 
Exp Exponential function 
Ln Natural logarithm 
Log Logarithm to the base 10 
Sqrt Square root 
Sumsqr Sum of the squares 

Other mathematical functions 

Abs 
Average 
Count 
Int 
Max 
Min 
Round 
RoundlEEE 
Sum 

Examples 

Sum(39.5,A 1,82:07) 
Count(A 1:E13) 
Tan(839 * Pi) 

Absolute value 
Average (mean) 
Number of values in a range 
I nteger part 
Greatest value 
Smallest value 
Round value 
Round value 
Total 

Lookup("Saugerties",A 1:A 16,01 :016) 
Npv(.14,01:012) 
If(A1 < 81,29.5,Max(C1,01,E1)) 
If(E2 = F2,lf(G2,23,lf(H1,J1,K1)),47.5) 



If you want the spreadsheet recalculated every time any 
value changes 

~ Choose Calculate 
Automatically from the 
Calculate menu. 

If you want the spreadsheet recalculated only on request 

~ Choose Calculate Manually from the Calculate menu. 

To recalculate the spreadsheet immediately 

~ Choose Calculate Now from the Calculate menu. 

To interrupt recalculation 

~ While holding down the 
@ key, press the period 
key. 

In a new spreadsheet, Calculate Automatically is in 
effect. With this option, whenever the value of a cell 
changes, all cells that depend on it are recalculated. You 
can also choose Calculate Now for immediate 
recalculation of the whole spreadsheet. 

Calculate 

Recalculation 
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If you have chosen Calculate Manually, no recalculation 
takes place until you choose Calculate Now. Therefore 
the value shown for a cell on the screen may not be its 
correct value. 

If the formula in a cell refers to the same cell, either 
directly or indirectly, this is called a circular reference. 
LisaCalc attempts to check for circular references, but 
this is not always possible. 

Example 

If A 1 contains the formula 

A1+1 

this is a direct circular reference, which LisaCalc can 
detect. 

If A 1 and A2 contain the following formulas 

A1: A2+1 
A2: A1+1 

this is an indirect circular reference, which LisaCalc 
usually cannot detect. 

If Calculate Automatically is in effect, LisaCalc 
recalculates the spreadsheet for about 30 seconds 
before stopping. After this time, an alert message 
appears telling you that calculation is not finished. This 
message means one of two things: either your 
spreadsheet is too large or complicated to be calculated 
in 30 seconds, or it contains a circular reference. If you 
have determined that the spreadsheet doesn't have any 
circular references, you can choose Calculate Now to 
complete the recalculation. 



When you choose Calculate Now, LisaCalc continues to 
recalculate the spreadsheet until all formulas have been 
calculated, regardless of whether Calculate Manually or 
Calculate Automatically is in effect. If your spreadsheet 
contains a circular reference, LisaCalc will never finish 
calculating. To interrupt calculation, press the period key 
while holding down the @ key. 

While a spreadsheet is being calculated, cells that are 
going to be changed are shown in gray before the new 
value is displayed. 

Calculate 

Recalculation 
(continued) 
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C38 Clear Entries 
C40 Copy Cells with Paste 
C45 Copy Cells with Paste Adjusting 
C52 Copy Text 
C54 Cut Cells 
C55 Cut Rows or Columns 
C57 Cut Text 
C58 Enter Value 
C60 Insert Rows or Columns 
C62 Insert Text 
C63 Move Cells 
C67 Move Rows or Columns 
C69 Move Text 
C71 Replace Text 
C72 Restore Previous Entry 
C73 Revert to Previous Version 
C74 Undo Last Change 

Edit 
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To clear cells 

~ Select the cells you want to clear. 

~ Choose Clear Entries 
from the Edit menu, or 
press the ~ key_ 

Insert Blnnl<. 

Select All of Document .A 

You can clear entries from one or more cells in the 
spreadsheet, including whole columns and rows. When 
you clear entries, values and formulas are removed from 
the cells but they retain their format. 

If a cell is protected, you cannot clear it until you 
unprotect it. If you clear a range of cells, and some of 
them are protected, only the unprotected cells are 
cleared. In this case, you get a warning message. See the 
Protect procedures in this chapter. 

Cleared entries are not placed on the Clipboard and 
therefore cannot be pasted. You can immediately choose 
Undo Last Change from the Edit menu to reverse the 
clear operation. 

After you clear a cell, you cannot restore its contents with 
Restore Previous Entry. 



If a formula references a cell that has been cleared, the 
value of the cleared cell is zero. If, on the other hand, the 
cell has been cut rather than cleared, the formula has the 
value Error. Therefore, if you want to remove the contents 
of a cell, you should use Clear rather than Cut. (This does 
not apply to a cut that is the first step of a move.) 

Edit 

Clear Entries 
(continued) 
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To copy cells within the same spreadsheet 

~ Select the cells that you want to copy. 

~ Choose Copy from the 
Edit menu. 

Paste 
Paste Adjusting ... 
Paste Values 

t· .... · .... ·"·"· .. ·""",,,,,,·,,· .... · .............. " .... " .......... "" .... """ .. ".",, .. 

~ Select the new location for the cells. 

~ Choose Paste or Paste Values from the Edit menu. 



To copy cells into another spreadsheet 

~ Select the cells that you want to copy. 

~ Choose Copy from the 
Edit menu. 

Paste Adjusting ... 
Paste Values 

~ Get or activate the spreadsheet that you want to copy 
to. 

~ Select the location for the cells. 

~ Choose Paste or Paste Values from the Edit menu. 

If you choose Paste, the entire cell, including its format, 
protection, value, and formula, is copied. 

When you copy a range of cells, some of the cells in the 
range might have formulas that refer to other cells in the 
range. In this case, the formulas are automatically 
updated so they refer to the new cells, not the old cells. 
References to cells outside the range are not changed. 
Formulas outside the range being copied are not 
affected. See the example below. 

Edit 

Copy Cells 
with Paste 

(continued) 
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If you choose Paste Values, the format, protection, and 
value of the cell are copied, but not its formula. The copy 
of the cell retains its current value; this value does not 
change when the value in the original cell changes. 

One use of Paste Values is when you want to exchange 
val ues between spreadsheets. When you copy cells from 
one spreadsheet to another, Paste may not be 
appropriate because the locations of the cells in the new 
spreadsheet may not be the same as the locations of the 
corresponding cells in the old spreadsheet. However, if 
you use Paste Values, the formulas of the cells are not 
copied, and therefore you don't have to worry about the 
locations of the coordinates. 

When you copy cells, a duplicate is put on the Clipboard. 
When you paste, you are pasting a copy from the 
Clipboard; a copy remains on the Clipboard so you can 
paste it again. You can immediately reverse either the 
copy or the paste operation by choosing Undo Last 
Change from the Edit menu. 

When you copy cells, the following combinations are 
possible: 

A single cell can be copied 
to another cell. 

A single cell can be copied 
to a range of cells. The 
range can have any size or 
shape. 

1 
2 
3 
4 
5 
6 

ABC 

ABC 



A range of cells can be 
copied to another range of 
the same size and shape. 

A range of cells can be 
copied to a larger range if 
the new range is an exact 
multiple of the size and 
shape of the old range. 

A range of cells can be 
copied to a single cell. In 
this case, the single cell is 
treated as the upper left 
corner of a range the same 
size and shape as the range 
to be copied. 

A column or row can be 
copied to another column 
or row. 

1 
2 
3 
4 
5 
6 

ABC 

A 

·::: .. :.·.·:.:.·.0. ... ;J.~.==::~\'T·.·.·: ... ·:::.·.· ... ·.·.· ........ : .............. ::J 
................................ C ..... · ........ :.·: ..... ·::.· ...... : .......... I .............................. l 

i 21. 9Si 21. 9Si 

:;;::~~=j~=li~[-~~~i~ 
A B ~ C II 

rL ............. §.9.:..J~L ......... .?2 .. JJ.i ................ ?: .. ~?.l 
2 21. 951 14,56! 18,27' 1 ........ · .... · .................. :· .. ·· ...... ··~+ ............ T·· .......... ·· .. ·· ...... · ...... j. 
4 5O.1Si 23.21i 2.92 "5 .... · ...... ir .. 9·s·:········· .. ·i4 .. :··5·6·r ...... · .. ··i·8 .. ~·'2} 
6 i : 

Edit 

Copy Cells 
with Paste 
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A colu mn or row can be !--+-......:A~.II--~-Ij..-..:;:~+-~....II 

~o~~a: ~~I ~ ~ ~i~rh~~~ li~· 1 §.~9.~Y.i:;~~~~t~~!~;y'?:.:.:~.:,:;Ip.~aHQ~:.::.:dqif.i~i~;:i;:.:~1 
inserted at the location, 
and the old column or 

Example 

Cells A 1, A2, 81, and 82 have the following formulas: 

A B 
iAl+l= i 

1 231 241 Ai:;: .. i;; .... · ...... ·rA'2+i~ ............ 1 

2 ......................... ?~.L ...................... ?~.l 
If you copy A 1 and A2 to C 1 and C2 with Paste, the cells 
have the following formulas after the copy: 

ABC 

1 iAl+l= i ! 
231 24! 23! 

2 ·Ai:;:'i~· ...... · .... r'A'2+i~ .... · .... ··Tci+i;;; .......... 1 
241 25! 241 

•• " ............................ : .......................... ' ..... 6 ............................... .! 



To copy cells with paste adjusting 

~ Select the cells that you want to copy. 

~ Choose Copy from the 
Edit menu. 

Paste 
Paste Adjusting ... 
Paste Values 

~ Select the new location for the cells. 

~ Choose Paste Adjusting from the Edit menu. A dialog 
box appears. 

~ In the dialog box, check 
the box above any 
coordinates that you 
want to be the same 
instead of relative, until 
the formula shown for 
the sample cell is 
correct. 

~ If you are copying more 
than one cell, click Next 
to go on to the next cell 
or Previous to go back to 
the previous cell. 

Same 

Formula: ~+1 
I 
Relative 

[preViOUS] 

[ Next] 

Edit 

Copy Cells with 
Paste Adjusting 
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~ When all the [ OK ] coordinates are 
adjusted correctly, click 
OK to complete the 
operation. 

~ To cancei the paste, [ [ancel J cl ick Cancel. 

The combinations that are possible with Paste Adjusting 
are the same as those for Paste. See the Copy Cells with 
Paste procedure, under Edit, in this chapter. 

When you copy a cell with Paste Adjusting, the entire 
cell, including its alignment, number style, protection, 
value, and formula, is copied. Paste Adjusting differs 
from Paste and Paste Values in that it allows you to 
systematically adjust formulas in the range you are 
copying to. 

The dialog box shows you what the formula would be for 
a sample cell from the range you are copying to. Check 
boxes are shown above and below each coordinate. To 
indicate that a coordinate is to be the same, you check 
the box above the coordinate. To indicate that it is to be 
relative, you check the box below the coordinate (or 
leave it checked). When you check a box, the sample 
formula in the dialog box changes automatically. 

If a cell range such as A 1:85 occurs in the formula, only 
one check box appears over the range. The whole range 
must be relative or the same. 



Initially, all the coordinates are shown as relative. That is, 
the position of each coordinate relative to the sample cell 
is the same as the position of the corresponding 
coordinate in the original formula relative to the original 
cell. If you change a coordinate to be the same, then it is 
replaced by the corresponding coordinate from the 
original cell. 

The sample cell stands for all the cells in the range you 
are copying to. For each coordinate in its formula, 
whichever choice you make applies to all the cells in the 
range you are copying to. 

Example 

1. Suppose the formula in 
82 is A2+C2, and you 1 
copy this cell, using 2 
Paste Adjusting, to the 3 
range 84:86. Suppose 4 
further that you want the 5 
first coordinate in each 6 
formula to be relative, 
and the second to stay 
the same. 

2. The sample cell in the 
dialog box is 84. In order 
to find the relative 
coordinates for 84, 
LisaCalc interprets the 
formula as saying "add 
the cell to the left of 84 
and the cell to the right 
of 84." This translates 
into the formula A4+C4, 
which is shown in the 
dialog box. 

[ell: 84 

Same 
o 0 

Formula: A4+C4 
I I 
Relative 

Edit 

Copy Cells with 
Paste Adjusting 
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3. Since you have decided 
you want the second 
coordinate to stay the 
same, you click the box 
above C4 and it changes 
to C2. 

4. After you click OK, a 
similar formula is copied 
to every cell in the range 
A4:A6. 

(ell: B4 

Same 
o I 

Formula: A4+C2 

A 

I 0 
Relative 

1 .............................. 1... ............................ 1 ............................ ...! 
iA2+C2= i i 2 12: 46: 34: 

·~· ... ~.::~.:·=~:·.·.:~ .. ~:~r~:::~:~:~.:~.·.:~::~.I.:~.:~::~ .. ::: ...... : .. :: .... J 
131 A4

+C2=47i I 

==4:~~=~ 
6 lSi 49i i 

................................ : ........... ,,, .................. 6 ...................... " ........ : 

You can copy from a range of cells rather than from a 
single cell. Since each cell in the range can have a 
different formula, you need to adjust the coordinates for 
each cell separately. For each cell in the range you are 
copying from, LisaCalc finds a sample cell in the range 
you are copying to. The formulas for these sample cells 
are displayed in the dialog box one at a time, starting at 
the beginning of the range and proceeding toward the 
end of the range. To move forward in the range, click 
Next. To move backward in the range, click Previous. 

When you are satisfied that all the sample cells in the 
range have the correct formula, click OK. If you have not 
made any changes to a particular cell, all the coordinates 
in its formula will be relative. 



Example 

1. Suppose you want to copy from the range A 1 :A3 to the 
range C 1: E3. That is, you want to copy A 1 to C 1, D 1 
and E1; A2 to C2, D2, and E2; and A3 to C3, D3, 
and E3. 

2. You select A 1 :A3 and choose Copy, then you select 
C1 :E3 and choose Paste Adjusting. The dialog box 
shows the formula for C 1, which is the sample cell for 
A 1. Whatever adjustments are made to this cell will 
also be made to D1 and E1. 
Cell: Cl I 

Same 
o 

Formula: C7*6 
I 
Relative 

3. When the formula for C 1 is correct, you click Next and 
the dialog box changes to show the formula for C2, 
which is the sample cell for A2. 

[ell: [2 I [previous) ~ ~ 
~ Cancel 

Same 
o 

Formula: C1+12 
I 
Relative 

4. When you finish making adjustments to the formula, 
you can click Next to go on to the sample cell for A3. 
Or, if you want to see the sample cell for A 1 again, you 
can click Previous to go back. When all the formulas 
are correct, you click OK. 

Edit 

Copy Cells with 
Paste Adjusting 
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If the range of cells you are copying to includes cells that 
are in neither the same row nor the same column as the 
original cell, you can separate the row and the column in 
the dialog box. That is, you can have the row stay the 
same and the column be relative, or vice versa. 

Example 

Suppose you want to create a multiplication table. To 
start with, you have a spreadsheet in which 81 through 
H 1 contain the numbers from 1 to 7. The same numbers 
are in A2 through A8: 

ABC 0 E F G H 

To make this spreadsheet into a multiplication table, 
here's what you do: 

1. In 82, enter the formula 

A2*B1 

Now you want to copy B2 to the range B2:H8. When 
you do this, you want to adjust the formula so that 
each cell contains the product of two numbers: the 
number all the way to the left of the same row, and the 
number at the top of the same column. For example, 
you want the formula in C3 to be A3*C1. 



2. Choose Paste Adjusting from the Edit menu. A dialog 
box appears, showing the sample formula for C3, 
which is now shown as 83*C2. 

[ell: [3 

Same 
DO DO 

Formula: B3*C2 
1111 
Relative 

3. In the dialog box, click 
the box over the 8 and 
the box over the 2. When 
you finish, the formula 
should be A3*C1. 

[ell: [3 

Same 
10 01 

Formula: A3*Cl 
01 10 
Relative 

4. Click OK. The rest of the cells fill in automatically. 

Edit 

Copy Cells with 
Paste Adjusting 

(continued) 
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To copy text within the same spreadsheet 

~ Select the text that you want to copy. 

~ Choose Copy from the 
Edit menu. 

Paste 
Paste Adjusting ... 
Paste Values 

~ Select the new location for the text. 

~ Choose Paste from the Edit menu. 



To copy text to another spreadsheet 

~ Select the text that you want to copy. 

~ Choose Copy from the 
Edit menu. 

Paste 
Paste Adjusting ... 
Paste Values 

~ Get or activate the document that you want 
to copy to. 

~ Select the new location for the text. 

~ Choose Paste from the Edit menu. 

Text is any sequence of letters, numbers, and 
punctuation symbols. You can copy text from a cell or 
from the status panel. When you copy text, a duplicate is 
put on the Clipboard. When you paste, you are pasting a 
copy from the Clipboard; a copy remains on the 
Clipboard so you can paste it again. 

To copy text from a cell, first you select the cell, and then 
you select the text you want to copy. 

You can immediately reverse either the copy or the paste 
operation by choosing Undo Last Change from the Edit 
menu. To copy a cell, see the Copy Cells with Paste 
procedure, under Edit, in this chapter. 

Edit 

Copy Text 
(continued) 
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It is not recommended that you cut cells, except as the 
first step in a move; see the Move Cells procedure, under 
Edit, in this chapter. If you want to remove the contents 
of a cell or group of cells, use Clear Entries; see the Clear 
Entries procedure, under Edit, in this chapter. 

The reason why cutting cells is not recommended is that 
when you cut cells, they are removed from the 
spreadsheet and put on the Clipboard. If any other cells 
have formulas that reference the cells you have cut, 
these references are invalid as long as the cells are on 
the Clipboard. This could result in the values of these 
cells becoming Error. 

Example 

1. A 1 has the value 21 and 
81 has the formula 
A 1 + 1. Assume you want 
to change A 1 to 23. 

2. If you select A 1 and then 
choose Cut, A 1 is placed 
on the Clipboard, the 
space for A 1 in the 
spreadsheet is shown as 
blank, and the value of 
81 becomes Error. 

3. If you type 23 in A 1, 
81 is still shown as 
Error. There is no way 
to correct 81 without 
first pasting A 1 back into 
the spreadsheet or 
editing 81. 

A II B II 
!A1+1= 1 

1 21: 221 
- ......... " ................ " ...................... " ....... 00" ... : 

A II B II 
1 iError+ 1=1 

! Error! _ ................. , .............................................. .. 

A 

1 !Er-ror+ 1=1 
.... ''' .......... , ...... ?},l... ........ ~~~.Q~J 

The correct way to change the value of A 1 is to select A 1 
and enter the new value. If you want to remove the value 
from A 1, you select A 1 and choose Clear Entries. 



To cut rows or columns 

~ Select the rows or columns to be cut. 

~ Choose Cut from the 
Edit menu. Undo Last Change 

rles to!' e PI' e~/i (~tl:-; r:'flt:r~J 

(ut t_X ,. 

When you cut rows or columns, they are removed from 
the spreadsheet and placed on the Clipboard. The 
remaining rows and columns are reordered 
automatically. All formulas are updated to refer to the 
new row or column locations instead of the old locations. 
If a formula refers to a cell in a row or column that was 
cut, the formula now has the value Error. 

You can reverse the cut operation by choosing Undo Last 
Change from the Edit menu. 

Edit 

Cut Rows or 
Columns 
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In the following example, column B is cut; the 
spreadsheet shows the formulas before and after the cut. 

:------:--------:--------:--------=---------: 
..... . ........................ ·······························i· ···················f··· ·················I·~~t·rCii·;·f 

!Units ! 31300! 32500! 34100! 97900! 

::::·.·:··:.·:;p.I.I~.·~ :.·:.:.·:::~·.·~i~.2~~.~~:.~1~·8~~.~~.·~1~~~%].~.·~.:i.~ .. ~ .. ~.::.~j 
11 

12 

13 
........ ......... ;R.~~.~.~.~.~ .... : ..... nJ.4.§.Q.9.~.136 5000 1 J.4}.??..~ .•. ~.~~.;,n§QQ .. 

Before 

1 
2 
3 .. 
5 
6 

7 

8 

10 

11 

12 

13 

After 

A 

", ... ;"".,~" •• , .. ~., .. " .... M~ .... "" ....... " ......... """i" ....... ,.. ,,, ...... ,,................ ..~"., ... "' .... .. 
,,, ... ,, ....... t .......... ·.··· ...... ·· .... i ... ·.· ... _ ... " .. ,," ''' .................... "."" ...... 1" ................................. ,[, ..................... ,', .... ; 
........ · .... i ...... ·· ............. ,......................+ .................. · .. ·iTst Quart:·· .. ·......... .• 
. .. : .. : ..... ·:.: .. IJ..~~· .. : ... : ..... : .... : .. Jf .. ~:~ ... :::::.: ::::::;@..~:.::..... · .. ······t .. ···· .... · .... ·· .. ·· .. ·· .. ·· .. ····rAQr· ................ . 

l~!!~!~~~~~;::l 
i.:-,:,:,:,:.:.:.:-~:~-----:-------: ---------:-----:.:.:::~ ............ · .... ··Ts·um'{§TL'[:i!· ............ ··· 

i11):. . 
i 31300i 32500 i 34100i 97900i 55700i 

:={it}8~?~~~f;~~A~t~~jii!~~=~~~~%l 
i 13146001 .. 1J.~.~.9..9..9. .• ! .. H2.??QQ.! .... .4..1. .. g.~ ...... nI~4QQ.: .. , ........... ,!, ....... , ....... "" ..... " .. ,": 



To cut text 

~ Select the text to be removed. 

~ Choose Cut from the 
Edit menu. Undo Last Change 

Hesto!'t!: P!'evio(!s r:'nt:r~J 

[ut _x 

Text is any sequence of letters, numbers, and 
punctuation symbols. You can cut text from a cell or from 
the status panel. 

To cut text from a cell, first you select the cell, and then 
you select the text you want to cut. 

Text that has been cut is removed from the spreadsheet 
and placed on the Clipboard. When you cut part of a 
cell's value, the value isn't changed until you press the 
(Enter) key or select another cell. 

You can immediately reverse the cut operation by 
choosing Undo Last Change from the Edit menu. In 
addition, you can paste the text that you cut into the 
same spreadsheet or into another spreadsheet. See the 
Move Text procedure, under Edit, in this chapter. 

Edit 

Cut Text 
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To enter a value in a cell 

~ Seiect the cell. 

~ Type the value. 

~ Press the (Enter) key or 
seiect another cei i. 

A cell is either blank, or it contains a value. A value can 
be either a number, a label, a date, or a date part. If you 
select a cell that contains a value and you enter a new 
value, the old value is replaced by the new one, unless 
the cell is protected. 

When a single cell is selected, its full value is shown in the 
Value area. In the display of the selected cell in the 
spreadsheet view, as many characters in the leftmost 
part of the value are shown as will fit in the cell. You can 
edit the value in either place, with identical results. 

In some cases, if the value is too long to be displayed in 
the Value area, you can see the whole value by widening 
the column the value is in. This can only happen with 
labels. 

The display of the value in the Value area is in floating 
decimal number style, except that no value is ever shown 
as a string of asterisks. Essentially, what this means is: 

• If the value is equal to a whole number, it is shown 
without any decimal places. That is, if you enter 2.000, 
it is shown as 2 in the Value area. 



• If the number has decimal places, the number that is 
displayed may not be equal to the number you entered. 
For example, 123.454 might be shown as 
123.45399999999999. This is because it is not always 
possible to store a decimal value exactly. Generally 
speaking, the slight difference in value does not affect 
calculations in the spreadsheet . 

• The Value area cannot show more than 23 characters, 
including the sign and the decimal point, if any. Of 
these 23, no more than 15 can be after the decimal 
point. If the value is too large to be shown in this many 
characters, it is shown in scientific number style. See 
the Number Style procedure, under Format, in this 
chapter. 

After the value has been entered, its type is indicated in 
the Value area by one of the following words: 

Blank 
Number 
Date 
Date Part 
Text 

Logical values are considered numbers, as are all special 
constants except Date, which is today's date. 

The word indicating the type of the value also tells you, in 
some cases, if you have mistyped a value. For example, if 
you type "1983" with the letter L instead of "1983" with 
the digit 1, the Value area says Text rather than Number. 

For inserting text into a cell value, see the Insert Text 
procedure, under Edit, in this chapter. For replacing text 
in a cell, see the Replace Text procedure, under Edit, in 
this chapter. 

Edit 

Enter Value 
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To insert blank rows or columns 

~ Select the grid handle where you want the new 
columns or rows to be. 

~ Choose Insert Blank 
Row or Insert B!ank 
Column from the Edit 
menu once for each row 
or column you want. 

~ .. _. 
unDo LIlH Lnllnge 

When you insert a blank row or column, the other 
columns or rows in the spreadsheet are reordered 
automatically. All formulas in the spreadsheet are 
updated to refer to the new names of the rows or 
columns. 

You may immediately reverse this operation by choosing 
Undo Last Change from the Edit menu. 



The following example shows a spreadsheet before and 
after a blank column has been inserted between columns 
Band C. 

1 
2 
3 
4 
5 
6 

7 

8 

9 

A 

•• "M .. N ........ _ •••••••••• j .............. + .......... - ... ~ .. ~ ...... -.. -.. -...... - ................... " .. + 

, ... " .. ''' .. ,;' "', .. " .. , •. ,',." ....... "',, .. , .. , .... L ............................ ,.l ......................... ,"...... ........ . ...... L." ...... , ........ " ......... j 
,., .. " .. , .... ~ ..... ".l ...................... " ........ l ................................ L.................... j ~ j 

:.: ... : ... ~.: ..... ;:.: ............ " .. ·" .. ·l5an""··:::.:·.:I~b.~" ,,·.·:··:·:::JB·~·":,,"·:.·.:,,:·::,,:·::~~··~::~ .. ~·~:~·~f.~:~i. .. =.':~=~,,] 
." .... ""--" ... ,._ .. ""........ ·"····i·,,·······,,··,,,,·· .... " ... "."" .• " ..... " ..... "." .. " "'''i's~(Cf'E7''''''''''''''''-'''''-

iUnits i 440001 45600i 479001) 137500i 493001 
",,:::~.::::.·:.:·~.:·.:·TP.iI£~, ::.:·::.~$.IIQ:.:QQ::~lU.9.:~:.9..9..·~J~I!Q::·,Q~L:.T.::.::::~ .. ~:.::.·.::.:.:.·:::::~:~.Ii.Q·jgi:.·: .. l 

iC7*C8= i07*08= iE7*E8= i SI.l1l (C9: E9iG7*G8= i 
1 i 1 i )= i i 

1Revenue 1 48400001 50160001 52690001 15125000i 54230001 

10 ."" ... ".--,,=J:===:=.:F:::::::::::::'E::::.::.:r=;':::::}~~1~~.~~.~.::::::~::.:::::::::'1 
11 

iUnits : 31300: 32500: 341001
11

) =97900: 55700: 

: ---J:Piliiliit~~~~}~~;~~~;~~~tA~ 
.... _ ....... """." ........ ~8.~~.~~.lJ..~. :" ... ~.~ .. ~.4.~.Q.9.;""~.~.~.~Q9.Q.: ... ..!.4..3..~.~.QQ.;." ... ~J~J.~QQ; .... ~.??..~Q9.; 

Before 

1 
2 
3 
4 
5 
6 

7 

8 

A 

..... , .... , ..•. , ...... ............... ! .. " ............... _ .. H • ··· .. "" .... ·,,,···· .. ·_···t 
"M ." ... , ....... ? .............................. " .. + "" ... ,,, ... ,,: .... ,, ......... ",, ........... " ""M .. M ...... H •• "."~ .. " .. : 

...... +..... .. ........... i....· ..................................................... ::: ... :.:t ....................... ,: .. :,jI.~f.~.9.~·.~tl 
............ ::;: .. ::~.:...... .. :: .. ::: ... J.~.6·::·· · .. · .. · .. ·Jt~·~."' ................ ;~.~........... . ........................... ; 

~;~i-~-:-- .. :i]~lJl;~~~I0~;f:~~~~ 
, , 07*08= 1E7*E8= iF7*F8= isum(09 :r9i 

9 .• R!l:-'.~nue I 4840000i 50160001 5269COOP ~51250001 
10 ... " ... " ........... " ........ :.:.:.:.---.:.:; ............. =::.:.:.:.:.:;·:·:·=.::~::~==::===~=F:::::·~::~·:1 

~ ____ :::~~ll~ .. _:_-:::~:::~.-_-~t~}i~:~_-i~f~~ 
13 j8~e~~1 ______ ~~::':;~~~~~:;,]~~:~ 
After 
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To insert text 

~ Position the pointer where you want to add text and 
click the mouse button to set the insertion point. 

~ Type the text. 

Text is any sequence of letters, numbers, and 
punctuation symbols. You can insert text into a cell or 
the status panel. 

To insert text in a cell, first you select the cell, and then 
you set an insertion point where you want to insert the 
text. 

The blinking vertical bar, called the insertion point, 
shows where the next typed character will go. 

When you insert text into a cell value, the change isn't 
entered until you press the (Enter) key or select another 
cell. 



To move one or more cells within the same spreadsheet 

~ Select the cells you want to move. 

~ Choose Cut from the 
Edit menu. 

Cut L..X 

~ Select the new location for the cells. 

~ Choose Paste from the Edit menu. 

To move one or more cells to another spreadsheet 

~ Select the cells you want to move. 

~ Choose Cut from the 
Edit menu. Undo last Change 

Hesh.ne Previm!:; Ff~tq} 

Cut r...X 

~ Get or activate the spreadsheet that you want to 
move the cells to. 

~ Select the new location. 

~ Choose Paste from the Edit menu. 

Edit 

Move Cells 
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When you cut cells, they are removed from the 
spreadsheet and put on the Clipboard. If any other cells 
have formulas that reference the cells you have cut, 
these references are invalid as long as the cells are on 
the Clipboard. This results in the values of these cells 
becoming Errof. Thereiore, whenever you cut ceiis to 
start a move, you should paste them back to the 
spreadsheet as soon as possible. 

When you paste, you are pasting a copy of the cells from 
the Clipboard; a copy remains on the Clipboard so you 
can paste again. Any cells that reference the cells you 
have moved are automatically adjusted to reflect their 
new location. See example below. 

You can immediately reverse either the cut or the paste 
operation by choosing Undo Last Change from the Edit 
menu. You cannot reverse the whole move. 

When you move cells, the following combinations are 
possible: 

A single cell can be moved 
to another cell. 

A Single cell can be moved 
to a range of cells. The 
range can be any size or 
shape. 

ABC 

21.951 ~ 1 

;~;l~-~§i~H~~ 
".".""""".""""."""L"" .. " .. ?1.: .. 2.~.L. .. " .. "fJ .. :.~~.\ 



A range of cells can be A B 
moved to another range of 1 
cells with the same size and 2 
shape. 3 

4 "::"~~l1!;:~~~;lj~iJ 
A range of cells can be 
moved to a larger range if 
the new range is an exact 
multiple of the size and 
shape of the old range. 

A range of cells can be 
moved to a single cell. In 
this case, the single cell 
becomes the upper-left 
corner of a range the same 
size and shape as the range 
that was moved. 

A column or row can be 
moved to another column 
or row. 

5 
6 

1 
2 
3 
4 
5 
6 
7 

................................ L .......... ~ .. t .. ~.~.L ............. ~ .. : .. ~.?: 

A II B II C 

.L. ............ §9..: .. !.~.L. ......... ~.~ .. : .. ?J.: ................ ~ .. : .. ~.~.; 
2 21. 95~ 14. 56! 18.27: 3 ............................ · .. ( ...... · ........ l .... ·'1' .. · ...... · .. ·· .... ·· .... : 

.t- ............ ®. .. J.?.' ....... }} .. J .. L ......... 2.92 
5 21.95' 14.561 18.27 
6 : : 

A 

1 .~.n.'?n. ........... ; ............................... :.0.f..~.9D ........... ; 
2 ~.;I.~.Q ............ : ................................ l~J.rg,.o ............. :. 
3 .~:.~§~y ........... L .............................. I~~.~:¥. ...... "..i 
4 p..9.pe.~ .. ~:i ... .: ........ .lp..9.P.PJ.~i .... : 
5 Erin: Erin: 
6 I.~.·.~.9.~·.f.~:.f······ ··.·.·.··.·.·.·.·.· ..... ·.··.II~.9.~.i~.f.r 

i~~~T:":".J~{~ltj 
~~ .J..~.9.M.9.D. .. )........ . ............... t.:.~ ........ a.i ..... c.n ...... ci .. ~ ....... o.~ ... : .. ~ ..........•. t~.~.tJ.9.~.~.Y. .... L................... ... < .. 
12 L8!i!SOtI . [Lawson : 

~~ ~~~t~~l~~~~~ 
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A col u m n or row can be !--+-.....:A~oo\I-...;;..-'I---.;::.-+-...;;..-Ij 

~:~~;~~~~!e~;o~~~dl~: A 4 ~~~~~~~~~~~~~~1 
an d the old colu m n or row =5---l .......... " .................... , .............................. : ............................... , ............................. : 
: ___ •• _..J .. _ : .. 

I~ IIIUVt::U LU Il. 

Example 

Suppose cells A 1, A2, and 
B 1 have the formulas as 
shown. 

If you move A 1 and A2 to 
C1 and C2, the cells will 
have the formulas as 
shown. 

A II B 
1 82+1= jA2+1= 

100i 102 
~ ............................................................... .. 
2 Al+l= 1 

'--- ................... JQ,~,L ....... , ....... "' .... ~.~, 

A II Bile II 
1C2+ 1= 182+ 1= 1 

1 1 1021 1001 _." ............................ , ................................. : ................................ . 
1 1Cl+l= 1 

2 1 991 lOll _ ......................... " ..... : .................................................................. : 



To move rows or columns 

~ Select the rows or columns that you want to move. 

~ Choose Cut from the 
Edit menu. Undo Last Change 

f:~estore Previ(J~~;; r'nt.'q,l 

Cut r.. WX 

~ Select the new location for the rows or columns. 

~ Choose Paste or Paste Values from the Edit menu. 

When you move rows or columns, it is essential that you 
paste them as soon as possible after you cut them. It's all 
right to scroll the spreadsheet or change the format of 
cells, but you shouldn't do anything that changes the 
contents of the spreadsheet. The reason can be seen 
from the following sequence of steps: 

1. Suppose you want to 
move column A to be to 
the right of column C. 

1 

2 

3 

4 

5 

• M For 

Edit 
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2. First, you cut column A. 
When you do this, 
LisaCalc renames all the 
columns so that old 
column B becomes new 
__ 1 •• __ A _I..J __ I •• __ " 
\lUIUIIIII 1""\, UIU \lUIUIIIII v 

becomes new column B, 
and so forth. Any 
formulas that reference 
cells in the column you 
cut are set to Error. 

3. The place where you 
want to paste the 
column, which used to 
be the grid handle 
between columns C and 
0, has now become the 
grid handle between 
columns Band C. You 
should immediately 
paste the column there. 
When you do so, the 
cells that were set to 
Error in step 2 are reset 
to reflect the changed 
coordinates in the new 
column. 

1 

2 

3 

4 

5 

1 

2 

3 

A 
Cl+lO= iii 

20! 15! lO! cz·:;::s2';;;'· ..... T .. · .... ····· ......... · ...... "!' .. · .. · ......................... r 
55! 251 30! 

.. • .. · .......... · .. · ............ : ............ ·· .................. t ...... ·· ........................ : 

83+10= iii 
45! 35! 251 

~.~.~~.~.~.~.~r~ .. ~ .. ~ .. ~ .. ~ .. ~ .. ~ .. ~l'.~·~·.~.~·i..~.~·.~I 
sum( Ai: A:sum (Bl :Bisum(Cl :C1 
3)= :3): 13)= : 
................... J.?.9..l... ................... ..?..~.L ...................... §.~.l 

4. Between the cut and the paste, you should not 
perform any operations that affect the contents of the 
spreadsheet. In particular, you should not cut or insert 
any rows or columns, or edit any formulas. If you do 
so, you will see an alert message that gives you the 
opportunity to change your mind. If you continue, you 
might leave the spreadsheet in an ambiguous 
condition. 



To move text within the same spreadsheet 

~ Select the text that you want to move. 

~ Choose Cut from the 
Edit menu. Undo last Change 

Cut t,. teX 

~ Select the new location for the text. 

~ Choose Paste from the Edit menu. 

To move text to another spreadsheet 

~ Select the text that you want to move. 

~ Choose Cut from the 
Edit menu. 

Cut . teX 

~ Get or activate the spreadsheet that you want 
to copy to. 

~ Select the new location for the text. 

~ Choose Paste from the Edit menu. 

Edit 

Move Text 
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Text is any sequence of letters, numbers, and 
punctuation symbols. You can move text from a cell or 
from the status panel. 

To move text from a cell, first you select the cell, and then 
you select the text you want to move. 

When you cut text from the spreadsheet, it is placed on 
the Clipboard. When you paste, you are pasting a copy of 
the text from the Clipboard; a copy remains on the 
Clipboard so you can paste it again. 

You can immediately reverse either the cut or the paste 
operation by choosing Undo Last Change from the Edit 
menu. To move a cell, see the Move Cells procedure, 
under Edit, in this chapter. 



To replace text 

~ Select the text to be replaced. 

~ Type the new text. 

~ Press the (Enter) key or 
select another cell. 

Text is any sequence of letters, numbers, and 
punctuation symbols. You can cut text from a cell or from 
the status panel. 

10 replace text in a cell, first you select the cell, and then 
you select the text you want to replace. 

You can reverse the replacement by choOSing Undo Last 
Change from the Edit menu. 

Edit 

Replace Text 
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To restore the previous entry in the cell that you are 
editing 

~ Choose Restore 
Previous Entry from the 
Edit menu. 

Restore Previous Entry is available only while you are 
editing a cell. It cancels all changes made to that cell 
since it was selected. As soon as you select another cell, 
press the (Enter) key, or clear the cell, this item is 
unavailable. 

Example 

Suppose you select a cell, and then you 

1. Insert some text. 

2. Cut some text. 

3. Add more text. 

4. Choose Restore Previous Entry. 

All changes to the cell are reversed. The value the cell 
started with is restored, because you didn't enter the 
new value. 



To undo all changes made to a spreadsheet since it was 
last saved 

~ Choose Revert to 
Previous Version from 
the File/Print menu. 

Set Aside Everything 
Set Aside "84 Budget" 

Save [, Put Away 
Save [, Continue 

~ Click OK in the alert box that appears. 

This operation restores the document to the condition it 
was in when you last saved it. This menu item is always 
available and applies only to the active document. 

Edit 

Revert to 
Previous Version 
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To reverse the effect of the last change 

~ Choose Undo Last 
Change from the Edit 
menu. 

Operations that you can undo include Cut, Copy, Paste, 
Clear Entry, changing column widths, inserting a blank 
row or column, formatting a cell, typing a character, 
setting or removing page breaks, and type style changes. 

Operations that you cannot undo include entering a value 
or formula in a cell, printing, saving a file, Restore 
Previous Entry, and changing the selection. 

If an operation cannot be undone, a message appears 
telling you that LisaCalc cannot undo the last change. 



C76 Alignment 
C78 Column Widths 
C80 N umber Style 
C84 Printing Type Style 
C86 Screen Type Size 
C87 Show Formulas and Show Values 

Format 
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Alignment 
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To change the way values are aligned in cells 

~ Select the cells. 

~ Choose an alignment 
option from the Format 
menu. 

f¥Words left/Nos. Right 
left Fillsh 
Center 
Right Filish 
Fi II Pattern 

........ """"."""."" .. """"""." ... """." ..... " .. "."":;;:,;.""".""" .. """ 
~ - -

Alignment refers to the way values are lined up in cells. 

The cells you align can be blank when you align them; the 
alignment option takes effect as soon as you enter a 
value. If you don't choose an alignment option, the 
option in effect is Words Left/Nos. Right. When a single 
cell is selected, its value is shown with Words Left/Nos. 
Right to facilitate editing, regardless of the alignment 
option in effect. 

Alignment does not affect numbers in cells with a 
monetary number style. 



With fill pattern alignment, the value is repeated as many 
times as necessary to fill the cell. If the width of the cell 
changes, the number of repetitions of the value changes 
to match. 

If you want to see what alignment is in effect in a selected 
cell, just look at the Format menu; there is a check mark 
next to the option in effect. 

Here's how the value 123 looks in a cell whose column 
width is 8, with different alignment options: 

A B 

Format 

Alignment 
(continued) 
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Column Widths 
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To change the width of one column 

~ Position the pointer in 
the grid handle on the 1 
right side of the column. 2 

mouse button while 
moving the pointer and 
flickering boundary to 
the left or right. 

~ Release the mouse 
button when the 
flickering outline shows 
the column width you 
want. 

A B 

To change the width of several columns at once 

~ Select the columns. 

~ Choose Column Widths 
from the Page Layout 
menu. 

Im",T(: p(Jqt.: M(lti<. 
Remove Page Marks 

~ When the dialog box appears showing the number of 
characters the cells can display, type the number you 
want. 

~ Click OK. 

The maximum width of a column is 80 characters. 



Example 

Changing the column widths of columns C, D, and E from 
8 to 12: 

B ~ C 0 E 

Format 

Column Widths 
(continued) 
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Number Style 
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To change the number style of one or more cells 

~ Select the cells. 

~ Choose a number style 
from the Format menu. ~.iIIl IIII~L======_~ __ ""1!11 

----
Floating Decimal 
No Decimal 
Fixed Decimal 
Scientific •.. 

$1,234.56 
1,234. ~6 

$ 1234.56 
1234.56 

v'$1,235 
1,235 

$ 1235 
1235 

-

A number in a cell can be displayed in any of several 
styles, depending on the number style chosen and the 
size of the cell. For example, you can display the value 
498 as either 498.0 or $498.00 or 4.98E + 2, etc. In a new 
spreadsheet, all cells have the floating decimal number 
style. 

Some number styles require LisaCalc to display a 
rounded value. In this case, the value in the cell is not 
changed, only the way it is displayed. If the last digit 
removed is 5, the number is rounded so that the 
preceding digit is even. 



Zero is shown as 0.0, regardless of the number style. 

The number styles are: 

Floating Decimal 

No Decimal 

Fixed Decimal 

Monetary style 

Shows numbers in the most 
convenient style for the size 
of the value and the width of 
the column. The number 
might be shown in the no 
decimal, fixed decimal, or 
scientific number style. 

Shows numbers rounded to 
the nearest whole number 
value. 

Shows numbers as values 
with a fixed number of 
decimal places. When you 
choose this menu item, a 
dialog box appears 
allowing you to set the 
number of digits to the right 
of the decimal point. 

Shows numbers in any of 
the following monetary 
styles: 

Dollar sign, commas, cents 
($1,234.56) 

Format 

Number Style 
(continued) 
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Number Style 
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Scientific 

Commas, cents (1,234.56) 

Dollar sign, cents 
($1234.56) 

Cents (1234.56) 

Dollar sign, commas 
($1,235) 

Commas (1,235) 

Dollar sign ($1235) 

Numbers only (1235) 

Numbers are shown with 
right flush alignment. 
Negative numbers are 
shown surrounded by 
parentheses. Positive 
numbers are shown with a 
space to the right. 

Shows numbers with 
scientific notation and a 
fixed number of decimal 
places. When you choose 
this menu item, a dialog 
box appears allowing you 
to set the number of digits 
to the right of the decimal 
point. There is always 
exactly one digit to the left 
of the decimal pOint. 

In scientific notation, a number looks like this: 

1.234E+5 



This is the same as the formula 

1.234 * 10 (+5) 

or 123,400. 

A positive number after the E means the decimal point in 
the number to the left of the E is to be moved to the right 
that many places. A negative number after the E means 
the decimal point in the number to the left of the E is to 
be moved to the left that many places. 

If you want to see what number style is in effect in a 
selected cell, just look at the Format menu; there is a 
check mark next to the option in effect. 

Example 

To give you an idea of how a cell's number style affects 
the way its value is displayed, the value 987.654321 is 
shown below as it would appear in a cell that is eight 
characters wide. 

Number Style 

Floating Decimal 

No Decimal 

Fixed Decimal (1) 

Scientific (3) 

$ 1234.56 

Value Displayed 

987.6543 

988 

987.7 

9.877E+2 

$987.65 

Fortnat 

Number Style 
(continued) 
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Printing 
Type Style 
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To change the printing typeface of a spreadsheet 

~ Choose a font from the 
Type Style menu. 

1-

15 Pitch Gothic 
12 Pitch Modern 
12 Pitch EI ite 
10 Pitch Modern 

..,110 Pitch Courier 

Show Actual Size ': 
Show Small Type 

..,IShow Medium Type 
Show Large Type 

A character set of a particular size and typeface is called 
a font. LisaCalc provides a number of different printing 
fonts. The whole spreadsheet must be the same font. 

Size, or pitch, refers to the number of characters printed 
per inch; 15 pitch prints 15 characters per inch and so 
on. The "face" is the portion of the character that 
displays and prints. 

Names like Modern and Gothic refer to the kind of type 
face. For instance, Modern is a sans serif face; there are 
no serifs, or "feet," on the characters; Gothic is a serif 
face, one with "feet." 

Changing the printing font might change the location of 
the default page marks. 



Example 
ThlS lS 15 PltCh GothlC 

This is 12 pitch Modern 

This is 12 pitch Elite 
This is 10 pitch Modern 

This is 10 pitch Courier 

Format 

Printing 
Type Style 

(continued) 
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Screen 
Type Size 
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To change the type size shown on the screen 

.. Choose a screen type 
size for the spreadsheet 
from the Type Style 
menu. 

~ 
~ 
~now ~mall I ype 

.,fShow Medium Type 
Show large Type 

The spreadsheet may be displayed on the screen in 
small, medium, or large type, regardless of the size used 
for printing. For instance, choose Show Small Size, 15 
characters per inch, to check the table's appearance or 
Show Large Size, 10 characters per inch, to read and edit 
values easily. Show Actual Size shows the size of type in 
which the table will print. 

Changing the size of the screen display does not affect 
the location of the default page marks. 

Example 

Here are the various sizes when the type style is 12 Pitch 
Modern: 

This is Large Type 

This is Medium T~7pe 

ThIS IS SMall Type 

This is Actual Size 



To show formulas and values in the spreadsheet 

~ Choose Show Formulas 
& Values from the 
Calculate menu. 

To show only values in the spreadsheet 

~ Choose Show Values Only from the Calculate menu. 

When you have chosen Show Formulas & Values, you 
cannot change the contents of the spreadsheet. 
However, you can scroll the spreadsheet in any direction, 
change the width of columns, print the spreadsheet, or 
file it. 

Format 

Show Formulas 
and Show Values 
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Show Formulas 
and Show Values 
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Here are two displays of the same spreadsheet: 

B I 
............... ,,, .. ,,, .............. ? ..... . 

Show Values Only 

E 

........ " ......... ! 

:Units 44(0)' 45600' 47900 
'Price ... it . ····fi6 .00$ ······110:00$ .... ···1 10 :06: 

[-Ie :,= [-.[:= E-'E:= 

F=e .:.nlJe '-1:4 11 ~ ~~, ~:t:111 

------:-.::~-----------:::-j-:-.:.:.-::.:.:.:.:::--:-.-:-:~:~~--------~ 

Units 31300 32500'}~)9.9.: 
!pij~~ ·······tf···4foo~··4foO·$· 42.00: 

.. rti1*C 12=;Eii*Ei2~·· 

;8.~Y~n~~ .................... 1.2 .. 1..1~ •.. mm •• n.?~9.9.9 ............. 1.4}??.9.9.< 

Show Formulas & Values 



C90 Format for Specific Printers 
C95 Insert Page Marks 
C96 Print a Document 
C100 Remove Page Marks 

Print 
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Format for 
Specific Printers 

C90 ::: Section C 
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To format your document for a specific printer 

~ Choose Format for 
Printer from the File/ 
Print menu. 

Set Aside Everything 
Set Aside "Typical Lis[lCalc Spreadsheet" 

Print ... 
Monitor the Printer ... 

~ Check the type of printer that this document will 
print on. 

~ If you are using a dot matrix printer, check the 
orientation and resolution that you want to use for this 
document. 

~ If you are using a daisy wheel printer, check the paper 
size and print wheel style that you want to use for this 
document. 

~ Check the response you want the Lisa to make if no 
printer matches the settings you've picked. 

What do you want done 11' the pnnter 'y'ou've spec1fied 
does not appear to be connected to this machine? o Tell Me • Pick 1l,n Ave.ilable Printer for Me 0 Disre'J1lJd it 

~ Click OK. 

Printer format settings are stored with the spreadsheet, 
so that they are remembered even after the spreadsheet 
is put away. 



Settings in the Format for Printer Dialog Box 

The Format for Printer dialog box lets you check the kind 
of printer you want this document to print on, and then 
lets you specify some details on size of paper and type 
style. 

You can tell the Lisa to print your document on a dot 
matrix or daisy wheel printer. The items that follow Print 
Method in the dialog box change when you change your 
printer preference from dot matrix to daisy wheel, or 
back. 

Dot Matrix Printer Settings 

When you choose Dot Matrix printer in the Format for 
Printer dialog box, you see these additional choices: 

Format For Printer ... 
On y','hich printer do you intend to print tl,is cJocumet"lt7-' 

Print Method:. Dot Hatrix ODaisl,l ',\if"leel 
Paper Length:. 11" 0 14" . 

Orientation: • Portre.it (tell) D Landscape (',nde', 
Resolution: • Norme! 0 High 

Paper Length: With a dot matrix printer, you can print on 
11 or 14 inch paper. 

Orientation: This setting tells the Lisa whether to print 
your document horizontally or vertically on the paper in 
your printer. When the orientation is Portrait, the Lisa 
prints the text of your document across the 8-112 inch 
width of your paper, from left to right. When the 
orientation is Landscape, the Lisa treats the length of the 
paper (11 or 14 inches) as the width. In other words, it 
prints the spreadsheet sideways. 

Print 

Format for 
Specific Printers 
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Format for 
Specific Printers 
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Resolution: This tells the Lisa what quality you want the 
document to print with. Normal resolution gives you a 
standard character image. High resolution produces a 
much finer quality character image, but takes longer to 
print. 

When using landscape orientation and normal 
resolution, the font size of the text will be smaller when it 
is printed than it was on the screen. 

Daisy Wheel Printer Settings 

When you choose Daisy Wheel printer in the Format for 
Printer dialog box, you see these additional choices: 

Format For Printer ... 
On which printer clo ',IOU intend to print this document;' 

Print Method: 0 Dot. Hstrix • DaLy" Vil'leel 
Paper Size: IS.5x11" 0 11x85' 

08.5>:14" D14x8,5" D 14x11" 
Print Wheel: DGw'lC 15 .Elite 12 DColll'ier 10 DEl:ecutive PS 

o PS plus italics Dl0/12./P:3 0 10/12+Hclcln' 1 ,;i',5r8(,t.ers 

Paper Size: When you print with a daisy wheel printer, 
you have five choices for paper size: 8-1/2 x 11 inches; 11 
x 8-1/2 inches; 8-1/2 x 14 inches; 14 x 8-1/2 inches; and 
14 x 11 inches. 

Print Wheel: You have a range of choices in print wheels. 
The wheel that you choose determines what type style 
will be displayed on the screen if you have chosen Show 
Actual Size from the Type Style menu. It has no effect on 
the screen type style if you have chosen Show Small, 
Medium, or Large size. 



When Settings Don't Match a Printer 

In order for the Lisa to follow your instructions in the 
Format for Printer dialog box, two other factors must be 
true: Preferences must show that the type of printer with 
the settings you choose here is attached to the Lisa, and 
such a printer must be attached. 

Whenever you click OK in the Format for Printer dialog 
box, the Lisa checks the new setting. The Lisa then looks 
at the bottom line of the dialog box to see what you want 
done. 

Tell Me: When Tell Me is checked, the Lisa notifies you 
that no printer specified in Preferences meets the 
settings you have checked. An alert box appears, so that 
you can decide what you want to do next. Here is what it 
looks like: 

Intended Printer Unavai lab Ie! 
According to the Preferences \A!indow's list of Device Connectiom, the 
Intended Printer for this document is not connected to this machine. 

On which printer do you intend to print this document? 
o A printer that is not listed in Preferences right now. 
o Slot 2 Upper -- Dot Matrix -- 11" 
• Port A -- Daisv Wheel -- Gothic 15 -- l1x8.5" 
o Port B -- Daisy Wheel -- Gothic 15 -- l1x8.5" 

\Alhat do you want done if the printer ~Iou've specified 
does not appear to be connected to this machine? 

• Tell Me 0 Pick an Available Printer for Me 0 Disregard it 

Pick an Available Printer: When Pick an Available 
Printer is checked, the Lisa will choose an alternative 
printer if one doesn't match exactly the settings you 
requested. For instance, if you've specified a daisy wheel 
printer but only a dot matrix is attached and checked in 
Preferences, the Lisa formats your document for the dot 
matrix printer, rather than for a daisy wheel printer. 

Print 

Format for 
Specific Printers 

(continued) 

Chapter 2 C93 
Procedures 



Print 

Format for 
Specific Printers 
(continued) 

• • • LisaCalc Reference Guide 
C941 : : : Section C 

Disregard It: When Disregard It is checked, the Lisa 
notes the difference in printer settings and available 
printers, but doesn't do anything. This allows you to 
continue working with your document without being 
interrupted to make a decision about print formats now. 
You should check this box 'w"v'hen you intend to print the 
document on a different printer from the one that is 
connected to your Lisa now. 



Print 

To insert a page mark in your spreadsheet Insert Page Marks 
~ Select a grid handle between columns or rows where 

you want the page mark to be. 

~ Choose Insert Page 
Mark from the Page 
Layout menu. 

Page marks control where LisaCalc starts a new page 
while printing the spreadsheet. When you insert a page 
mark between two columns or rows, you instruct LisaCalc 
to print the second column or row at the beginning of a 
new page, regardless of how much information has been 
printed on the previous page. 

Wherever there is a page mark, it appears on the screen 
as a dashed line, instead of the solid line usually found 
between rows and columns. 

In addition to any page marks you have specified, 
LisaCalc also sets default page marks at calculated 
locations. These default page marks are designed to be 
one page apart; their location is determined by page size, 
type style, and other information specified in the Format 
for Printer dialog box. The default page marks are 
automatically adjusted whenever you make a change to 
the spreadsheet that affects the location of the page 
boundaries. You cannot insert or remove the default 
page marks. 

By inserting page marks, you can print as small a number 
of rows and columns on each page as you like, but you 
cannot increase the number of rows and columns beyond 
the number that will fit on one page. 

Chapter 2 ::: I C95 
Procedures ••• 



Print 

Print a Document To print a document 
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~ Make sure your printer is set up and connected to 
your Lisa. For assistance, see the manual that came 
with your printer . 

.... I' "",. h ... "", ... "'+ "" .. ",,,i,,,, ,.,.1" I!.'nol'ifiorl tho nr'intor'C! \/nll 
,...... II yVY IIQV'V IIV .. tJlvYIVU...:II1 ""1-',,",""'1.""''''' "11"'...,1 ••• ,,"'.""" ~ __ 

use in Preferences, do so now, and then start the Lisa 
again. For assistance, refer to Section D, Desktop 
Manager Reference Guide, in the Lisa Owner's Guide, 
under Set Printer Configuration. 

~ Get or activate the document. 

~ If you need to change 
any of the options in the 
Format for Printer dialog 
box for this document, 
choose Format for 
Printer from the File/ 
Print menu. 

Monitor the Printer ... 

~ Make any necessary changes in the Format for Printer 
dialog box that appears. 

~ Click OK. 

~ Choose Print from the 
File/Print menu. Set Aside Everything 

Set Aside "84 Budget" 



~ Make any necessary changes in the Print dialog box 
that appears. 

~ Click OK. 

Using the current printer settings and the formats you 
specified in the text, your document begins printing. 

For how to make changes in the Format for Printer dialog 
box, see the Format for Specific Printers procedure, 
under Print, in this chapter. 

If the printer settings and printer don't match, an alert 
box appears. Alert boxes resulting from a mismatch are 
discussed in the Format for Specific Printers procedure, 
under Print, in this chapter. 

Sometimes a dialog box titled Monitor the Printer will 
appear. See While You Work, later in this chapter, for 
information on this alert box. 

Print Dia/og Box Settings 

Print .. , • Finished Quality 0 Quick Draft l:rext Onl'i) 

D Dne COPI! ',vi-die You ',va.i\ • vJhile You 'iJork 
• All P8.1~e; DOniv , ....................................... , 

I'Jurnber of Copies aITJ0~0[I]0[I]0@] 

The Print dialog box lets you specify some final details 
about how your document will print. The choices in the 
Print dialog box are discussed below. 

Quality 

Finished Quality: Finished Quality prints your document 
as you have formatted it on the screen, including special 
type styles and fonts. 

Print 

Print a Document 
(continued) 
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Print 

Print a Document Quick Draft: Quick Draft lets you get a printed copy of 
(continued) the text faster, but without any special type styles and 

fonts used in your document. On a dot matrix printer, the 
built-in font is used for Quick Draft. On a daisy wheel 
printer, whatever print wheel is on the printer is used, 
even if you;ve specified a different one in your document. 

• • • LisaCalc Reference Guide 
e981 : : : Section C 

Speed 

While You Wait: You can have the Lisa use most of its 
attention to print your document while you wait. A 
document will print more quickly if you choose While You 
Wait, but you won't be able to use the Lisa for any other 
tasks. 

While You Work: You can print the document while you 
use the Lisa for other tasks. Some printing conditions 
make printing while you work inconvenient, however. For 
example, if you are feeding Single sheet paper into your 
printer, and printing a quick draft, you won't have time to 
do other activities on the Lisa. 

When you choose While You Work, the Monitor the 
Printer dialog box appears. 

Monitor the Printer .. 
Document being printed: 85 Forecast 
Copy being printed: 1 Df 1 
Page being printed: 0 Df 1 

If YOLI want to do other work while the docllment is being printed, 
click Proceed. Otherwise, just wait. 

If yOI) do decide to Proceed, YOll can get back here by choosing 
Monitor t.he Printer from the File/Print menu. YOLI should do that if 
YOLI hear a wI-listIe or if you want to terminate printinlJ 

This dialog box tells you the document name, the copy, 
and the page being printed. Click Proceed to return to 
LisaCalc and continue working. Click Terminate to stop 
the printing. If you decide to proceed, you can return to 
this dialog box at any time to stop the printing by 
choosing Monitor the Printer from the File/Print menu. 



Print 

Note that if you hear a whistle, there is a problem with Print a Document 
printing while you work. Choose Monitor the Printer from (continued) 
the File/Print menu to see what the problem is. 

Number of Pages 

A page in LisaCalc is determined by the location of the 
page marks. See the Insert Page Marks procedure, under 
Print, in this chapter. In a spreadsheet, page numbering 
starts at the upper left hand corner and then goes down, 
until there are no more non blank rows. Then the 
numbering starts again at the top of the spreadsheet. 

All Pages: You can print all pages of a document. Just 
make sure All Pages is checked in the Print dialog box. 

Selective Pages: To print selective pages of a 
document, check Only Pages and then fill in the boxes 
with the starting and ending pages to print. 

When you want to print from the beginning of a document 
through some page number, say 8, you enter "8" in the 
second box after Through. Similarly, if you want to start 
at a given page number and print to the end, you need to 
enter the starting page number in the box after Only 
Pages. 

Number of Copies 

You can print from 1 to 10 copies of any document. Just 
check the box with the number of copies you want 
printed. 

Chapter 2 ::: I Cgg 
Procedures ••• 



Print 

Remove 
Page Marks 

• • • LisaCalc Reference Guide 
C100 I : : : Section C 

To remove a page mark from your spreadsheet 

~ Select the grid handle between columns or rows 
where the page mark is. 

~ Choose Remove Page 

Layout menu. 

.pmtji,jiliQl 
r,OhIlYHl Widths '" 

Insert Page Mark 
Remove Page Marks 

To remove all page marks from your spreadsheet 

• 

~ Choose Select All of Document from the Edit menu. 

~ Choose Remove Page 
Marks from the Page 
Layout menu. 

COhUYHl Widths '" 

Insert Page Mark 
Remove Page Marks 

You can remove page marks that you have specified, but 
you cannot remove the default page marks set by 
LisaCalc. When you remove one or more page marks, 
LisaCalc automatically adjusts the default page marks to 
be one page apart. 



C102 Protect Formulas and Values 
C103 Protect Formulas Only 
C104 Unprotect 

Protect 
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Protect Formulas 
and Values 
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To protect all cells 

~ Select the cells you want protected. 

~ Choose Protect 
Formulas & Values from 
+h", 0 .. ",+".,..+ ....,.""' ....... 
"llv I I \JL~VL Illvll"". 

If you select a range of cells and choose Protect 
Formulas & Values, all cells in the range are protected. 

When a cell is protected, the following rules apply: 

• You cannot change or replace the value. 
• You cannot clear the cell until you unprotect it. 
• If you try to paste another cell on top of the cell, an 

alert box asks you to confirm that you really want to do 
this. 

• You can edit the formula without unprotecting the cell, 
but you cannot clear the formula. 

• You can cut the cell. 
• You can copy the cell. The cell you copy to is also 

protected. 
• You can move the cell. The cell you move to is also 

protected. 

If you want to see whether a selected cell is protected, 
just look at the Protect menu; there is a check mark next 
to the option in effect. 



To protect cells with formulas 

~ Select the cells you want protected. 

~ Choose Protect 
Formulas Only from the 
Protect menu. 

If you select a range of cells and choose Protect 
Formulas Only, only cells in the range with formulas are 
protected; cells with values only are not protected. 

When a cell is protected, the following rules apply: 

• You cannot clear the cell until you unprotect it. 
• If you try to paste another cell on top of the cell, an 

alert box asks you to confirm that you really want to do 
this. 

• You can edit the formula without unprotecting the cell, 
but you cannot clear the formula. 

• You can cut the cell. 
• You can copy the cell. The cell you copy to is also 

protected. 
• You can move the cell. The cell you move to is also 

protected. 

If a cell with no formula is protected with Protect 
Formulas Only, then as soon as a formula is entered in 
the cell, it is protected. If you enter a value or clear the 
cell instead of entering a formula, the cell becomes 
unprotected. 

If you want to see whether a selected cell is protected, 
just look at the Protect menu; there is a check mark next 
to the option in effect. 

Protect 

Protect 
Formulas Only 
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To remove protection from cells 

~ Select the cells you want unprotected. 

~ Choose Unprotect from 
the Protect menu. 

If you want to see whether a selected cell is protected, 
just look at the Protect menu; there is a check mark next 
to the option in effect. 



C106 LisaGraph 
C107 LisaWrite 

Other Tools 
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L isa Graph 
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To copy data from a LisaCalc spreadsheet into a 
UsaGraph table 

~ Get or activate the LisaCalc spreadsheet. 

~ Select the cells that you want to copy. 

~ Choose Copy from the 
Edit menu. 

Paste 
Paste Adjusting ... 
Paste Values 

~ Get or activate the LisaGraph document. 

~ Select the location in the LisaGraph table where the 
cells are to be pasted. 

~ Choose Paste from the Edit menu. 

~ Edit and format the graph and table; then save, print, 
and file the LisaGraph document as usual. 

When you copy cells from a LisaCalc spreadsheet to a 
LisaGraph table, LisaGraph retains the values, 
alignment, and number style but not the formulas, 
protection, or column width. You can paste rows of cells 
from LisaCalc into columns in LisaGraph, or columns 
into rows. The values are automatically plotted in the 
graph after pasting. 

You can also copy cells from LisaGraph into LisaCalc to 
perform calculations on the values. 



To copy cells from LisaCalc to a LisaWrite document 

~ Get or activate the LisaCalc spreadsheet. 

~ Select the cells that you want to copy. 

~ Choose Copy from the 
Edit menu. 

Paste 
Paste Adjusting '" 
Paste Values 

~ Get or activate the LisaWrite document. 

~ Place the insertion point where you want to place the 
LisaCalc data, or select the text in the LisaWrite 
document that you want to replace. 

~ Choose Paste from the Edit menu. 

When you copy cells from a LisaCalc spreadsheet to a 
LisaWrite document, only the values are copied. The cells 
are arranged in the LisaWrite document in the same 
positions as in the LisaCalc spreadsheet. Each column 
becomes a tab stop. Tab alignments are set to match the 
alignments that were specified in LisaCalc. 

Other Tools 

Lisa Write 

Chapter 2 ::: C107 
Procedures • • • 



@ f!i @l ® ® @l ® © fi) Section D 
® ® f!i @ @ ® ® ® @ Appendixes 

@ ® @ ® 

@ @ @ @ @ 

@ fi) @ @ @ if) @ @ 

@ @ fit, @ 

@ ® @ 

@ @ @ @ @ ® ® @ 

@ @ @ ® @ @ @ @ @ 

@ @ @ @ IJI @ @ @ @ 

029-0133-A 



Contents 

01 Appendix 1. Menu Items 

05 Appendix 2. Apple Keys 

07 Appendix 3. Type Fonts 

09 Appendix 4. Formulas 

021 Appendix 5. Functions 

... : : : I Diii 



Appendix 1 
Menu Items 

File/Print Menu 
Returns all windows to their icons 
without saving the contents. 

Returns the current document to 
its icon without saving the 
contents. 

Saves the contents of the 
document, closes the window, and 

Save & Put Away returns the icon to its original 
Save & Continue .... -----111---. location. 

Revert to Previous Versio Saves the contents of the 
document and leaves the window 

Format For Printer" ...... --M-..., open. 

Pr int " ..... --------1....., 
Monitor the Printer ........ -....-, 

Returns the document to its state 
as of the last time you saved it. 

Sets formats in the document 
based on the printer that will be 
used. 

nts the document. 

Shows the status of the 
documents that are printing. 

Appendix 1 
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Edit Menu 

Reverses the effect of the last 
operation. 

!:!eSf:ore P~'evious Fntrq .... --a- Restores last entered contents of 

Cut 
Copy 
Paste 

cell. 

Perform basic editing operations. 

Paste Adjusting ........ ---11-- Pastes cells and adjusts formulas. 

Paste Values Pastes values only. 

Clear Entries ..... ----........ - Removes contents of cells. 

lnsN"t Hi.nnh ..... -------II-Inserts blank row or column. 

Select All of Document .AI .... Selects entire document. 

Type Style Menu 

15 Pitch Gothic 
..,112 Pitch Modern 

12 Pitch Elite 
10 Pitch Modern 
10 Pitch Courier 

Show type fonts available in 
t---- LisaCalc. See Appendix 3, Type 

Fonts, for examples. 

Shows spreadsheet with font 
Show Actual Size ... -R---- specified in Format for Printer 
Show Small Type 1 dialog box . 

..,IShow Medium Type t---- Show spreadsheet with specified 
Show large Type J size of font. 

Page Layout 

Column Widths ....... -11---- Sets widths for selected columns. 

Sets a page mark at selected grid 
ln~(.Tt p(J~')e Mm·j<, .... -tt----- handle. 

Remove Page Marks Removes page marks from 
selection. 



Format Menu 

"Words Left/Nos. Right 
Left Flush .L 
(enter .K 
Right Flush .R 
Fill Pattern 

"Floating Decimal 
No Decimal 
Fixed Decimal 
Scientific ... 
$1,234.56 
1,234.56 

$ 1234.56 
1234.56 

$1,135 
1,235 

$ 1235 
1135 

Protect Menu 

Aligns labels to left and numbers 
...- to right. 

r-- Align values between left and 
right sides of cell. 

'--- Set number style. 

.:'.11 . .,. .... 
~~~~~;.::========t""- Removes protection. I.v'Unprotect --

Protect Formulas fr Values ~ Protects all selected cells. 

'"1IiI!iIIPlII\lIr.o.teecetmFlII\lIollllllrllllllmllllllu.I.Cl.s III\lIDen•1 Y5D~_mm!lIr- Protects only selected cells with 
formulas. 
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Calculate Menu 

"'Calculate Automatically ~ Specify when recalculation is to 
occur. 

Calculate Manually 
Calculate Now ... ---...... - Immediately recalculates the 

spreadsheet. 

Show Formulas u Values 
"'Show Values Only 

h Specify whether spreadsheet r view shows formulas in addition to 
values. 

Don't Circle Values _~-___ -- Removes circles from missing 
values. 

"'Circle Missing Values ... --11-...... 
..... Circles all missing values. 

find Next Missing Values ~ 
Finds the next missing value. 

function Hints ...... ---11-- Provides quick reference for 
function formats. 



Appendix 2 
Apple Keys 

Some LisaCalc menu items contain the Apple key symbol 
@ followed by a character. 

Menu items that appear with the Apple key symbol can 
be chosen by using the mouse or by pressing the @ key 
and the character associated with that menu item. For 
example, to use the Cut menu item, you first select what 
you want to delete, press the@ key, and while holding it 
down, press the X key. 

The following list shows the characters that can be used 
in combination with the @ key in LisaCalc: 

A Select All of Document 
C Copy 
G Select Cells area ("Go to cell") 
K Center 
L Left Flush 
M Select Formula area ("Mathematical formula") 
R Right Flush 
V Paste 
X Cut 

Terminate 
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Type Fonts 

Type of one size and face is called a font. The "face" is 
the portion of the character that displays and prints. On 
the Type Style menu, some font names are preceded by a 
number that indicates character size. This number 
indicates how many characters will print per inch when 
you use that type font. 

The list below shows the fonts as they print. You can print 
any of the LisaCalc type styles on a dot matrix printer. To 
use them with a daisy wheel printer, however, you must 
have the appropriate wheel. If you choose a font that your 
printer is not set up to use, an alert message is displayed 
on the screen. 

15 Pltch GothlC 
12 Pi t ch ~1ol~ern 

12 Pitch Elite 
10 Pitch ~'1odern 

10 Pi tch Courier 
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Arithmetic 
Formulas 

Appendix 4 
Formulas 

There are three kinds of formulas in LisaCalc: 

• An arithmetic formula has a number as a value. 
• A logical formula has True or False as a value. 
• A date formula has a date or a date part as a value. 

This appendix also describes a group of special 
constants, such as Error, Date, and so forth. 

If you type an invalid formula, and then try to enter it, 
LisaCalc displays an alert message. It won't let you do 
anything else until you have corrected or cleared the 
formula. 

An arithmetic formula is a series of arithmetic operands 
separated by arithmetic operators. 

Operands 

An operand is one of the things shown in Table 4-1. 

Table 4-1. Arithmetic Operands 

Operand 

Number 

Cell coordinate 

Function 

Parenthesized formula 

Example 

123.456 

A42 

Sum(A 19:057) 

(A 1 *84) 

The term "parenthesized formula" means that if part of 
the formula is enclosed in parentheses, it can be used as 
an operand. 
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Example 

(A 1 * B4)/(C2 - 03) 

In this case, the division operator has two operands: 
(A1*B4) and (C2-03). 

Operators 

The arithmetic operators are shown in Table 4-2. 

Table 4-2. Arithmetic Operators 

Operator 

+ 

* 

/ 

DIV 

REM 

Meaning 

Addition 

Subtraction 

Multiplication 

Division 

Integer division 

Remainder 

Exponentiation 

Exponentiation means "raise to the power." 

Examples 

3 ~ 2 = 9 
8~{-1/3)=.5 

DIV is integer division. It operates like regular division, 
except that the result is always a whole num ber; any 
fractional remainder is discarded. 

Examples 

11 DIV 3 = 3 
11 DIV -3 = -3 
-11 DIV 3 = -3 
-11DIV-3=3 

REM is the remainder operator. Its result is the 
remainder after integer division. There must be a space 
on both sides of the letters REM. 

Examples 

26 REM 7 = 5 
26 REM -7 = 5 
-26 REM 7 = -5 
-26 REM -7 = -5 



Order of Evaluation 

When a formula contains more than one operator, the 
order in which the operations are performed depends on 
what the operators are. There are three categories of 
operators; these are shown in Table 4-3. Any operations 
in the first group are performed first, then any operations 
in the second group, and finally any operations in the 
third group. 

Table 4-3. Order of Evaluation of Arithmetic Operators 

Order 

First 

Second 

Third 

Examples 

2+3 ~ 2 = 11 
2 ~ 3+2 = 10 
3*4+2*5 = 22 
2+4/2+3 = 7 
-2 ~ 2 = -4 

Operators 

* / REM DIV 

+-

In the last example, the exponentiation operation is 
performed first, and then the result is subtracted from 0, 
even though no 0 is shown in the formula. 

If a formula contains parentheses, the formula within the 
parentheses is evaluated first. Therefore, parentheses 
can always be used to control the order of evaluation. 

Examples 

(2+3)~2 = 25 
3*(4+2)*5 = 90 
(2+4)/(2+3) = 1.2 
2*( -20/(5-3»+(4*(8/2» = -4 
Sum(1,2,3,4,5)*Sum(2,3,4) = 135 

If a formula contains more than one operator from the 
same group, the operations are evaluated from left to 
right. Again, parentheses can be used to change the 
order of evaluation. 
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Examples 

24/4/2 = 3 
24/( 4/2) = 12 
2 A 3 A 2 = 64 
2 A (3 A 2) = 512 

Logical Formulas A logical formula has the value True or False. A logical 
formula can occur either as a formula on its own or as 
one of the arguments to the If or Search function. 

• • • LisaCalc Appendixes 
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The simplest kind of logical formula is just one of the 
constants True or False entered as the value of a cell. The 
next simplest kind is a relational formula. Relational 
formulas can, in turn, be combined into compound 
logical formulas through the operators Not, Or, and And. 

Logicai vaiues and iormuias can be used as components 
of arithmetic formulas. In this case, False is equal to 0, 
and True is equal to 1. 

Relational Formulas 

A relational formula compares two operands to see 
whether they are equal, or if not, which is greater. Each of 
the two operands of a relational operator is itself a 
formula. The relational operators are shown in Table 4-4. 

Table 4-4. Relational Operators 

Operator 

< 
<= 

> 
>= 

<> 

Example 

C1 <= D1 

Meaning 

Less than 

Less than or equal to 

Greater than 

Greater than or equal to 

Equal to 

Not equal to (that is, less 
than or greater than) 

This formula has the value True if C 1 is less than or equal 
to D 1; otherwise, it has the value False. 



Example 

Sum(A1:M2) <> 23.45 

This formula has the value True if Sum(A 1:M2) is not 
equal to 23.45; otherwise, it has the value False. 

When the operands to a relational formula are labels, 
only = or < > can be used as the operator. 

LisaCalc compares values based on the values stored in 
memory. Because it is not always possi ble to store 
decimal numbers precisely, two values that appear to be 
equal may be found to be unequal when they are 
compared. 

Compound Logical Formulas 

You can combine two or more relational formulas into a 
compound logical formula using one or more of the 
operators Not, Or, and And. The possible forms are 
shown in Table 4-5. 

Table 4-5. Compound Logical Formulas 

Formula 

Not formula 1 

Formula 1 Or Formula 2 

Formula 1 And Formula 2 

Value 

True if formula 1 is False; 
False if formula 1 is True. 

True if formula 1 or formula 
2 or both are True; False if 
both are False. 

True if both formula 1 and 
formula 2 are True; 
otherwise, False. 

The operands for Not, And, and Or must be relational 
formulas or other logical formulas. 

When a formula contains more than one relational or 
logical operator, the order in which the operations are 
performed is shown in Table 4-6. 
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Table 4-6. Order of Evaluation of Operators 

Order Operators 

First Arithmetic operators 

Second <, <=, >, >=, =, <> 

Third Not 

Fourth And 

Fifth Or 

Table 4-7 shows some examples of logical formulas. In 
these examples, assume that 

A1 = 12 
81 = 27 
Cl = 39 

Table 4-7. Compound Logical Formulas 

Formula Value 

Not A1 <= 12 False 

AI> 13 Or B 1 = 27 True 

A 1 + 81 = C 1 And C 1 True 
>= 81+10 

C 1 = 39 Or 81 > 26 And True 
A1 < 6 

(C1 = 390rB1 > 26) False 
And A1 < 6 

The last two examples show you how parentheses 
change the order of evaluation of a logical formula. In the 
first formula, with no parentheses, the And operation is 
performed before the Or operation. This part of the 
formula reads: 

B 1 > 26 And A 1 < 6 

Since A 1 is not less than 6, the And operation results in 
the value False, even though B 1 is greater than 26. This 
means that the whole formula is equivalent to: 

C1 = 39 Or False 



Date Formulas 

Since C1 is equal to 39, the formula is True. In the last 
formula, however, the parentheses require the Or 
operation to be performed first. This part of the formula 
reads: 

C 1 = 39 Or B 1 > 26 

Since C1 is equal to 39, the Or operation results in the 
value True. This means that the whole formula is 
equivalent to: 

True And A 1 < 6 

Since A 1 is greater than 6, the value of the formula is 
False. 

A date formula is one whose value is a date or a date 
part. Dates are in the form: 

month/day/year 

where month is a number from 1 to 12, day is a number 
from 1 to 31, and year is a number from 1 to 9999. The 
year can be entered in 1 to 4 digits; if the first two digits 
are omitted, "19" is assumed. 

Dates and date parts can be values, as well as occurring 
in formulas. 

A date must be a legal date. For example, 

2/31/84 

is not a date, but text. Any date obtained as the value of a 
formula is always a legal date. 

Dates are based on the Julian calendar; in particular, 
February 29 occurs only in leap years. 

The special value Date is always equal to today's date. Its 
value in a spreadsheet does not change unless the 
spreadsheet is recalculated. Every time the spreadsheet 
is recalculated, "Date" is evaluated as equal to today's 
date. 

If a date is entered in the Formula area of a cell, it must 
be surrounded by quotation marks. In the Value area, 
quotation marks are not necessary. 
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Example 

"4/2/92" 

in a formula is a date, but 

4/2/92 

is a sequence of two divisions. 

A date part is in one of the following forms: 

x days 
x weeks 
x months 
x years 

You can type 

x weeks 

in a cell, but as soon as you enter the value, it is changed 
to 

7*x days 

Values are never displayed in weeks. 

Date formulas take one of the forms shown in Table 4-8. 

Table 4-8. Date Formulas 

Formula Value 

- Date Date 

,.-- Date part Date part 

Date + date part Date 

Date - date part Date 

Date part + date part Date part 

Date part - date part Date part 

Date - date Date part 

Examples 

"9/5/47" + 10000 days = 1/21/75 
"12/11/82" - 1000 days = 3/16/80 
"12/25/83" - "3/31/83" = 269 days 
1 year + 400 days = 1 year, 400 days 



In logical formulas, dates can be compared to dates and 
date parts can be compared to date parts. The formula: 

Date 1 < Date 2 

is True if Date 1 occurs before Date 2, and False 
otherwise. 

Example 

Date> "3/3/84" + 1 year 

has the value True if a year has elapsed since March 3, 
1984, and the value False otherwise. 

For date parts, only the equal (=) and not equal « » 
comparisons are valid. Two date parts are considered 
unequal if they are in different units. For example, it is 
never true that a certain number of months is equal to a 
certain number of days. The only exception to this rule is 
that X weeks is equal to 7*X days. 

The interpretation of a date part depends on what units it 
is expressed in. If the formula only contains date parts, 
then date parts expressed in the same units are 
combined, but not date parts in different units. 

Examples 

1 year + 17 days = 1 year, 17 days 
1 month + 3 weeks = 1 month, 21 days 
3 years + 4 months + 5 years - 2 months = 8 years, 
2 months 

In a formula of the form: 

Old Date + date part = New Date 

the interpretation of the date part is as follows: 

• If the date part is a number of days, New Date is found 
by counting forward that many days from Old Date. 

• If the date part is a number of weeks, it is converted to 
days when the formula is calculated, but is still shown 
as weeks in the formula. 

• If the date part is a number of months, that many 
months are added to the month part of Old Date. The 
year part is increased if necessary, but the day part 
does not change, unless leaving the day part the same 
would result in an illegal date. 

• If the date part is a number of years, New Date is the 
same date, except that the number of years is 
increased or decreased accordingly. An exception is 
February 29, in a non-leap year, which is changed to 
March 1. 
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Examples 

"4/30/85" + 1 month = "5/30/85" 
"1/31/85" + 1 month = "3/3/85" 
"2/10/84" + 1 year = "2/10/85" 
"2/10/84" + 365 days = "2/9/85" 

The same interpretation applies for a formula of the 
form: 

Old Date - date part = New Date 

except that the date part is subtracted instead of added. 

You can convert date parts expressed in one unit into 
any other unit by using the following form: 

(Number Unit 1) Unit 2 

This form takes a date part specified in Unit 1 and 
converts it to one in Unit 2. For example: 

(3 months) days = 90 days 

In this example, 3 months are converted to the 
corresponding number of days. The rules used in 
conversion are as follows: 

1. For months, days, and years, the following applies: 

1 week = 7 days 
1 month = 30 days 
1 month = 4 weeks = 28 days 
1 year = 12 months 
1 year = 365 days 
1 year = 52 weeks = 364 days 

2. Weeks are first converted to days, and then treated as 
in rule 1. 

3. Amounts less than a whole number of units are 
rounded down. 

4. If the answer after converting is 0, it is always shown 
as "0 days" regardless of the original units. 

Examples 

(Date - "1/1/83") months = number of months since 
beginning of year 

(23 months) days = 690 days 
(23 months) years = 1 year 
(121 days) months = 4 months 
(1 year) weeks = 364 days 
(1 month) weeks = 28 days 



In the last two examples, the answer is shown in days 
because values are never shown in weeks. After 
conversion to weeks, the number of days shown is 
always divisible by seven. 

Date parts can be arguments to the functions Int, Round, 
and RoundlEEE, shown in Appendix 5, Functions, in this 
manual. The result of one of these functions is the whole 
number of units in the date part, without the units. The 
whole number can then be used in contexts where date 
parts are forbidden, for example multiplication. 

Example 

4*lnt(3 weeks) = 12 

Special Constants Certain labels are given special meanings by LisaCalc. 
When these labels appear in the Formula area, they 
stand for certain special values. These labels are: 

Date When used in a formula, or by itself in the 
Formula area, today's date is substituted. If 
the spreadsheet is recalculated, and the 
date has changed, the new date is 
substituted. If the spreadsheet is not 
recalculated, the value of Date stays the 
same, even if today's date has changed. 
Date is only meaningful in a formula; when it 
is used as the value of a cell, it is interpreted 
as the text value "Date," not as today's 
date. 

Example: Date + 6 months = The date six 
months from today. 

Error This value is returned by LisaCalc whenever 
an error occurs in calculating a formula. It 
can also be used in a formula if you want to 
flag an error in a cell. When Error appears 
as an operand in a formula, the value of the 
formula is also Error. 

Example: If(81 > C1,A1,Error) = The value 
of A 1 if 81 is greater than C 1, otherwise 
Error. 
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Infinity The largest possible value. Infinity is 
returned as the result of division by zero, or 
as the result of certain functions. -Infinity is 
the negative number with the largest 
magnitude. 

Example: If (A 1 = Infinity, "Overflow", "OK") 
= The word Overflow if A 1 contains Infinity, 
otherwise the word OK. 

Na Not Available. This value is returned by the 
Lookup function if the value being looked up 
is out of range, and by the Search function if 
the value is not found. You can use it as the 
value of a cell if some information is not 
available yet, but you don't want an error in 
the spreadsheet. When Na appears as a 
value in a formula, the value of the formula is 

Pi 

also Na. 

Example: The value of A 1 is Na. The formula 
in A2 is A 1 + 1. Therefore, the value of A2 is 
also Na. 

The mathematical constant Pi 
(3.14159265358979 ... ). Pi is only 
meaningful in the formula of a cell; when it is 
used as a value, it is interpreted as the text 
value "Pi," not as a number. 

Example: Cos(Pi) = -1 



Function 
Arguments 

Appendix 5 
Functions 

Functions are used in formulas. A function can either be 
a formula by itself, or it can be a component of a longer 
formula. 

If you want a quick reminder of the name or arguments of 
a particular function, choose Function Hints from the 
Calculate menu. 

The form of a function is: 

name (argument 1, argument 2, ... ) 

The number of arguments for the function, and what the 
arguments can be, differ for each function. All of the 
arguments fall into one of the three categories shown in 
Table 5-1. 

Table 5-1. Kinds of Arguments 

Argument 

Value 

Definition 

A single value; something 
that is or could be the 
contents of a cell. 

Examples: 

23.5 

A2 

A26*B27 

C1 < D2 

true 

"9/5/47" 

3 months 

"Yearly Total" 
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Table 5-1. Kinds of Arguments, continued 

Argument 

Range 

List 

Definition 

A range of cells in the usual 
notation. A range cannot 
be a whole row or column. 

Examples: 

A1:B10 

D27 

A list of values and ranges, 
separated by commas. Any 
number of values and 
ranges is allowed. 

Exampies: 

B2:B30,C5,42.3 

A 1 :A2,A 1:B 10," 1/19/95", 
"Tomorrow" 

1,2,3,4,5 

Each of these types of arguments is a collection of one or 
more values. Every value belongs to a certain data type; 
a function may allow values of only certain types. If you 
use an argument of the wrong type, the most likely result 
is that the function will be assigned the special value 
Error. The data types are shown in Table 5-2. 

Table 5-2. Data Types of Arguments 

Type 

Blank 

Number 

Definition 

An empty cell. When used 
as a number in a formula, a 
blank is equal to zero. 

A whole or decimal number. 

Examples: 

23.2 

4.5E+2 

$123.45 



Table 5-2. Data Types of Arguments, continued 

Type 

Logical 

Date 

Date part 

Label 

Definition 

True or False. When used 
as a number in a formula, 
True is equal to 1, and False 
is equal to O. 

A calendar date. 

Example: 

"8/12/34" 

A number of days, weeks, 
months, or years. 

Examples: 

1 day 

2 weeks 

3 months 

5 years 

Any value not in one of the 
above categories. When 
used as a number in a 
formula, a label is 
equal to O. 

Examples: 

Truue 

23.A 

$12?.45 

3 moths 

Break-Even Factor 
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Abs Abs (Value) 

Type of Value Number. 

Result Abs returns a positive value 
of the same magnitude as 
Value. That is: 

• If Value >= 0, 
result = Value . 

• If Value < 0, 
result = - Value. 

Example Abs(3.2) = 3.2 

Abs( - 3.2) = 3.2 

Error Conditions Abs returns Error if Value is 
net a number. 

Acos Acos (Value) 

Type of Value Number. -1 < = Value 
<=1 

Result Arccosine of Value, in 
radians. 0 < = Result 
<= Pi. 

Error Conditions Acos returns Error if Value 
is not a number or is 
outside the range 
indicated. 

Annuity Annuity (Value 1, Value 2) 

Type of Value 1 Number. Value 1 is the 
interest rate per period. 

Type of Value 2 Number. Value 2 is the 
number of periods. 
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Result 

Example 

Error Conditions 

Asin Asin (Value) 

Type of Value 

Result 

Error Cond it ion 

Annuity returns a number 
called the annuity factor. 
When this factor is 
multiplied by the return per 
period of an investment, 
the result is the present 
value of the annuity. The 
formula used for 
calculation is: 

~ 

(1-(1 +Value 1) (-Value 
2)/Value 1 

Suppose you want to know 
how much your monthly 
payments would be on a 
30-year mortgage for 
$100,000, if the interest 
rate were 15% a year. This 
is 360 payments; the 
interest each month is 
1.25%. The formula for this 
would be: 

100000/ Annuity(.O 125,360) 

The answer is 1264.44. 

Annuity returns Error if 
Value 1 is not a number or 
is less than or equal to -1, 
or if Value 2 is not a 
number. 

Number. -1 < = Value 
<= 1. 

Arcsine of Value, in radians. 

- Pil2 < = Result 
<= Pil2. 

Asin returns Error if Value 
is not a number. 
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Average 
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Atan (Value) 

Type of Value 

Result 

Error Condition 

Average (List) 

Type of List 

Result 

Example 

Error Conditions 

Number. 

Arctangent of Value, in 
radians. 

- Pil1 < Result < Pil2. 

Atan returns Error if Value 
is not a number. 

Any number of numbers, 
logical values, or labels. 

Average returns the 
""',.....""'_" 1 ____ \ _" ........ _ 
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values in the list. It is 
equivalent to: 

Sum(list)/Count(list) 

or the sum of the values in 
the list divided by the 
number of values in the list. 
In computing the number of 
values in the list, LisaCalc 
includes labels but omits 
blank cells. If any of the 
values is Na, the result of 
the function is Na. 

Average(14.2,True,100) = 

38.4 

Average returns Error if any 
of the values in the list are 
dates or date parts, or have 
the value Error. Blank cells 
are allowed and do not 
contribute to the result. 



Compound 

Cos 

Compound (Value 1, Value 2) 

Type of Value 1 

Type of Value 2 

Result 

Example 

Error Conditions 

Cos (Value) 

Type of Value 

Result 

Error Condition 

Number. Value 1 is the 
interest rate per period. 

Number. Value 2 is the 
number of periods. 

Compound returns the 
compound interest factor, 
which, when multiplied by 
the principal, yields the 
total compounded value of 
a debt or investment. The 
formula used for 
calculation is: 

(1 + Value 1) A Value 2 

Suppose you have $75,000 
invested at 18% a year, 
compounded monthly, and 
you want to find out how 
much you will have at the 
end of four years. This is 48 
periods, at 1.5% interest 
per period. The formula for 
this would be: 

75000*Compound(.015,48) 

The answer is $153,260.87 

Compound returns Error if 
Value 1 is not a number, or 
is less than or equal to -1, 
or if Value 2 is not a 
number. 

Number, in radians. 

Cosine of Value. 

Cos returns Error if Value is 
not a number. 

Appendix 5 ::: I D27 
Functions •• • 



Count 

Exp 
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Count (List) 

Type of List 

Result 

Example 

Error Conditions 

Exp (Vaiue) 

Type of Value 

Result 

Examples 

Error Conditions 

If (Value 1, Value 2, Value 3) 

Type of Value 1 

Type of Value 2 

Any number of values of 
any type. 

Count returns the number 
of values in the list that are 
not blank. If the value of a 
cell is any number of 
spaces, the cell is not 
considered blank by the 
Count function. 

Count(A 1:A7) = 5 

" G [ells: AS Value (Number): 5 
" M Formula: count(Al:A7) 

ABC 

4 

None. 

Number. 

Exp returns the exponential 
function of Value, which is 
e - Value. 

Exp(1) = 2.718281828459 

Exp(-1) = 
.36787944117144 

Exp returns Error if Value is 
not a number. 

Logical formula. 

Any type of value. 



Type of Value 3 

Result 

Examples 

Error Cond it ions 

Int Int (Value 1, Value 2) 

Type of Value 1 

Type of Value 2 

Any type of value. 

If Value 1 is equal to True, 
the result of the function is 
Value 2. If Value 1 is equal 
to False, the result of the 
function is Value 3. 

If (A1 < 27,B1,C1) = 
B 1 if A 1 is less than 27, 
C 1 otherwise. 

If (D1, "yes", "no") = 
The label "yes" if D 1 is 
true, otherwise the label 
"no." 

If (A 1 < 2 And B 1 
< 2,Min(C1:C8), 
Max(C1 :C8» = 
If A 1 and B 1 are both less 
than 2, the smallest value in 
C1:C8, otherwise the 
largest value in C1:C8. 

For more examples, see the 
LisaCalc Tutorial, Section 
B, Chapter 4. 

If returns Error if Value 1 is 
not a logical value, or if 
Value 1 is True and Value 2 
is Error, or if Value 1 is 
False, and Value 2 is Error. 

Number or simple date 
part. 

Whole number. Value 2 can 
be omitted. 
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Result 

Examples 

Error Conditions 
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Int returns the truncated 
value of Value 1; that is, 
Value 1 with some of its 
decimal places deleted. If 
Value 2 is present and is 
not zero, it indicates the 
number of decimal places 
to be included in the result. 
If Value 2 is omitted or zero, 
the result has no decimal 
fraction. 

If Value 2 is negative, that 
number of digits to the left 
of the decimal point goes to 
zero. If Value 2 is positive, 
that number of digits to the 
right of the decimal point is 
truncated. If Value 2 is not a 
whole number, it is rounded 
to the nearest whole 
number. 

If Value 1 is a sim pie date 
part, Int returns the number 
of units (days, months, or 
years) without the units. 

Int(4.23) = 4 

Int(4.23,0) = 4 

Int(1.234567,3) = 1.234 

Int( -1.234567,3) = 

-1.234 

Int(1.234567,-3) = 0 

Int(14 months) = 14 

Int(1 year + 2 months) = 

Error 

Int(1234,-2) = 1200 

I nt( 1234 years, - 2) = 1200 

Int returns Error if Value 1 
is not a number or a simple 
date part, or if Value 2 is 
not a number. 



Ln 

Log 

Lookup 

Ln (Value) 

Type of Value 

Result 

Examples 

Error Cond it ions 

Log (Value) 

Type of Value 

Result 

Examples 

Error Conditions 

Positive number. 

Ln returns the natural 
logarithm of Value. This is 
the logarithm to the base e. 

Ln(2.7182818284591) = 1 
Ln(2) = .69314718055995 
Ln( 1 0) = 2.302585092994 

Ln returns Error if Value is 
not a positive number. 
Ln(O) is equal to Infinity. 

Positive number. 

Log returns the logarithm 
of Value to the base 10. 

Log(2.7182818284591) = 

.43429448190326 
Log(2) = 

.30102999566398 
Log(10) = 1 

Ln returns Error if Value is 
not a positive number. 
Log(O) is equal to infinity. 

Lookup(Value, Range 1, Range 2) 

Type of Value 

Type of Range 1 

Any type of val ue except a 
date part. 

Can contain any type of 
cells; must be compatible 
with Value. 
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Type of Range 2 

Result 
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Can contain any type of 
cells. Range 2 can be 
omitted. Range 1 and 
Range 2 should have the 
same number of cells, but 
one can be part of a row 
while the other is part of a 
column. If Range 2 is 
smaller than Range 1, then 
whenever a value is found 
in Range 1 in a cell in which 
there is no corresponding 
value in Range 2, Lookup 
returns Na. 

Lookup treats Range 1 as a 
table in which it looks up 
\/!:IIiIO It I"'hol"'vc O~n,.,o 1 in 
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order to find a value that 
matches Value. When Value 
is found, the corresponding 
entry in Range 2, counting 
one-for-one, is returned as 
the result of the function. If 
Value 1 is not matched 
exactly, but a value 
exceeding it is found, then 
the entry immediately 
before the value that 
exceeds Value 1 is returned 
as the result of the 
function. If Range 2 is 
omitted, then the next 
column or row is treated as 
Range 2. 

If Range 1 is more than one 
column wide and one row 
deep, the range is 
examined by going down 
each column from top to 
bottom before moving on 
to the next column. 



Example 

Error Cond it ions 

If Value is a date or number, 
Lookup assumes that 
Range 1 is arranged in 
ascending numerical 
sequence. If it is not in 
sequence, then Lookup 
stops looking for values as 
soon as it finds a value out 
of sequence. 

If Value is a label, it must be 
enclosed in quotation 
marks, unless it is a single 
word. For labels, the values 
in Range 2 do not have to 
be in any particular order. 
Upper case letters and 
lower case letters are 
considered the same when 
Lookup is looking for a 
match. 

See the LisaCalc Tutorial, 
Section 8, Chapter 4. 

If Value is a label, it must be 
matched exactly in Range 
1, or the result of the 
function is Na (Not 
Available). If Value is a 
number or date, it must fall 
between the first and last 
values in Range 1, or the 
result of the function is Na. 

~~---------------------------------------------------------------------Max Max (List) 

Type of List 

Result 

Numbers, logical values, 
labels, or dates. Dates 
cannot be mixed with any 
of the other types. 

Max returns the largest 
value in the list. If List is a 
list of dates, Max returns 
the date occurring the 
latest. Labels are equal 
to o. 
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Examples Max(1.2,-200,3) = 3 

Max(" 1 /9/87" , 
"2/4/93", "3/15/72") = 
2/4/93 

Max(False,.3,.4,True,.7) = 
True 

Error Conditions Max returns Error if the 
items in List are not of 
compatible types, or if any 
item in the list has the value 
Error. 

Min Min (List) 

Type of List Numbers, logical values, 
labels, or dates. Oates 
cannot be mixed with any 
of the other types. 

Result Min returns the smallest 
value in the list. If List is a 
list of dates, Min returns 
the date occurring the 
earliest. Labels have the 
value O. 

Examples Min(1.2,-200,3) = -200 

Min(" 1 /9/87", 
"2/4/93","3/15/72") = 
3/15/72 

Min(False,.3,.4,True,.7) = 
False 

Error Conditions Min returns Error if the 
items in List are not of 
compatible types, or if any 
item in the list has the value 
Error. 
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Npv 

Round 

Npv (Value,Range) 

Type of Value 

Type of Range 

Result 

Example 

Error Conditions 

Round (Value 1, Value 2) 

Type of Value 1 

Type of Value 2 

Result 

Number. Value is the 
discount rate. 

Numbers. Range is the 
cash flow over successive 
periods, one cell for each 
period. 

Npv returns the net present 
value of an investment 
yielding a specified cash 
flow at a given discount 
rate. 

See the LisaCalc Tutorial, 
Section B, Chapter 4. 

Npv returns Error if Value is 
not a number, or if Range 
contains any cells whose 
value is not a number. 

Number or simple data 
part. 

Whole number. Value 2 can 
be omitted. 

Round returns the rounded 
value of Value 1; that is, 
Value 1 with some of its 
rightmost decimal places 
deleted, and the last 
remaining place rounded 
appropriately. If Value 2 is 
present and is not zero, it 
indicates the number of 
decimal places to be 
included in the result. If 
Value 2 is omitted or zero, 
the result has no decimal 
fraction. 
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Examples 

Error Conditions 
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If Value 2 is negative, that 
number of digits to the left 
of the decimal point is 
rounded to zero. If Value 2 
is positive, that number of 
digits to the right of the 
decimal point is rounded. If 
Value 2 is not a whole 
number, it is rounded to the 
nearest whole number. 

If Value 1 is a simple date 
part, Round returns the 
number of units (days, 
months, or years) without 
the units. 

If the next decimal place 
after the iast one to be kept 
is a 5, followed only by 
zeroes, the number is 
rounded up if positive, and 
down if negative. 

Round(1.739) = 2 

Round( 1.8725,3) = 1.873 

Round( -1.8725,3) = 
-1.873 

Round(1.87251,3) = 1.873 

Round( 1250.000, - 2) = 

1300 

Round((5+7) years) = 12 

Round( 1250 days, - 2) = 

1300 

Round returns Error if 
Value 1 is not a number or a 
simple date part, or if Value 
2 is not a number. 



RoundlEEE RoundlEEE (Value 1, Value 2) 

Type of Value 1 

Type of Value 2 

Result 

Number or simple date 
part. 

Whole number. Value 2 can 
be omitted. 

RoundlEEE returns the 
rounded value of Value 1; 
that is, Value 1 with some of 
its rightmost decimal 
places deleted, and the last 
remaining place rounded 
appropriately. If Value 2 is 
present and is not zero, it 
indicates the number of 
decimal places to be 
included in the result. If 
Value 2 is omitted or zero, 
the result has no decimal 
fraction. 

If Value 2 is negative, that 
number of digits to the left 
of the decimal point is 
rounded to zero. If Value 2 
is positive, that number of 
digits to the right of the 
decimal point is rounded. If 
Value 2 is not a whole 
number, it is rounded to the 
nearest whole number. 

If Value 1 is a simple date 
part, RoundlEEE returns 
the number of units (days, 
months, or years) without 
the units. 

If the next decimal place 
after the last one to be kept 
is a 5, followed only by 
zeroes, the number is 
rounded in whichever 
direction makes the last 
digit an even number. 
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Examples 

Error Conditions 

RoundIEEE(1.739) = 2 

RoundIEEE(1.8725,3) = 

1.872 

RoundIEEE(-1.8725,3) = 
-1.872 

RoundIEEE(1.87251,3) = 

1.873 

RoundIEEE(1250.000, -2) 
= 1200 

RoundIEEE((5+ 7) years) = 
12 

Round1EEE(1250 
months, - 2) = 1200 

RoundlEEE returns Error if 
Value 1 is not a number or a 
simple date part, or if Value 
2 is not a number. 

Search (Range, Value 1, Value 2, Value 3) 

Type of Range 

Type of Value 1 

Type of Value 2 

Type of Value 3 

Result 

Values of any type. 

Logical formula. 

Number. Value 2 is 
optional. 

Number. Value 3 is 
optional, but must be 
present if Value 2 is 
present. 

Search examines each cell 
in Range to see if it meets 
the criteria specified by 
Value 1. If Value 2 and 
Value 3 are omitted, then, if 
Value 1 is True, the result of 
Search is a count of the 
non blank values in Range. 
In this case, Search is the 
same as Count. If Value 1 is 
False, the result of the 
function is Na. 



Examples 

If Value 2 is present, it 
specifies an initial value for 
the result of the function. If 
Value 3 is present, it 
specifies what the result of 
the function will be 
whenever one of the items 
being searched for is 
found. 

Two special constants that 
can only be used in the 
Search function are Cell 
and Result. Cell refers to 
the value of the cell being 
examined. Result refers to 
the current value of the 
result of Search. Search 
can be thought of as a 
procedure that is executed 
once for each cell in Range. 

Search functions cannot be 
nested. 

Search (A 1:A 10,Cell= 10) 

This example returns the 
number of cells in A1:A10 
that are equal to 10. 

Search 
(A 1:A 10,Cell = 10,0, 
Result+ 1) 

This example is identical to 
Search (A 1:A 10,Cell = 10). 

Search (A 1:A 10, 
Cell >= 10 And Cell 
<100) 

The result is the number of 
cells in the range A1:A10 
that have 2-digit values. 

Search (A1:A100,True,20, 
Result+3) 
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Search starts with a result 
of 20 and increases it by 3 
for each non blank cell in 
the range A 1:A 100. That is, 
for each non blank cell in 
the range the result is 
successively 20,23,26,29, 
and so forth until no 
nonblank cells are left. 

Search (A1:A10,True,0, 
Result+Cell ~ 2) 

This example returns the 
sum of the squares of the 
numbers in the range 
A 1:A 10. It is the same as 
the Sumsqr function, 
_ .. , ___ ", .&.I-_.&. __ •• 1_1-._1_ :_ 
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the range result in Error. 

Search(A 1:A 1 0, True,O, 
Result + If(Cell > 
10000,Cell* 1.10,Cell) 

In this example, the values 
in A1:A10 are sales figures 
for this year in ten different 
categories. The example 
assumes that for any 
category in which the total 
is greater than $10,000, 
sales next year will be 10% 
higher. The result of the 
function is the sum of the 
sales figures in the range, 
with those over $10,000 
increased by 10%. 

Search (A 1:A 1 0, Cell > 
1000, True, True) 

This example returns True if 
the range A 1:A 1 ° contains 
any value greater than 
1000; otherwise, it returns 
Na. 



Sin Sin (Value) 

Type of Value 

Result: 

Error Conditions 

Sqrt Sqrt (Value) 

Type of Value 

Result 

Example 

Error Conditions 

Sum Sum (List) 

Type of List 

Result 

Example 

Error Cond itions 

Number, in radians. 

Sine of Value. 

Sin returns Error if Value is 
not a number. 

Positive number. 

Sqrt returns the positive 
square root of Value. 

Sqrt{13.69) = 3.7 

Sqrt returns the value Error 
if Value is negative or not a 
number. 

Any types of values except 
dates. Values must be 
compatible. 

Sum returns the sum of the 
values in List. Blank cells 
and labels are treated as 
zero. 

Sum{ 1.45, True," Balance", 
- .007) = 2.443 

Sum{3 months,2 years,15 
months) = 2 years, 18 
months 

Sum returns the value Error 
if any of the items in List is 
a date, or is not compatible 
with the other items, or has 
the value Error. 
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Sumsqr 

Tan 
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Sumsqr (List) 

Type of List 

Result 

Example 

Error Conditions 

Tan (Value) 

Type of Value 

Result 

Error Conditions 

Numbers, logical values, 
and labels. 

Sumsqr returns the sum of 
the squares of the items in 
List. Blank cells and labels 
are equal to zero. 

Sumsqr(1 ,2,3,4,5,6,7, 
8,9,10) = 385 
Sumsqr(.1 ,.2,.3,.4,.5,.6,.7, 
.8,.9,1)= 3.85 
Sumsqr(1,1,2,3,5,8, 
13,21,34,55)= 4895 

Sumsqr returns the value 
Error if List contains any 
dates or date parts, or if 
any of the cells has the 
value Error. 

Numbei, in iadians. 

Tangent of Value. 

Tan returns Error if Value is 
not a number. If Value is 
equal to (4n+ 1)*Pi/2, 
where n is a whole number, 
positive or negative, then 
Tan returns either Infinity or 
a very large positive or 
negative number. 



-0134-A 

Section E 
Index 



Index 

A 
Abs, 024 
Acos, 024 
Alert boxes, C 14 
Alignment, 862, C76 

Center, 862 
Fill pattern, 863 
Right flush, 863 

And,013 
Example, B99 

Annuity, 024 
Apple key, B32, C 13 
Apple key commands, 05 
Apple symbol in menu, C13 
Area 

Cells, B5, C4 
Formula, 85, C4 
Value, 85, C4 

Argument, function, 828, 021 
Arrow, scroll, 829 
Arrow keys, 88 
Arrow pointer, C5 
Asin, 025 
Asterisks, 858 
Atan, 026 
Average, 026 

B 
Backspace, B7, B9 
Bar, scroll, 829 
Blank cells, C25 
Blank in function, 022 
Blank row, inserting, 863 
Budget, department, B25 
Button 

Next, B68 
Previous, 868 
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C 
Calculate, C23 

Automatically, C33 
Manually, C33 
Now, C33 

Calculate menu, 04 
Calculation, interrupting, C33 
Cancel button, C14 
Capital gains, 894 
Cash flow, 883 
Caution message, C15 
Cell, 85,C4 

Clearing, C38 
Copying, 833 
Copying, with Paste, 835, C40 
Copying, with Paste Adjusting, 836, C45 
Cutting, C54 
Moving, C63 
Protecting, 846 
Range, 828 
Selecting, C6 

Cells area, 85, C4 
Editing, 831 
Selecting, C9 

Center alignment, 862, C76 
Cents, 857 
Change 

Column width, 87 
Column width on several columns, 860 
Number style, 812, 857 
Value, 816 

Characters, selecting, C8 
Check box, C 14 
Check pointer, C5 
Choose menu item, C13 
Circle Missing Values, C24 
Circular reference, C34 
Clear 

Cells, C38 
Template, 847 

Clear Entries, 810, C38 
Column, 85, C4 

Copying, 867 
Cutting, C55 
Inserting blank, C60 
Moving, 870, C67 
Selecting, 867, C6 



Column width, 87, C78 
Changing on several columns, 860 

Commas, 857 
Comparisons, D 12 

Date, D17 
Compound, D27 
Condition, 888 
Constant, 831 

Date, D19 
Error, D19 
Infinity, D20 
Na, D20 
Pi, D20 
Special, D19 

Coordinates, 85 
Copy 

Cell, 833 
Cell with Paste, 835, C40 
Cell with Paste Adjusting, 836, C45 
Column, 867 
Text, C52 
To LisaGraph, 8106 
To LisaWrite, 8110 

Correct mistakes, 88 
Cos, D27 
Count, D28 
Cross pOinter, C5 
Current cell, 85 
Cut 

Cell, C54 
Column, C55 
Row,C55 
Text, 89, C57 

D 
Daisy wheel printer, C92 
Date, C27 

Constant, D19 
Example, 885 
Formulas, C27, D15 
In logical formulas, D17 
Value, D15 
Value in function, D23 

Date part, 885, C27, D 16 
In function, D23 

Days, D16 
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Decimal pOint, 856 
Delete, see Cut 
Department budget, 825 
Depreciation, 883 
Deselect, C9 
Dialog box, C 14 

Filling in, C14 
Fixed Decimal number style, 860 
Paste Adjusting, 837 
Print, C97 

Discount rate, 884 
DIV, D10 
Division, 830 

By zero, 830 
Integer, D 1 0 

Dollar sign, 856 
Don't Circle Values, C24 
Dot matrix printer, C91 

E 
Edit, C37 

Cells area, 831 
In status panel, 810 

Edit menu, 02 
Elevator, 833, C 11 
Ellipsis, C13 
Enter 

Formula, 814, C29 
Function, C31 
Value, 87, C58 

Enter key, 87 
Entry, clearing, C38 
Error, D19 
Evaluation, order of, D11 
Existing document, C 18 
Exp, D28 
Exponentiation, D10 

Order, 882 

F 
False, 012 
File spreadsheet, 819 
File/Print menu, D 1 
Fill pattern alignment, 863, C76 
Financial functions, 881 
Find Next Missing Value, C24 



Finished quality print, C97 
Fixed Decimal number style, 859, C81 
Floating Decimal number style, 856, C81 
Folder, 845 
Font, C84, 07 
Forecast, 854 
Format, C75 
Format for Printer, C90 
Format menu, 856, 03 
Formula area, 85, C4 

Selecting, 815, C9 
Formula, 09 

Arithmetic, 09 
Calculating, C29 
Compound logical, 013 
Date, 015 
Entering, 814, C29 
Logical, 012 
Order of calculation, 881 
Printing, 844 
Protecting, C103 
Relational, 012 
Show, 843 
Unprotecting, C104 

Function 
Argument, 828, 021 
Entering, C31 
Financial, 881 
Lookup, 890 
Max, Example, 897 
Min, Example, 897 
Npv, Example, 884 
Sum, Example, 828 

G 
Get 

81ank spreadsheet, 84 
Existing document, 826 

Gray menu item, C13 
Grid handle, 87 

Selecting, C7 

H 
Hourglass pOinter, C5 
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I 
Icon, C4 
If function, 028 

Advanced, B98 
Example, B88 

Infinity, B30, 020 
Insert 

Column, C60 
Page marks, C95 
Row, B63,C60 
Text, B9, C62 

Insertion pOint, B7 
Int, 029 
Integer division, 010 
Interrupt calculation, C33 
In\loC!trnont t~v " .. .o.rfi+ CQi 
'1 I" ""' ......... ,., ••• • ~'" VI ,",""",1., LJU I 

L 
Label, B6 
Left flush alignment, C76 
Length of paper, C91 
Less than, B88 
Line up, see Alignment 
LisaCalc 

Screen, C3 
Work flow, C 17 

LisaCalc window, B5 
LisaGraph, copying to, B106, C106 
LisaWrite, copying to, B110, C107 
List, as argument, 022 
Ln, 031 
Log, 031 
Logical 

Formula, 012 
Value, 012 
Value, in function, 023 

Logical formula, date, 017 
Lookup function, 031 

Example, B90 

M 
Make Stationery Pad, B48 
Max function, 033 

Example, B97 
Maximum, 897 



Menu, C12, D1 
Calculate, D4 
Edit, D2 
File/Print, D 1 
Format, D3 
Page Layout, D2 
Protect, D3 
Type Style, D2 

Menu bar, C4 
Menu item, C4, 01 

Choosing, C13 
Gray, C13 

Menu title, C4 
Message 

Caution, C15 
Note, C15 
Stop, C16 
Wait, C15 
?, C16 

Min function, 034 
Example, 897 

Minimum, 897 
Missing values, finding, C24 
Mistakes, correcting, 88 
Monetary number style, 813, 857, C81 
Months, 016 
Mouse, to enter coordinates, 838 
Move 

Cell, C63 
Column, 870, C67 
Row, C67 
Text, C69 

Multiplication, 815 

N 
Na, D20 
Net present value, 883 
New spreadsheet, 84 
Next button, B68, C45 
No Decimal number style, C81 
Not, D13 
Note message, C 15 
Npv function, 035 

Example, 884 
Number, in function, D22 
Number of copies, print, C99 

LisaCalc Index ::: E7 



... E81 : : : Section E 

Number of pages, print, C99 
Number style, C80 

Changing, 812, 857 
Fixed Decimal, 859 
Floating Decimal, 856 
Monetary, 813, 857 

o 
OK button, C14 
Operand, 881, D9 
Operator, 881, D 10 
Or, 013 

Example, 899 
Order of calculation, 881 
Order of evaluation, D11 
Orientation, print, C91 
Other tools, copying to, B103, C105 

p 
Page Layout menu, 861, D2 
Page marks 

Inserting, C95 
Removing, C100 

Panel, status, C4 
Paper length, C91 
Paper size, C92 
Parentheses in formula, 882, 011 
Paste, copying cell with, 835, C40 
Paste Adjusting 

Copying cell with, 836, C45 
Dialog box, 837 
Multiple cells, 867 

Paste Values, C42 
Percentage, 831 
Pi, D20 
Pointer shapes, 86, C5 
Precedence of operators, 882 
Previous button, 868, C45 
Print, C89 

Dialog box, 818, C97 
Document, C96 
Format for Printer, C90 
Formulas, 844 
Number of copies, C99 
Number of pages, C99 
Orientation, C91 



Paper size, C92 
Resolution, C92 
Speed, C98 
Spreadsheet, 818 
Wheel, C92 

Printer, 818 
Daisy wheel, C92 
Dot matrix, C91 

Printing type style, C84 
Protect, C101 

Cells, 846 
Formulas and values, C 1 02 
Formulas only, C103 
Menu, D3 

Q 
Quality, print, C97 
Quick draft, C98 
Quotation marks in If function, 888 

R 
Range as argument, 022 
Range of cells, 828 
Recalculate, 817, C33 
Relational formula, D12 
Relative, 842, C46 
REM,010 
Remainder operator, D 1 0 
Remove contents of cells, see Clear 
Remove page marks, C100 
Replace text, 810, C71 
Replicate, see Paste Adjusting 
Resolution, print, C92 
Restore contents of cell, 811 
Restore Previous Entry, 811, C72 

With Clear, C38 
Return key, 813 
Revert to Previous Version, C73 
Revise spreadsheet, 853 
Right flush alignment, 863, C76 
Round, D35 
RoundlEEE, D37 
Row, 85,C4 

Cutting, C55 
Inserting blank, 863, C60 
Moving, C67 
Selecting, C6 
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S 
Sales tax, 890 
Same, 842, C46 
Save 

Spreadsheet, 844 
Template, 848 

Save & Put Away, 819 
Scientific number style, C82 
Screen, LisaCalc, C3 
Screen type size, C86 
Screenful, Scroll, 834 
Scroll, C10 

Arrow, 829 
8ar, 829 
Screenful, 834 
Spreadsheet, 829 

Search, 038 
Select, C6 

Cell,85,C6 
Cells area, C9 
Characters, C7 
Column, 867, C6 
Formuia area, B 15, C9 
Grid handle, C7 
Letter, 810 
Row,C6 
Several cells, C7 
Several columns, 861, C7 
Several rows, C7 
Value area, C9 
Whole document, 812 
Whole spreadsheet, C9 
Word, 831, C7 

Select All of Document, 812 
Show Actual Size, C86 
Show Formulas, 843 
Show Formulas & Values, C87 
Show Medium Type, C86 
Show Values Only, C87 
Sin, 041 
Size of paper, C92 
Speed, Print, C98 
Split control, 865, C 11 
Split view, 865 



Spreadsheet 
81ank,84 
Existing, 826 
Filing, 819 
Initial display, 84 
Printing, 818 
Revising, 853 
Saving, 844 
Scrolling, 829 
Selecting, C9 
View, 85, C4 

Sqrt, 041 
Start new document, C17 
Stationery, making, 848 
Stationery pad, 84 
Status panel, 85, C4 
Stop message, C 16 
Sum function, 828, 041 

Missing values, C25 
Sumsqr, D42 

T 
Table example, 889 
Tan, 042 
Tax forms, 894 
Tell me, C93 
Template, 845 

Clearing, 847 
Saving, 848 

Text pointer, C5 
Text, 87 

Copying, C52 
Cutting, 89, C57 
Inserting, 89, C62 
Moving, C69 
Replacing, 810, C71 
Value, in function, 023 

Travel expense report, 83 
True, 012 
Type face, C84 
Type size, C86 
Type style, C84, 07 

Menu, 02 
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U 
Undo Last Change, B11, C74 
Unformatted numbers, B12 
Unprotect, C104 
Unsplit view, B67 

V 
Value, B6, C4 

As argument, 021 
Blank, in function, 022 
Changing, B16 
Date, in function, 023 
Date part, in function, 023 
Entering, C58 
Logical; D 12 
Logical, in function, 023 
Number, in function, 022 
Protecting, C102 
Text, in function, 023 
Unprotecting, C104 

Value area, B5, C4 
Selecting, C9 

Variance, B55 
View 

Splitting, B65 
Spreadsheet, B5, C4 
Unsplitting, B67 

View Button, B34, C11 

W 
Wait message, C 15 
Weeks, D16 
Width of column, B7, C78 
Window, C4 

LisaCalc, B5 
Wipe out, see Clear 
Word, Selecting, B31, C8 
Work flow, LisaCalc, C 17 

y 
Years, 016 



Z 
Zero, division by, B30 

<, B88, 012 
<=,012 
<>,012 
=,012 
>,012 
>=,012 
? message, C16 
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